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1

OBJECTIVES

Digital Terrain Modeling for
Drainage Design and Analysis

In this chapter, you will learn more about:

o Displaying DTM features such as contours and triangles.
o Create TIN files from Superelevation Shapes.
o Create TIN files from proposed cross sections.

INTRODUCTION

ACCESSING

SETTINGS

A Digital Terrain Model (DTM) represents the topography of a project in the form of a triangulated
network. The DTM can be drawn in a 2D or 3D file, and then rotated to see the existing surface of the
project area. The tools associated with the DTM are not related to and are independent of GEOPAK
Drainage.

Digital Terrain Models can be generated from various sources including MicroStation elements, survey
data, photogrammetry data, GEOPAK cross-sections, and geometry data.

e Triangulation is a mathematical process applied to ground points and vertices along longitudinal
features to create planar surfaces. The result of triangulation is the creation of triangles connecting
these points. These triangles are included in the GEOPAK TIN file from which existing ground
profiles and existing ground cross sections can be generated.

The DTM tool frame can be accessed from the MS Menu: Applications>Geopak
Road>DTM Tools. Then clicking on the DTM menu icon, the user can access
the DTM tool bar depicted below.

Settings Extract Build Edit Drape Load Reports Analysis  Utilities

When the Stroking Options tool is selected, the DTM Stroking Options dialog opens.

[C]iCurve Stroke Tolerance:;
[7] Minimum Linear Distance:

Two user-defined stroking values can be defined before graphics can be extracted to create a DTM.
Stroking is the process of automatically adding shots to the DTM Input file by interpolating new shots

VDOT GEOPAK Drainage © 2011 Bentley Systems, Incorporated 11




Extract Graphics

from the linear and curved sections of the data. If the source topography data is mapped in a 3D-design
file, stroking may be applied. Stroking is not available if the topography data resides in a 2D-design

file.

Curve Stroke The maximum distance between the arc and the chord used to approximate the
Tolerance arc in the DTM. Stroking is only applied to breaks and contours.

Minimum Linear If a linear segment is greater than the Minimum Linear Distance, points are
Distance interpolated and added to the segment such that the distance between the points

EXTRACT GRAPHICS

1-2

in not greater than the Minimum Linear Distance.

The Extract Graphics tool reformats MicroStation elements into DTM input data.

File
Name

File Type

File Open

Feature
Type

File Name:

Fletype: (Bnay =]
File open:
Feature: [Spots -

Mode:
Search Criteria

[  Lv Names:

[ Lv Mumbers:

Calors:

Styles:

Weights:

I o o o o

Types:

Cell Name: Origin =~ =

| [owler | [ A

Apply

The name of the file to be created for storing the input data. The .dat extension is
automatically assigned so you are not required to key this in; however, an alternate
extension may be defined. If file already exists, it may be selected by clicking Files.

Format of the new file. Either format produces the same results. The difference between
the two is ASCII files can be viewed and edited with any text editor while_binary files
process faster, but cannot be viewed.

For ASCII file designation, you must define the number of decimal places for the data.
Indicates whether a file is being created (Create) or the user is appending data (Append)
to an existing .dat file.

This notifies GEOPAK of the feature type that the extract graphics will put in the DTM.
Spots — Random survey points. Can also be vertices of a Line or a Line String.

Breaks — Designate linear features such as edges of pavement, ditch bottoms, ridges,
etc. No triangle leg will cross a Break.

Boundary — The external boundary of the digital terrain model — only per .dat file.
Contours — For use in extracting digitized or otherwise imported contours.

Void - Closed shapes representing an area with missing data or obscure areas. (i.e.
ponds, headwalls, concrete pads, etc.). The void coordinates determine void lines, which
are inserted as drape lines on the triangulated surface and do not alter the slope or
elevations of the TIN.

Island — Area within a void that contain data and should be included in the model.

© 2011 Bentley Systems, Incorporated VDOT GEOPAK Drainage



Build Tools

Mode

Search
Criteria

Extract

BuiLD TooLs

Graphic Triangle — For use in extracting triangles from a TIN model that has been
otherwise created or imported.

Drape Void — Same as Void, except the Void’s vertex elevations are ignored and the
triangulated model elevations at these vertex points are utilized.

Break Void — Same as Void, except the void elevations are included in the triangulated
model at it’s x y coordinates; therefore, the slope and elevations are modified on the
TIN surface.

The Extraction mode calculates XYZ data directly from the coordinate values of 3D
MicroStation elements. The Interpolation mode produces XYZ data by interpolating
between spot elevations along linear MicroStation elements. This mode works in both
2D and 3D files wherein the elements are not represented with a defined Z value.

The Select Criteria group box provides options to specify the features to be extracted.
When a "check" is placed in the box next to Levels, the Select box is activated. Then
click the Select button to invoke the Level Mask dialog wherein only those levels you
want GEOPAK to search for when extracting data can be selected. If the Levels box is
not turned on, GEOPAK searches all levels. The same procedure is utilized for other
criteria selections. The three buttons located at the bottom of the Select Criteria group
box Match, Display and Reset enable you to interactively define, highlight elements that
match the search criteria or clear the search criteria respectively.

The Extract group box has several options for data extraction. Complex Chain reads
those elements along adjoining MicroStation elements. Selection Set uses the
MicroStation selection set tools to identify elements to extract. Fence extracts all
elements within a fence boundary. Viewl, View2, View3, etc. extracts all selected
elements displayed in the selected view.

Tools

=
Build
r

[ has=z]

Menu Bar

Build > Triangle
Build > Lattice

Build > Merge TINs
Build > Clip TIN
Build > Pad

Build > Delta Surface

Included under the Build pull down and icons are options for creating, manipulating and merging DTM
models. This class addresses, in detail, only those options utilized in routine DTM operations.

BuILD TRIANGLES

Tool bl e, el
r_
| T, Ty d e e = |
DTM Menu Bar Build > Triangle

The Build Triangle tool processes the information stored in a DTM input file (.dat) to create a
triangulated model (TIN). The file extension TIN (which is automatically assigned) represents a
triangulated irregular network.

VDOT GEOPAK Drainage
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Build Tools

4 Build Triangle: =

Data File:

TIN File:

Dissolve Optioni [None |

Process

Data File

The DTM input file where the extracted topological features are stored. The file can also
be selected via Files. If the full path is not given, GEOPAK utilizes the working
directory to locate the file.

TIN File

The filename in which the DTM data will be stored in a binary format. The file can also
be selected via Files if the file exists. If the full path is not given, GEOPAK utilizes the
working directory to locate the file.

Dissolve
Option

This option will allow the elimination of external triangles based on the selected option.
Note that internal triangles are not affected. The three options are:

None - no external triangles are deleted.

Sliver - long, thin triangles based on a hard-coded formula within the software are
deleted.

Side - external triangles where a side is longer than the user specified length are deleted.

Process

Commences the TIN creation process.

ADDITIONAL BUILD OPTIONS

Tool

Build
EZ =
| To T 4 s 1z = |

Menu Bar

Build > Additional Tools

Several additional Build tools are supported, which are detailed in the following table.

Lattice Creates a gridded mesh (.lat) of the triangulated data (TIN) to create a three
dimensional visual display of the topography.

Merge TINs Two triangulated models to be merged together as long as the boundaries of
one model overlaps the other at a minimum of one point. This process creates a
third model (TIN) from the combination of the two existing models.

Clip TIN Creates a new model (TIN) from a portion of an existing model. The area is
defined as internal or external to a user defined polygon.

Build Pad Defines a pad (such as a building) and integrates the pad into the existing
terrain with a variety of slope options.

Build Delta Tin Creates a new model based on the difference between two other models or a

model and elevation surface.

1-4
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Reports

REPORTS
Tools
Menu Bar Reports > Duplicate Points
Reports > Crossing Features
Reports > Tin Statistics
Reports > Lattice Statistics
Options under the Reports pull down and tool frame include a way to check for duplicate points or
crossing breaklines, and the ability to generate statistics associated with a TIN or Lattice file. Each
report is described in the following table.

Duplicate Points

Reports points with the same x and y coordinates

Crossing Features

Reports intersecting (same xy location, varying z) breaklines or contours.

Triangle Statistics
Lattice Statistics

Displays a summary indicating the total count of each element type and
minimum and maximum X, Y, Z ranges for the specified TIN or LAT file.

UTILITIES
I" RECII AZCII £ ML =ML ODTH  TIN [ A Y
| N =5~V et A ) |
Menu Bar Utilities > Convert TIN

Utilities > ASCII to Binary
Utilities > Binary to ASCII
Utilities > Check Triangulation
Utilities > Metric to English
Utilities > DTM

Utilities > Import LandXML
Utilities > Export LandXML
Utilities > LIDAR XYZ Tools

Tools under the Utilities pull down and tool frame include a way to check the validity of a triangulated
file, converting triangulated files from previous versions of GEOPAK, converting the DTM data file
between ASCII and binary format; as well as exporting the LATTICE information to the Trimble DTX
format. They are detailed in the following table.

Convert TIN Converts a pre-GEOPAK 98 triangulated file to the current format.

ASCII to Binary Reformats the DTM data file (.dat).

Binary to ASCII

Check Verifies the integrity of the triangulated file. A message appears indicating

Triangulation

“Triangulation Valid” if the file structure is intact.

English to Metric
Metric to English
Metric to
Imperial

Custom

GEOPAK TIN files are neither English nor metric. English and metric
preference settings within GEOPAK are for volume purposes and do not affect
the TIN. This utility converts an entire TIN file with optional translation and
rotation tools.

Export DTM

This tool utilizes a lattice file to generate a Trimble DTX file, Trimble TTM
file, or Leica GSlI file suitable for use in Trimble and Lecia field equipment.

VDOT GEOPAK Drainage
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Import LandXML This tool is utilized to create a DAT file from a LandXML file.

Export LandXML  This tool is utilized to create a LandXML file from a TIN file.

LIDAR XYZ This tool set is used to process, filter, clip, compare, report, and display
Tools LIDAR data.

LoAaD DTM FEATURES

1-6

Tool

Menu Bar

Load > DTM Feature

Load is the process by which we can visualize the DTM data, TIN model, lattice model, and contours.
By selecting the Load DTM Feature icon, the following dialog box appears. The designer can choose
to load the DTM data (.dat), the TIN file (TIN), or the Lattice file (.lat). Each of these files can be
loaded for the model extents, within a fence, or selected view.

File

Load File:

Display Preferences

Load: [ Display Only

Q[ ]

[ Graphic Group

Feature Level

Color |Weight| Style

Display

Triangles Default
TIN Hull Default
Contours
Major Lines  Default
Major Label Default
Minor Lines  Default

0
1

2

0 0
0 0

2

1

OFF
OFF
OFF
OFF
OFF
OFF

(]

Activating the Display Only toggle enables you to view the elements without writing them to the
MicroStation file (temporary display). Conversely, deactivating the toggle writes the DTM features to
the MicroStation design file at the defined symbology. These elements can be placed as a graphic

group when Display Only is deactivated.

© 2011 Bentley Systems, Incorporated
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Edit Tools

Feature Level Color |Weight| Style | Display =
Triangles Level 1 2 0 0 oN (o] Wt
TIN Hull Default 1 ] ] OFF |2 o
Contours - - - OFF

Major Lines  Default 2 2 0 OFF ¥
Major Label Default 4 D D COFF ¥
Minor Lines  Default 7 1 0 OFF -

=

L% Activates the display of all Features.
1 Turns off the Display of all Features.
Turns on only the selected Feature. This can also be accomplished by
P activating the toggle (below the list box) or double-clicking on an item
that is turned off within the list box.
Will turn off only the selected item. This can also be accomplished by
¥ activating the toggle (below the list box) or double-clicking on an item
that is turned on within the list box.
EDIT TooLs
Tools
Menu Bar Edit > Triangles

Edit > Duplicate Points

Edit > Crossing Break Lines
Edit > Filter Vertices

Edit > Join Linear Features
Edit > Z Range Clip

GEOPAK supports an extensive range of powerful editing tools, both pre- and post TIN generating.

Triangles

The triangulated model can be dynamically edited in terms of adding, deleting
or moving spot elevations. Break lines can be added, draped or deleted.

Duplicate Points

Interactive editing of points in a DTM data file with the same X and Y
coordinates within the data (DAT) file.

Crossing Break
Lines

Interactive editing of crossing break lines and extracted contours within the
data (DAT) file.

Filter Vertices

Removes vertices from break lines or extracted contours within the data
(DAT) file when located within the specified Tolerance of another vertex.

Join Linear
Features

The Join Linear Feature is useful when the source break line or contour line
consists of several elements containing numerous vertices. In these cases, the
end of one break line is the beginning of the next break line, so the software
utilizes this as two separate break lines. During the Joining process, GEOPAK
changes these from the beginning and end of individual elements to the
beginning and subsequent shots of one element.

Z Range Clip

Deletes individual vertices from the data file (DAT) based on a user defined
elevation range.

VDOT GEOPAK Drainage
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Lab Exercise: Digital Terrain Modeling

DIGITAL TERRAIN MODEL (TIN)

1-8

( Data File

Feature Types: Spots
Breaks
Voids
Contours

Boundaries

\ Isjands

TRIANGULATION
(Build Triangles)

|
I

Triangulated Irregular Network

Build Lattice

Build Pad

DISPLAY FEATURES

© 2011 Bentley Systems, Incorporated

Analysis

Ground XS and
Profiles
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Lab Exercise: Digital Terrain Modeling

LAB EXERCISE: DIGITAL TERRAIN MODELING
The purpose of this exercise is to review the triangles of a tin file and to create contours from it.
> Accessing DTM Tools

1. Execute c:\data\geo\vdot\drain1\LABO1_ V8 SELECTseries.exe.
2. Open the MicroStation file, c:\data\geo\vdot\drain1\h17682.dgn.
3. Access the GEOPAK DTM Tools frame. (Applications > GEOPAK >ROAD> DTM Tools)

> Load DTM Features

1. Select the Load DTM Features icon from the tool frame.

qLoad DT Feature

2. Change the Load File optionto TIN.
3. Select the TIN file located in c:\data\geo\vdot\drain1\survey.tin by clicking the Files icon.

File
Load File:

Display Preferences

Load: Display Only

survey tin

A [Cow ]

Graphic Group

VDOT GEOPAK Drainage

Feature

Level

Color |Weight| Style

Display

Triangles

TIN Hull

Contours
Major Lines
Major Label
Minor Lines

Default
Default

Default
Default
Default

By lv Bylv Bylv
1 0 0

ra ra

7 1

ON
OFF

4. Enable the toggles for Graphic Group and the Display Only .

5. Select the Triangles Feature by highlighting in the list box. Notice that initially the display is
set to OFF. You can control the display of an item three ways

e  Use the “lightbulb” icons to the right of the dialog box
e Double-click on an item
o Use the “display” toggle in the lower right corner of the dialog box

Set the Triangles display to ON. At this point your dialog box should resemble the following:

© 2011 Bentley Systems, Incorporated
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Lab Exercise: Digital Terrain Modeling

File

Load File: survey tin Q

Display Preferences

Load: Display Onlty Graphic Group

Feature Level Color |Weight| Style | Display =
Triangles Default Bylv Bylv Bylv ON ‘

TIN Hull Default 1 0 OFF
Contours - - - - OFF
Major Lines  Default OFF
Major Label Default COFF
Minor Lines  Default OFF

e

Set the display symbology for the Triangles as indicated above.

Click Load and review the results.

When complete, toggle OFF the Display of the triangles.

Select the Contours feature. Activate the Display Feature. Verify that ON is set in the
Display field.

10. Complete the bottom of the dialog box as indicated below. To complete the Minimum and
Maximum Z, click the Read button, which will review the active TIN file and determine these

values.

© © N

File

Load File: survey tin Q

Display Preferences

Load: Display Onlty Graphic Group

Feature Lewvel Color |Weight| Style | Display =
Triangles Default ByLv Bylw Bylw
TIN Hull Default 1 0 0
Contours
Major Lines  Lewel 10
Major Label Level 10
Minor Lineg  Lewel 9

Minor Interval: | 1.000 Major Interval: | 5.000
Smooth: Hegistlation: 0.000 | Minimum Area: | 0.000

Minimum Z: | 1988.418 | Maxdmum Z: | 2135.845

11. Enable the Display Only toggle since we only want to “preview” our contours but not
actually write them to the design file.
12. Activate the Display of the Contour Lines and Labels and set the symbology as indicated

below:
Level Color | Weight | Style | Font | TH/TW Distance
Major Lines Level 10 | 4 3 0
Major Labels | Level 10 | 5 3 0 0 TH=3, TW=3 | 200

1-10 © 2011 Bentley Systems, Incorporated VDOT GEOPAK Drainage



Proposed Cross Sections to DTM

Minor Lines

Level 9 1

13. Click the Load button to initiate the process.
14. Close the Load DTM Features dialog box.

PrRoPOSED CROSS SECTIONS TO DTM

The DTM Prop 3D tool locates specified proposed cross section elements and existing ground, and
generates an X, Y, z file of vertices for break lines suitable for use with GEOPAK's Digital Terrain

Modeling. Each cross section generates one break line. In the hierarchy, the path follows (from left to

right) existing ground until a proposed finish element is intersected. The proposed path is followed

until it ties back to an existing ground element.

(7% DM Proposed 30 RepoRN .- sjws o |

I | Cument Station: | 200-00.00 R 1

Chain: [MAINLINE -]

Begin Station:
End Station:
Search Critera

ASCI File:

200+00.00R 1
220+00.00R 1

200+00.00R 1
220+00.00R 1

[7] Pause on Each X5
proposed dat Q.

Apply |

Job

Job which contains the cross section chain.

Chain

Chain utilized to generate the existing ground cross
sections or the name on the XSCELL

Current Station

Defaults to the lowest stationed cross section in the
file. During processing, the current cross section
being reported is displayed

Begin Station / End Station

GEOPAK determines the beginning and ending cross
section station within the MicroStation file and they
are noted below the chain and placed in the key-in
areas. If these defaults are utilized, the report is
generated for the entire set of cross sections.
However, if a report for a smaller range is required,
the user may simply key in the required beginning
and/or ending station.

Search Criteria: Existing
Ground Line/Proposed Finish
Grade

Refers to the Microstation symbology used to draw
the existing ground line and any Microstation element
that makes up the upper layer of the proposed cross
section.

Pause on Each XS

When the toggle is activated, the first section is
processed and stops. Each click of Apply processed
another section.

VDOT GEOPAK Drainage
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Lab Exercise: Proposed Cross Sections to DTM

LAB EXERCISE: PROPOSED CROSS SECTIONS TO DTM

1-12

ASCII File

Specify the name of the ASCII file to be generated.
The designer has the option of keying in the file name,
or clicking Files, invoking the Files dialog, wherein
the designer may select the desired file. The file is
placed in the current directory, unless a full path is
specified. If the specified file name already exists, the
file is overwritten with no warning message given.

Apply

Commences processing.

The purpose of this exercise is to create a proposed dtm from the roadway cross sections developed by
the roadway designers. The newly created dtm will include the existing and proposed elements of the

roadway merged together.

» Creating a Proposed DTM
1. Open the Microstation file c:\data\geo\vdot\drain1\d17682xsmainline.dgn (MS Menu: File >

Open)

2. Open Project Manager (MS Menu: Applications > GEOPAK > ROAD > Project Manager)
3. Select project:17682.prj located in c:\data\geo\vdot\drainZl, and click OK.

4. Access User: VDOT.

Projects

Directory  Admin

Cdata'Geo wdot \drain 1%

Fiter: | ~pr

Type: |Project -

Projects:
17682 prj

Directories:
[]

[projdbs]
[standards]
[C]

D]

H1]

Job Mumber:

Description:

m

Unit System: English

© 2011 Bentley Systems, Incorporated
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Lab Exercise: Proposed Cross Sections to DTM

5. Click OK. The Road Project dialog will load. This will setup the proper directories for the

Users

Project Users: User Infa

VDoT] Full Name:
Virginia DOT

0P Code:
VD

Description:

location of the gpk file

ile  Remember Options

VDOT GEOPAK Drainage

Worlding Directory:

Working Mignment Influence Runs [ oot ] [ Define l [ Port Viewsr ]

Worlking Alignment | MAINLINE

Exdsting
Ground

Existing Ground

Eefdia ‘ Cross Sections

Coordinate

Geometry
Calculate Superelevation

Superelevation Shapes

Horizontal
Alignment

Flan View

‘ Earthwork

Design
Plan View Tabular

Click the Report &XS Quantities button
Access the DTM Proposed 3D report.

© 2011 Bentley Systems, Incorporated
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Lab Exercise: Proposed Cross Sections to DTM

User

Blue & Red Top
Clearing
Closure

DTM Input
DTM Proposed 30
HEC-2
HEC RAS
Mutti-Line
Profile Grade

Radial Staking
RT40
Seeding
Slope Stake
Staking Detail

WSPRO

X5 List

[ Hilite:

8. Setup the DTM Proposed 3D Report dialog as shown below.

fob [ | Q, Cument Station:
Chain: [MAINLINE
Begin Station: | 200+00.00 R 1 200-+00.00 R 1
End Station: | 220+00.00 R 1 220-00.00 R 1
Search Criteria

Existing Ground Line: h\mﬁ'l Display

Proposed Finish Grade: h\mﬁ'l Display

[ Pause on Each X5
ASCIl File: | proposed dat

[ Apply

Existing Ground Line: Lv Name: Level 1

Proposed Finish Grade: | Lv Name: Level 2 thru Level 13
ASCII File Proposed.dat

9. Click Apply to create the proposed.dat file. This file will be created in your active working
directory : c:\data\geo\vdot\drainZ.

10. Access the GEOPAK DTM Tools frame. (Applications > GEOPAK > ROAD > DTM Tools)
11. Click OK to accept the run.
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Lab Exercise: Proposed Cross Sections to DTM

VDOT GEOPAK Drainage

12. Select the Build Triangles icon from the tool frame.

13. Populate the Build Triangles dialog as shown below.

Data File: | proposed dat

TIM File: | proposed tin

Dissolve Option: [None = |

Process

14. Click Process to create the proposed.tin file.
15. Close the Build Triangles dialog and select No when prompted to Save Settings.

16. Use the steps in previous lab exercises to display the new triangles and contours along the
pavement surface.

17. Exit Microstation.

© 2011 Bentley Systems, Incorporated
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2 Drainage Analysis

OBJECTIVES
Learn how to use different Geopak DTM, shapes and VBA tools for the analysis and creation of
drainage areas in a project.

INTRODUCTION

A Digital Terrain Model (DTM) represents the topography of a project in the form of a triangulated
network. The DTM can be drawn in a 2D or 3D file, and then rotated to see the existing surface of the
project area. The tools associated with the DTM are not related to and are independent of GEOPAK
Drainage.

ACCESSING

The DTM tool frame can be accessed from the MS Menu: Applications>Geopak
Road>DTM Tools. Then clicking on the DTM menu icon, the user can access
the DTM tool bar depicted below.

Settings Extract Build Edit Drape Load Reports Analysis  Utilities

ANALYSIS TOOLS

Tools Analysis
I._

Menu Bar Analysis> Height
Analysis > Profile
Analysis > Volumes
Analysis > Elevation Differences
Analysis > Slope Area
Analysis > Themes
Analysis > Drainage Tools
Analysis> Visibility
Analysis > Trace Slope Path
Analysis>DTM Camera
Analysis> Trench Volumes

The Analysistools allow you to visually analyze the digital terrain model utilizing numerous tools as a
profile analysis, thematic analysis, drainage flow patterns, and visual portions on the model from any
given location.

VDOT GEOPAK Drainage © 2011 Bentley Systems, Incorporated 2-1



Analysis Tools: Drainage

To determine the height and other associated data dynamically based on

Height . . s
g user-defined data points within the model.
Profile View a profile based on a user defined MicroStation element.
volumes To compute the volume between two TIN models, the volume between a

TIN model and a plane, or the cut and fill totals between two TIN models
while applying a shrinkage/swell factors.

Elevation Differences

Will display the elevation difference or the amount of cut and fill between
two TIN models, or a TIN model and a plane of constant elevation.

The Slope Area tool displays the horizontal area and actual slope area

Slope Area
P (area following the terrain of the Model).

Themes Displays the digital terrain model based on different user definable
themes such as elevation ranges, slope percentage, slope degree, or
aspect.

Drainage Displays and analyzes drainage patterns within a TIN model. Tools
include delineating watersheds, drawing flow arrows, determining
upstream and downstream traces, finding high and low points, and ridge
and sump lines.

Visibility Based on a user-defined point of origin, GEOPAK visually displays
which triangles can and cannot be seen, or what is visible between two
points.

Trace Slope Path Traces a path along a TIN file using a user specified slope and method.

DTM Camera Allows a 3d visualization camera for the DTM

Trench Volumes

Compute the excavation volume needed along the drainage pipes.

ANALYSIS TOOLS: DRAINAGE

2-2

These are available tools within the dialog.

Cptions

GEBS S

[] Display Only Watersheds

[] Load Within Fence I

[ Set Graphic Group Zero Slope Areas

Minimum Low Ol _

Point Depth: | 0.000 Void Areas
[ Refine Watershed | [ ]

[ )

Delineate All Water sheds

Displays the watershed boundaries that exist within a DTM.
A Watershed is defined by either a low point within the TIN
or a low edge point along the TIN hull. MicroStation shapes

© 2011 Bentley Systems, Incorporated VDOT GEOPAK Drainage



Analysis Tools: Drainage

may be created for each watershed contained in the TIN.
Two important options to consider are:

e Minimum Low Point Depth: A DTM has many
low points in which drainage areas could be
delineated, but many of depth are small dips in the
TIN file in which water will keep flowing.
GEOPAK determines each low point, then
determines if water placed at the specified depth
overflows these dips in the DTM and flows into
adjacent triangles. If it does not flow into adjacent
triangles, it is identified as a low point and the
drainage area is delimited. The designer must use
the appropriate criteria to set this value.

o Refine Water shed: this option processes the entire
TIN evaluating ridges, sumps, and low points and
determines more precise flow boundaries within the
triangles. It does not retriangulate, more specifically
it insert lines within the TIN that actually represent
flow divides.

Delineate Water shed

The Delineate Watershed tool further delineates watersheds
at any location within the TIN. A data point representing the
pour point of the watershed is indicated and the contributing
watershed area is computed and delineated.

Drainage Patterns

Evaluates the flow paths contained in a region of the TIN,
Model or Object. This tool performs a downstream trace
from the centroid of each triangle contained in the region
specified.

Downstream Trace

Trace tool delineates the flow path downstream from a given
point in the TIN. The indicated path follows the steepest
descent from the point through the TIN terminating at a low
point or the edge of the TIN.

Upstream Trace

Delineates the flow path upstream from a given point in the
TIN. The indicated path follows the steepest ascent from the
point through the TIN terminating at a high point or the edge
of the TIN.

Flow Arrows

Indicates the direction of flow within the triangles for a
given region of the TIN.

Delineate L ow Points

Locates all low points within a region of a TIN. A flow
arrow is placed and the text "LP" is placed at the triangle
vertex. Text placement utilizes the current MicroStation text
parameters.

Delineate High Points

Locates all the high points within a region of a TIN. A flow
arrow is placed and the text "HP" is placed at the triangle
vertex. Text placement utilizes the current MicroStation text
parameters.

VDOT GEOPAK Drainage
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Analysis Tools: Drainage

Delineate Ridge Lines Indicates the ridge lines within a region of a TIN. A ridge
line is defined as a triangle edge where the flow on each side
of the edge is away from the edge.

Delineate Sump Lines Indicates the sump lines within a region of a TIN. A sump
line is defined as a triangle edge where the flow on each side
of the edge is towards the edge and is found in areas of
concentrated flows such as streams and ditches.

Surface Ponds Delineates the area(s) of ponded water within the specified
TIN.
Pond Analysis Traces a point downstream to a low point and fills it giving

the volume, maximum depth, and maximum elevation. In
addition, the pond delineation is graphically displayed.
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Lab Exercise: Analysis of the Proposed DTM

LAB EXERCISE: ANALYSIS OF THE PROPOSED DTM
Accessing DTM Tools
1. Execute c:\data\geo\VDOT\drain1\LAB02_V8 SELECTseries.exe.

2. Open the MicroStation file, c:\data\geo\VDOT\drain1\h17682da.dgn.
3. Access the GEOPAK DTM Tools frame. (Applications > GEOPAK > ROAD > DTM Tools)

Reading Elevations with the Height Tool
1. Access the DTM Menu tool bar.

D TH T

qr

enu

1_=
Syl

E

=

=

i }‘_N

B
-l

s% ,83 [ﬁ"m o
i

1

s

-

2. Select the Height tool from the DTM Menu. (DTM > Analysis > Height)
Select the proposed tin file: proposed.tin located in c:\data\geo\VDOT\drain1\

Activate the Show Contour and Show Flow Arrow toggles. The color may be altered to your
choice of colors from the active color table on the Height dialog box. The weight of the
contour line and arrow are controlled by the active MicroStation settings.

TIN File: | proposed tin Q,
Mode : | Elevation « | Display Cnhy

V| Show Contour: J

Show Triangle: J
| Show Flow Amow: J

Cursor Point Values

X - 2718344 0327

Y - 339317.4342

Z - 2008.9882
Slope : 5. 27447%

5. Click the Start button and scan the surface model with the cursor to display the values for xyz
and the slope on the DTM at the cursor point.

6. Close the Height/Slope dialog.

Dynamic Proposed DTM Profiles

1. Select the Profiletool. from the DTM Menu. (DTM > Analysis > Profile)

2. Use the Object Selection icon to identify your surface model (TIN File) which you will
generate a profile from, and the symbology for your profile.

VDOT GEOPAK Drainage © 2011 Bentley Systems, Incorporated 2-5



Lab Exercise: Analysis of the Proposed DTM

2-6

File

it
Type | Feature Color |Weight| Style
TIN proposed tin 0 4 0

® By XODo

[TIM File | [proposedtin

Select the Tin File :proposed.tin by using the Select Filesicon.

Double-click on the symbology box (field to the right of the Filesicon) to set the symbology
representing the ground surface profile. You may choose any symbology you wish. Once the
symbology has been set, click OK.

( Set Feature

Symbology
Level! [Level 1
Color: [_ O

Style: [
Weight: |

Click the Add icon (top icon next to the list box) to add the feature to the collection box.
Select the Create Profile Icon.

Click the Place Profile Element icon to cut your actual profile at any desired area by just
placing two data points (i.e. a line) or a series of data points (i.e. a line-string) across your
surface model at any location.
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Lab Exercise: Analysis of the Proposed DTM

Curve Stroking: | 0.000

8. You can use the Profile Preferencesicon to set up a grid for your profile if desired.
9. Close the Profile dialog.

Analyzing Drainage Flow Pattern

1. Select the Drainage Tools from the DTM Menu. (DTM > Analysis > Drainage Tools)
2. Select the Drainage Patterns icon and fill the dialog box as shown below.

TIN File: | proposed tin

S S

Drainage Patterns}
— }

Options

Load Within Fence
Set Graphic Group

3. Click the Apply button. The drainage flow lines are drawn into the design file.
4. Close the Drainage Patterns dialog.

Locating Low Points

1. Select the Delineate L ow Pointsicon and populate the dialog as shown below.
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Lab Exercise: Analysis of the Proposed DTM

[ Delineate Low Poi E———)

TIN File: | proposed tin
Options

G&EBS S

Display Orly _1
[7] Load Within Fence

[] Set Graphic Group Amow Size: | 20.000
Mirimum Low
Point Depth: | 0.500

2. Click Apply to review the low points location in the Microstation file.
3. Close the Delineate Low Points dialog.

Delineating Drainage Areas

1. Select the Delineate All Water sheds icon and populate the dialog as shown below.

[0 Delineate Al Watersheamiacsl n=siiwe 3]

TIN File: | proposed tin
Options

LB S S

Watersheds

Display Oy
[7] Load Within Fence .

[7] Set Graphic Group Zero Slope Areas

Minimum Low [l _

Point Depth: | 0.500 Void Areas
[ Refine Watershed [l B

( Apply |

2. Click Apply and review the tentative watersheds for the pavement drainage.
3. Close the Delineate All Watersheds dialog when done.

Note This process will define all the “mathematically” possible drainage watersheds. The designer
will need to define the final drainage areas for the project.

Scouting for Pond Locations

1. Select the Surface Ponds icon.
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Lab Exercise: Analysis of the Proposed DTM

Options

&&@354

Surf, Pond
Display Only Ponds:
lslands: _

2. Select the Tin File: survey.tin located in c:\data\geo\VDOT\drainl1. The Proposed DTM does
not cover the areas where possible pond locations area available. Setup the dialog as shown

below.
F:j Surface Po o El

TIN File: | survey tin

Options

6885 <7,
w s Bl

Display Ony Pords: [ —
lslands: _

[ Set Graphic Group

3. Click Apply. GEOPAK will display the possible areas where ponded runoff is located.

Note Turn on the View Attribute called ‘FILL’ This will shade the areas on the surface where the
ponds would be located.

Analyzing the Pond Locations

1. Select the Pond Analysisicon.
Cptions

68E5SY,
e b i

Display Only Ponds: Pond Analysis
Islands:

2. Click Apply.
3. Data Point inside one the areas that we just determined had ponding occurring.
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Lab Exercise: Analysis of the Proposed DTM

TIM File: | survey tin

Options

8a% 5 S
o i

Display Only Ponds: _
lslands: _
Volume Cubic Feet »| 19173.932CF

Pond Surfface Area: 1027.280 S5Y
Maximum Suface Bevation: 2010147
Maximum Pond Depth:  6.057

[ Apply |

4. Following the previous steps, analyze other possible pond locations.
5. Close the Pond Analysis dialog when done.
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Lab Exercise: Plotting Profile Elevations along the Centerline

LAB EXERCISE: PLOTTING PROFILE ELEVATIONS ALONG THE CENTERLINE
Loading the Custom VDOT VBA Application
You can find the custom VDOT Macros in the VDOT Tools Tasks Navigation Menu under

VDOT GEOPAK Drainage

the Drainage section.

Tasks hd ]
[;;_—23 YDOT Taols [

LR ISEY ¥
;ﬁ»ﬁ»ﬁ »il_ﬂ»b—l»% E@ﬁ @»
& Survey

bli Bridge

f{‘ Geometry

4 DTM Tools

2 Road

é; Drainage

=D Traffic R
2 Site

ﬁa' Water Sewer

Flans Prep & Quantities

" Landscape
Geotechnical

C€|C||C|([C| €| €| €| €[ €||€| ¢

1. Select the Draw Profile into Plan icon. (3" Icon from Left)

Job: [101 - Elevations | Flow Arrows | HP and LP |

Chain: |MAINLINE A v Label Elevations

Profile: |MAINLINE - Increment: |50
Prefix: |EL

Station Range 12.34
Begin: |200+00.00 ﬂ
End: |208+69.97 ﬂ

3. Double click on the text box to setup the text size and level symbology.

© 2011 Bentley Systems, Incorporated
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Lab Exercise: Plotting Profile Elevations along the Centerline

2-12

[Label Attributes )

Level: |Leve| 2 j
Color: I:‘ 7 TH: |3— —lﬂ
Weight: |1 | w3
Font: |WORKING |

Justification Decmals: (2w

00 Crientation:

= O Radial -
SES e, Offset: [0

Cancel ‘

4, Click Set when done.
5. Select the Flow Arrowstab.

6. Attach the Microstation cell library that contains the flow arrow cell
C:\proj\supv8i\cells\design\drainage.cel. (Ms Menu: Element > Cells).

7. Close the Cell library dialog.
8. Setup the Flow Arrows part of the dialog as shown below.

- Elevations §

Chain: |MAIMLINE - ¥ Draw Flow Arrows
Profile: |MAINLINE v Increment: |50
Cell Name: |FLOWA

Cell Scale: |4
Station Range

Begin: Wﬂ Offset: |2

End: |208+69.57 ] —

9. Select the HP and L P tab and setup the dialog as shown below.

Job: |101 - Elevations ] Flow Arrows HP and LP

Chain: |MAIMLIME - v Label High and Low Points
Profile: |MAIMLINE - High Point Prefix: |HP
Low Point Prefix: ,LP—

Station Range 12.34

Begin: |200+00.00 Lol

End: |208+69.57 | Draw

10. Double click on the text box to setup the text size and level symbology.
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Lab Exercise: Plotting Profile Elevations along the Centerline

Level: |Leve| 2 j
Color: I:‘ 4 TH: IT —lﬂ
Weight: |1 | Tw: s
Font: |WORKING |

Justification Decmals: (2w

@ Crientation:

S S Radial -
SES e, Offset: [0

Cancel ‘

11. Click Set when done.

12. Click the Draw button. GEOPAK will place the profile elevations along the centerline and
show the direction of flow. The low and high points of the profile are also labeled.
13. Close the dialog when done.

14. Exit Microstation.
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Lab Exercise: Setting Up Land Use Areas

LAB EXERCISE: SETTING UP LAND USE AREAS

Creating Land Use Shapes

1. Open the MicroStation file, c:\data\geo\VDOT\drain1\h17682da.dgn.

2. Create Microstation shapes depicting the land use areas of the project: pavement, grass,
building, etc. (MSMenu: Tools> Base Geometry > Polygons > Open as Toolbox)

Assigning Proper Land Use Symbology
1. Open GEOPAK Drainage. (MSMenu: Applications> GEOPAK > Drainage).
2. Open the GEOPAK Drainage Library tool. (Drainage : Project > Drainage Library)

3. Verify that the VDOT Drainage Library: VDOT.dIb located in
C:\proj\supv8i\geopakiroad\standards is open.

File Edit

| Rairfall | Land Use " Nodes ” Links " Spread Section |

Element 1D Description
York Rainfall tem
Whthe Rational
Wise Rational
Winchester City Rational
Williamsburg City Rairfall ttem
Westmorand Rational
Washington Rational
Wamen Rational
Virginia Beach City Rational
Type Il SCS Unit Hydrograph
Tazewel Rational
Sussex Rational

4. Close the Drainage Library dialog.
5. Select the Land Use tool (Drainage: Component > Land Uses)

i and Use tem: VDOT

Runoff C | Land Use Description
0.200 Business, 0to 2%
D0.850 Business, 2to 5%
0500 Business, = 5%
0.650 Apartments, Dto 2%
0.700 Apatments, 2to 5%

Land Use Symbology: _

Fick Boundary | DF

Elements Create Shape

| Select Shape

6. Select the Impervious land use.
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Lab Exercise: Setting Up Land Use Areas

5 Land Use Boundan [ —

Land Use kem: [VDOT

Runoff C | Land Use Description

0.280 Unimprov 2to 5%
Unimprow = 5%
Impervious
Cultivated Oto 2%
Cuttivated 2to 5%

Land Use Symbology: =

Pick Boundary DP
Bements | Create Shape | Select Shape

7. Click the Select Shape button.
8. Select the previously placed Microstation shape that depicts the pavement portion of the
project.
Note A new level symbology will be assigned to the shape.
9. Repeat the process with all the shapes defined and assign the proper land use.
10. Close the dialog when done.
11. Exit Microstation.

VDOT GEOPAK Drainage © 2011 Bentley Systems, Incorporated
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3

OBJECTIVES

Starting a Drainage Project

In this chapter, you will learn more about:

. Various file types used within GEOPAK Drainage.

. Creating a new GEOPAK Drainage Project file.

. The general process for using GEOPAK Drainage to design a storm drain system.

GEOPAK DRAINAGE

GEOPAK Drainage has four major components within each project: the GEOPAK Drainage File
(*.gdf), MicroStation 2D design file, Drainage Library, and the MicroStation Cell Library. In contrast
to the GEOPAK Drainage File and MicroStation graphics file, the Drainage Library and Cell Library
are utilized for numerous projects, as they contain the Department’s standards. The designer only has
to select the desired items for each specific project.

File Type Description
GEOPAK Drainage This binary file contains all the hydraulic information about the drainage
File (*.GDF) system. Each GEOPAK Drainage Project contains Preferences, which

include hydrologic and hydraulic computation options, visualization
symbologies, and project file references to the Drainage Library and
GEOPAK GPK files. Spatial data, connectivity and hydraulic properties
for each drainage feature are stored in this external file. Sufficient data is
maintained to rebuild the graphical representation of the Drainage Project
with the exception of certain features, which are defined by MicroStation
elements.

MicroStation Design
File (*.DGN)

This two or three dimensional graphics file is utilized for the visualization
of the drainage project and definition of certain drainage features using
MicroStation graphic elements. The only data stored within this file are
attributes attached to the graphics for reference to the GEOPAK Drainage
file (.gdf).

DrainageLibrary
(*.DLB)

The Drainage Library is utilized for numerous projects, as it contains the
standards for an entire organization. The Drainage Library contains the
Rainfall Parameters, standard inlet types, standard pipes configurations,
spread sections, and land use symbology tables. All of these items are
merely referenced by each project to accommodate standardization and
information sharing among projects.

Drainage Cédll Library
(*.CEL)

Drainage cells are the plan views of the Department’s drainage structures
such as inlets and manholes. The Cell Library contains the commonly
used structures. The Nodes used in the Drainage Library refer to
appropriate cells in the Cell Library.

Design and
Computation M anager
database (*.DDB)

The Design and Computation Manager database is used for the
Department as a tool to expedite the drafting of plans using the VDOT
CADD Standards. The D&C Manager also allows the designer to
compute plan view quantities based on MicroStation level symbology.

Geometry Database
(*.GPK)

The gpk file is a database that stores all the geometric information of the
project. All alignments (chains), profiles, points, curves, spirals, parcels

VDOT GEOPAK Drainage
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DRAINAGE COMPONENTS

are saved into a single file per project. Then, Geopak Drainage can refer
to the nodes location by station and offset from a particular chain and get
or calculate elevations from a profile.

MicroStation Design File (*.DGN)

Drainage Project File (*.GDF) \ Drainage Library File (*.DLB)
/\ h

¥/ \¥/

Project Preferences Rainfall Parameters
Land Use Symbology

Project Drainage Features <

~ Pipes

Inlets

Drainage Cell
Library (*.cel)

D & C Manager
Database (*.ddb)

DRAINAGE COMPONENTS

GEOPAK Drainage organizes the components of a drainage system according to their spatial
characteristics. Spatial information is stored as Nodes, Links and Networks.

e Nodes: A node (inlets, manholes, etc.) is a point with a user-defined location. The location
may be in Cartesian coordinates (x,y) or in curvilinear coordinates (station, offset).
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MAIN MENU BAR

Links: A Link represents a linear feature depicting a path connecting two nodes, traversing
upstream to downstream. The path may be straight line or curvilinear (along a graphic
element).

Networks: A network is a system of interconnected nodes and links that form a system
through which water can flow to a single outlet node. A drainage project accommodates any
number of Networks.

Other associated components in GEOPAK Drainage include:

MAIN MENU BAR

Areas: A drainage area can be represented by a closed boundary or simply keyed-in (acres or
hectares). All flows from a single drainage area are tributary to a single Node. There is a one
to one correspondence between a node and an area. Therefore areas and nodes share the same
name (ID). A drainage area may contain multiple sub areas representing homogeneous
features such as soil types and land uses (“C” values), thereby allowing composite "C" value
calculations.

Profiles: A profile represents a path connecting any two nodes in a Network. Profiles provide
the visualization of profiles between any two nodes in a drainage network.

GEOPAK Drainage is invoked from within a two dimensional MicroStation graphics file. At the
Applications pull down, select GEOPAK Drainage, which accesses the software and displays the main
GEOPAK Drainage menu bar as depicted below.

6] DRAINAGE - Untitlec |

Project  Component  Network Reports  Utilities  Tool Boxes

Each menu selection accesses GEOPAK Drainage project information, feature placement and tools
necessary to complete a GEOPAK Drainage project. Tool frames and toolboxes are also supported for
all functions and are accessed via the Tools pull down.

PROJECT MENU SELECTIONS

The Project Menu selections are utilized for creating new GEOPAK Drainage projects, opening
existing projects, saving projects, establishing the project Preferences, editing the Drainage Library,
importing and exporting between GEOPAK Drainage Files (gdf).

| £1 DRAINAGE - Untitlec =

Project Compenent Metwork Reports  Utilities Tool Boxes

VDOT GEOPAK Drainage

QOpen...
Sawve

Save As...

Preferences
Drainage Library
Import 3
Export 4
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COMPONENT MENU SELECTIONS

COMPONENT MENU SELECTIONS

The Component menu selections provide the mechanism to add, edit and delete the various elements,
which comprise a drainage system including Areas, Nodes, Links, Profiles, and Land Uses. Each of
these tools invokes a dialog wherein the specific component information can be added or edited.

Project Component Metwork Reports  Utilities  Tool Boxes

Area 3
Mode | Add.
Link »| Edit
Profile | I
Delete
Culvert *
= Rename
Routing 3
Renumber
Land Uses
Miscellanecus Utilities y| UpdateAll
Update with Pay Items

NETWORK MENU SELECTIONS

The Network menu selections provide tools to add, edit, delete, and manipulate a drainage Network.
While work is being done on a particular Network, it can be identified as the Active Network, which
dictates which features are contained in the calculations and provides quick access to the components
of a specific Network. Once a Network is added to the project and set as the Active Network, the
Design and Analyze options perform their respective hydraulic procedures on the Network.

Project  Component | Metwork | Reports  Utilities  Tool Boxes
Add... '
Edit
Delete

Rename

Design

Analyze

Active Network

REPORTS MENU SELECTIONS

The Reports menu selections provide access to the predefined hydrologic and hydraulic reports
available and to the Custom Report Builder and Generator.

Project Component MNetwork | Reports | Utilities  Tool Boxes

Drainage Areas
Inlets 2
Storm Drains/Links »

Builder...

Generate
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TooLS MENU SELECTIONS

The Tools menu selections provide access to all Tool Boxes, Navigator, Labeler, Culvert, Routing and
DTM Drainage Tools.

(50 DRAINAGE - Untitled - =

Project Component Metwork Reports  Utilities | Tool Boxes
Main

Project
Area
MNode
Link
Profile
MNetwork
Routing
Culvert
Reports
Utilities

GENERAL DESIGN PROCESS FOR STORM DRAINS

The design of a storm drain system is usually an iterative process. Inlets locations and pipe sizes are
selected. The designer then checks if the system meets the Department’s criteria and changes pipe
sizes and other items as needed. The need to check if the system meets criteria is not avoided by using
GEOPAK Drainage. This document describes several ways that designers can use GEOPAK to check
and identify where the system need to be changed. The following is a general outline for creating
storm drain systems in GEOPAK. Details are provided in other chapters.

Start a New Project file (.gdf) by setting Project Preferences.
Select Inlet locations and types by adding Nodes.

Define the Areasto each node

Link the inlets together with pipe segments.

Identify the Network of pipes and inlets.

Use GEOPAK to Design the system.

N o gk~ w D oe

. Check if the design meets criteria. This can be done by several methods such as profiles, querying,
warnings, or output reports.

8. Edit the system, re-compute the hydraulics and check if criteria are met.
9. Print the VDOT Storm Drain Tabulation Form.

Note It is recommended that the designer should create or use an already existing Geopak Road
Project Manager file (*.prj). This will help locate other project files that Geopak Drainage may
use (Design and Computation Manager ddb file, Coordinate Geometry gpk file, etc).

VDOT VBA APPLICATIONS

The Department has provided VBA applications for specific tasks during the design and plans
production process of the drainage system. These VBA applications are accessed thru the
MicroStation: Utilities>Macro menu. They are:

e Draw flow arrows along the roadway centerline analyzing the profile conditions.

e Draw Drainage Storm Sewer Tabs: creates an Excel spreadsheet for the VDOT Storm Tabulation
form with information extracted from the GEOPAK Drainage gdf file.
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ACCESSING GEOPAK DRAINAGE

o Sketch of Geopak Drainage Network: creates a jpg image with a sketch (not to scale) of the
selected drainage network.

e Draw flow directional arrows along the pipes.

AccessING GEOPAK DRAINAGE

GEOPAK Drainage is invoked from within a two dimensional MicroStation graphics file. At the
Applications pull down, select GEOPAK Drainage, which accesses the software and displays the
Drainage application into the MicroStation pull-down menu.

Each menu selection accesses GEOPAK Drainage project information, feature placement and tools
necessary to complete a GEOPAK Drainage project. Tool frames and toolboxes are also supported for
all functions and are accessed via the Tools pull down.

GEOPAK Drainage always starts in an ‘Untitled’ project as noted in the MicroStation menu bar.
Therefore it is necessary to always either create a new project or open an existing project prior to
performing any other GEOPAK Drainage functions.

LAB EXERCISE: OPENING A NEW GEOPAK DRAINAGE PROJECT
> Create a New Geopak Drainage Project
1. Access GEOPAK Drainage (MSMenu: Applications> GEOPAK > Drainage).

All items in Drainage can be accessed through this main GEOPAK Drainage menu. GEOPAK
Drainage opens in an Untitled project file.

2. Open a new drainage project, c:\data\geo\vdot\drain1\h17682.gdf (Drainage Menu:
Project>0Open).

J F:j Open Drainage File - 11 Ll
Lookin: || drainl - @ F = m

D= Mame Date modified Type
el | HECRAS 5/23/2011 7:39 AM  Filefolder
RecentPlaces | 1 iojdbs 5/23/2011 T42 AM  File folder
! , standards 5/23/2011 7:22 AM  File folder
J standards_1 5/23/2011 7:39 AM File folder
Desktop t| | h17682.qdf 5/11/201112:37 PM  GDF File

w=ull

Libraries

A

—

Computer
@
]

File name: h17682 gdf

Files of type: = gdf
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LAB EXERCISE: OPENING A NEW

GEOPAK DRAINAGE PROJECT

VDOT GEOPAK Drainage

The following files are utilized for this project.

Drainage Design File

h17682.dgn

Reference File (land use file)

h17682da.dgn

Reference File (proposed roadway file)

d17682des.dgn

Reference File (existing topography)

s17682.dgn

Reference File (service utilities)

sul7682.dgn

English Drainage Library vdot.dlb
English Cell Library drainage.cel
GPK Alignment File job101.gpk
GEOPAK Drainage File (to be created) h17682.gdf
Existing Triangulated Irregular Network file (TIN) survey.tin

Proposed Triangulated Irregular Network file (TIN)

proposed.tin

Select the Main Drainage Tools tool frame. (Drainage Menu: Tool Boxes > Main)

[ 50 DRAINAGE - h1768:

Project Component Network Reports  Utilities Tool Boxes

The GEOPAK Drainage tool frame is similar to the MicroStation main tool frame, is 2x7, not

resizable, but can be docked.

r_Drainage Tool Box g

Bl s/ e VIR

During the course you will become familiar with the various tools on this tool frame.

© 2011 Bentley Systems, Incorporated

3-7



LAB EXERCISE: OPENING A NEW GEOPAK DRAINAGE PROJECT

3-8 © 2011 Bentley Systems, Incorporated

VDOT GEOPAK Drainage



GEOPAK Drainage Project
Preferences

OBJECTIVES
The objective of this chapter is to review the Project Preferences.

INTRODUCTION

GEOPAK Drainage supports a wide array of user defined Preferences which enables the designer to
set project specific options, or a large organization to set parameters to maintain standards. Each
GEOPAK Drainage project contains a set of Preferences and they remain with the project.
Computation options in the Preferences may be changed easily and the systems completely redesigned
utilizing the new computation options. The Preferences are invoked via Project > Preferences menu
selection. The Drainage Preferences can also be invoked by selecting Tool Boxes > Main, then
identifying the Drainage Prefer ences tool, (first column, top box).

File

Options
Units @ English () Metric

PI‘C!]ECt Comporents Drainaae Area = Acres Drainaae Area = Hectares

Rainfall Parameters Length = Feet Length = Meters

Land Use Options Dimension = Feet Dimension = Meters

Fregquency Options Depth = Fest Depth = Meters

Intensity Option Discharge = Cubic Feet per Second Discharge = Cubic Meters per Second
Junction Loszes Velocity = Feet per Second Velocity = Meters per Second

Inlet Options Intensity = Inches per Hour Intensity = Milimeters per Hour

Mode Options
Link: Cptions
Profile Options
Plan Symbology
Updates

Save Options

OK Cancel

The general Options are displayed in a list box in the left side of the dialog, while the right side
displays parameters for the highlighted Option. As different Options are selected in the list box, the
right side of the dialog will change dynamically to reflect the parameters for highlighted Option.
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UNI TS

UNITS

The first Preference is Units, which establishes the input and output units for the current project. Two

supported options are English and Metric. FDOT supports only English units.

File

Options

Units

Project Components
Rairfall Parameters
Land Use Options
Frequency Options
Intensity Option
Junction Losses
Inlet Options

Mode Options

Link: Cptions

Profile Options
Plan Symbology
|Updates

Save Options

@ English

Drainage Area = Acres

Length = Feet

Dimension = Feet

Depth = Feet

Discharge = Cubic Feet per Secand
Velocity = Feet per Second
Intensity = Inches per Hour

(7 Metric

Drainage Area = Hectares

Length = Meters

Dimension = Meters

Depth = Meters

Discharge = Cubic Meters per Second

Velocity = Meters per Second

Intensity = Milimeters per Hour

Within each group box is a listing of the units utilized for GEOPAK Drainage. These are display only
and cannot be changed.

Projects with mixed units are not supported within GEOPAK. There are no other unit specifications
within the project. The data input is expected to be in the proper units (English and Metric). As fields
are entered in the dialogs the units required will be displayed in the MicroStation Command Prompt.

Coordinate geometry databases (GPK files) must also be in the specified units when created within
GEOPAK ROAD. For additional information on this topic, refer to the GEOPAK Online help >

Coordinate Geometry.

© 2011 Bentley Systems, Incorporated
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PROJECT COVPONENTS

PROJECT COMPONENTS

The Project Components define the location of all files utilized by the project.

File

Options

Uitz

Project Components
Rainfall Parameters
Land Use Options
Fregquency Options
Intensity Option
Junction Losses
Inlet Cptions

Mode Options

Link Options

Profile Options
Plan Symbology
Updates

Save Options

Drainage Library File (DLB): | C:\proj‘supviitgeopak road standa Q,

GPK Job Number: Q

Drainage Cell Library: | C:\projsupv&itcels'\design drainage Q

Criteria Directory:
DDB: | C:hproj'supvBitgeopakroad ddb* VI
Water and Sewer Project:
Superelevation Shapes File:
[] Site Project:
Original Ground

TIM File hd

Design Suface

TIM File hd

DrainageLibrary File
(DLB)

Reference to the Drainage Library file containing the Rainfall Parameters, Land
Use Options, Node Library items, Link Library items and spread sections. This
file can be located within the working directory, in which case, no path need be
specified. However, a more prudent option is placing the Drainage Library File on
a central server or directory, so that all hydraulics designers can access the same
database. This ensures standardization and minimal maintenance. The file name
(and optionally, the path) may be supplied. Clicking Files opens the MicroStation
File Manager, wherein the path and database file may be selected.

The drainage library is vdot.dlb. The file is provided by VDOT.

GPK Job Number
(optional)

GEOPAK coordinate geometry database which contains all alignment and profile
information for the project. Creation and manipulation of this binary file must be
accomplished from within GEOPAK ROAD. The file name of the database is
job*.gpk, where * is a one to three alphanumeric name unique to each project. It is
this name that should be typed into the GPK Job Number field. In lieu of typing, it
may be selected by clicking Select. For VDOT project the job number is always
101, but for that particular reason, special attention must be given to the directory
path where the gpk file of the project is located.

VDOT GEOPAK Drainage
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ProJect COVWPONENTS

Road Preferences

Output Accuracy
Distance: |39.1234 -
Station: 5+—@'5 12 -
Angle Seconds: (379912 ¥

{Unit System: [ English -|
Coondinates: |NE A
Direction: [Bearng =]

Station: | 12+34 hd

Working Directony: Q.
[ Feature Preferences... I
| COGO Preferences.. |

g——

[7] Show this dialog at startup

The working directory, wherein the GEOPAK coordinate geometry database is
located, is specified within this dialog. The directory may also contain other
project files, which is desirable; however, this is not required by GEOPAK
Drainage.

The designer should adjust the Output Accuracy group settings as desired, since
they will not affect the precision and accuracy of the drainage calculation. They
are just output values.

Drainage Cell Library

Cell library containing cells utilized for Nodes contained in the Drainage Library.
The cell library is drainage.cel. The file is provided by VDOT.

Criteria Directory

Directory wherein the criteria to draw nodes, links and other drainage data onto
cross sections is stored. VDOT does not uses this functionality.

GEOPAK DDB

Defines the Design and Computation Manager which is utilized for matching pay
items to the Drainage Library in order to draw nodes and links at the desired
symbology and final quantities computation upon completion of the drainage
design. The file is VDOTenglish.ddb.

Water and Sewer Project

To leverage data from a Water and Sewer project, activate the toggle, then select
the directory and GWS file. This is not a required element for the drainage design.
VDOT has not standardized the usage of GEOPAK Water and Sewer.

ShapeFile Optional, GEOPAK superelevation shapes created in GEOPAK Road can be
leveraged into drainage. Specify the path and file name by manual entry via the
browse icon. In order to utilize and extract superelevation shapes data from the
superelevation shape file, the file must be referenced into the active design file.

Site Project To leverage data from a Site project, activate the toggle, then select the directory

and GSF file. A site project model or object may be used. This is not a required
element for the drainage design. VDOT has not standardized the usage of
GEOPAK Site.

Original Ground

The Model , Object or tin file to be used as existing ground. The Original Ground
profile along the drainage pipes is drafted when drawing the profile of the
drainage system.

Design Surface

The Model , Object or tin file to be used as another reference surface, in this case
as a “proposed” surface. The Design Surface profile along the drainage pipes is
drafted when drawing the profile of the drainage system.

4-4
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RAINFALL PARAMETERS

RAINFALL PARAMETERS

The Rainfall Parameters dialog establishes the rainfall parameters for computing intensities and
discharges for the current project.

File

Options

Units

Project Components
Rainfall Parameters
Land Use Options
Fregquency Options
Intensity Option
Junction Losses
Inlet Cptions

Mode Options

Link: Cptions

Profile Options

Plan Symbology
Updates

Save Options

Rational Method

Rainfall Source: [Henrico

SCS5 Method

Rainfall Source: [Type Il

() Antecedent Moisture Condition |

@ Antecedent Moisture Condition 11
(7)) Antecedent Moisture Condition |11
Hydrograph Time Interval: | 5.000

Rational M ethod
Rainfall Source

The Rainfall Data Source for computing intensities and discharges, which is
stored within the Drainage Library File, therefore it may only be selected here.
Select the zone where the project is located. Refer to the VDOT Hydrology

Handbook for the boundaries of the zones

SCSMethod:
Rainfall Source

The Rainfall Data Source for computing discharges, which is stored within the
Drainage Library File. Therefore, it may only be selected here. The Antecedent
Moisture Condition | is the lowest runoff potential (dry soil), while Antecedent
Moisture Condition I1 is the average condition, while Antecedent Moisture

Condition I11 is the highest runoff potential (saturated soil).

Hydrograph Time
Interval

Specified in minutes.

VDOT GEOPAK Drainage
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LAND UsSe OPTIONS

The Land Use dialog establishes the land use options used to delineate sub areas and runoff
coefficients for the current project.

File

Options

Units

Project Components
Rairfall Parameters
Land Use Options
Frequency Options
Intensity Option
Junction Losses
Inlet Options

Mode Options

Link: Cptions

Profile Options
Plan Symbology
|Updates

Save Options

Rational Method
@ Single Land Use kem:  [VDOT
(C) Multiple Land Use tem:

Land Use tem Level | Calor | Weight Style

voor =) smooeor D

5C5 Method
@ Single Land Use tem:  [VDOT |
(7 Multiple Land Use ftem:

Land Use tem Level | Color | Weight Style

=) Sboks. [

Different Single and Multiple Land Use Items can be defined for the Rational and SCS Method.

Since the Rational Method is the standard methodology used for VDOT Storm Drain projects, the
designer should disregard the settings for the SCS Method.

SingleLand Useltem

The land use source from the Drainage Library containing the runoff
coefficients and symbology for land use delineation may be selected from the

list box.

Multiple Land Use Item

The land use sources from the Drainage Library containing the runoff
coefficients and symbology for land use delineation. To select, utilize the
down arrow in the list box and select the desired option. The item selected
must be associated with a symbology that matches the symbology of each of
the main land use shapes in the design file. The Department has only defined
a Single Land Use Item in their Drainage Library. Therefore, this option

would not be used by the designers.

4-6
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FREQUENCY OPTIONS

The Frequency Options dialog establishes the computation frequency and runoff peaking factors for
discharge computations for the current project.

File

Options

Units

Project Components
Rainfall Parameters
Land Use Options
Freguency Options
Intensity Option
Junction Losses
Inlet Cptions

Mode Options

Link: Cptions

Profile Options
Plan Symbology
Updates

Save Options

Drainage Library (DLB): .. ‘\supv@i*geopak'road‘standards"VDO T dib

Rational Frequency Cptions

Computation
Frequency:

SCS5 Frequency Options

Cumulative
Frequency:

Runoff Coefficient
Peaking Factor:

1.0000

Runoff Coefficient
Peaking Factor:

1.0000

DrainageLibrary File

The current Library File as specified in the Project Component option, is
displayed. It cannot be changed from this dialog, only in the Project Components.

Computation Frequency
(Rational M ethod)

The displayed frequencies are selected from the available entries in the Rainfall
Parameters chosen from the library. Select the appropriate frequency for the
project. Refer to the VDOT Drainage Manual for further details. These fields
cannot be modified except through the Drainage Library dialog.

Cumulative Frequency
(SCS Method)

The displayed depths are selected from the available entries in the Rainfall
Parameters chosen from the library. The SCS approach is not standard for VDOT
storm drains, but it can be used for preliminary routing calculations. These fields
cannot be modified except through the Drainage Library dialog.

Peaking Factors

Runoff coefficient peaking factors to be applied in the runoff computations. These
factors are used to adjust runoff coefficients for differing frequency rather than
entering multiple set of coefficients for each frequency.

VDOT GEOPAK Drainage
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INTENSITY OPTIONS

The Intensity Options dialog establishes the intensity computation options for the current project.

File

Options
Units Drainage Library (DLB): ...\supv&‘geopak’road*standards" VDO T.dib
Project Components
Rainfall Parameters
Land Use Options Accumulate Pipe Flow Time by: [Uniform Fow Velocity |
Frequency Options . .

Intensity Option Intensity Options

Junction Losses @ Compute Intensity from Library Rainfall Data Source
Inlet Cptions (71 Absolute Intensity:

MNode Options s !

Link Options [] Weight Time of Concentration

Profile Options
Plan Symbology

|Updates
Save Options Absolute Intensity: | 4.0000

Minimum Time of Concentration: | 10.0000

Inlet Computation Only

DrainageLibrary File The current library file, as specified in the Project Component option, is
(DLB) displayed. It cannot be changed from this dialog, only in the Project
Components.

Minimum Time of Minimum Time of Concentration to use in discharge computations. This is used
Concentration throughout the computations as the minimum. In pipe hydraulic computations
this value will be used until the actual time of concentration within the systems
exceeds this value. Specified in terms of minutes.

The VDOT Drainage Manual specifies a minimum of 5 minutes.

Accumulate Pipe Flow This option controls how travel times through the pipes are determined. The

Time_by: Uniform Flow following provides an overview.
Velocity
Full Flow Velocity VDOT usesthe Uniform Flow M ethod. When selected, the velocity associated

Iterative Velocity with normal depth (uniform flow) establishes the travel time.

If Full Flow Velocity is selected, the velocity associated with full flow velocity
(V= Q/A) establishes the travel time.

If the Iterative Velocity method is selected, GEOPAK makes three passes up and
down the network performing runoff and hydraulic calculations. By making
several passes, the velocity used to compute the travel time closely matches the
actual flow conditions. For pipes flowing full, the full flow velocity (V= Q/A)
establishes the travel time. For pipes flowing partially full, the average velocity
through the pipe establishes the travel time. GEOPAK performs backwater curve
(water surface profile) calculations so the average velocity is often different than
normal depth (uniform flow) velocity.

Intensity Options Group Intensity options which allow for specification of an absolute (constant) intensity
or computed intensities to use throughout the network discharge computation
procedures.

Select Compute I ntensity from Library Rainfall Data Source for VDOT
project since the rainfall intensities are already predefined in the library.

Compute Intensity from Utilizes the values established and computed from the Rainfall Parameters
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Library Rainfall Data
Source

(either default equation or table) from within the Drainage Library File.

Absolute | ntensity

A constant intensity that overrides the Drainage Library File and utilizes the
specified value for all discharge computations. It is specified in terms of in/hr or
mm/hr depending on the project units.

Weight Time of
Concentration

When utilizing combining different types and times of concentration, activating
this toggle weights the times of concentration such that the discharge will not
decrease. Ignore this toggle for VDOT projects.

Inlet Computation Only:
Absolute | ntensity

A constant intensity that overrides the Drainage Library File and utilizes the
specified value for discharge computations required for inlet and spread
calculations only. Network hydrologic discharges will be computed as specified
in the Intensity Options. Note, however, for the value to be utilized, the toggle to
the left of the Absolute Intensity within the Inlet Computation Only group box
must be activated or the value will be ignored. Specified in terms of in/hr or
mm/hr depending on the project units.

VDOT performs most inlet and spread calculations on 4 in/hr.

Note The user should recognize that there are situations where roadway classification and design
speed will dictate that an “actual” calculated rainfall intensity be used in lieu of the Absolute
Intensity setting of 4 in/hr. Refer to Table 9-1 in Chapter 9 of the VDOT Drainage Manual, for
further guidance. In these situations, the switch for Inlet Computation Only should be Toggled
OFF; and the software will compute the rainfall intensity for the inlet computations.

JUNCTION LOSSES

The Junction Losses dialog establishes the junction loss equations and coefficients utilized in Link
hydraulic calculations for the current project. When selected from the Options list, the dialog depicted

below is displayed.

A e o -~

File

Options

Units

Project Components
Rairfall Parameters
Land Use Options
Frequency Options
Intensity Option
Junction Losses
Inlet Options

Mode Options

Link Cptions

Profile Options

Plan Symbology
Updates

Save Options

[ Disable All Junction Loss Computations

Loss Velocity: |Actual -

Description Loss Coefficient - K
Pressure Expansion: | 0.3000
Free Surface Expansion: | 0.1000
Pressure Contraction: | 0.5000
Free Surface Contraction: | 0.3000

Bend Loss: |Method 1 =

Teminal Inlet/Junction: | 1.0000

Simple Junction: | Method 1 -

Cancel Complex Junction: |Method 1 «

Unique Loss Coefficients (K) can be specified in the fields to the right of each Description, and apply

to the whole project. On the other hand, designers can specify a particular Loss Coefficients for each
junction in the "Node Configuration - Junction Loss" Dialog box discussed in the Nodes Chapter.
However, if the Disable All Junction Loss Computations is activated, no losses will be computed for

the entire project.

VDOT GEOPAK Drainage © 2011 Bentley Systems, Incorporated
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Disable All Junction L oss
Computations

If the toggle is active, no Junction Loss computations are calculated, regardless of
the option selected in the Nodes - Junction dialog. Note if a single or small
number of Junction Losses are not desired, an option is provided in the Nodes -
Junction dialog to accomplish this. The toggle here applies to the entire project.

Loss Velacity

Losses can be computed on Actual or Full Flow.

Pressure Expansion

Loss coefficient to be used in pressure (full flow) expansions within the system.

Free Surface Expansion

Loss coefficient to be used in free surface (partial flow) expansions within the
system.

Pressure Contraction

Loss coefficient to be used in pressure (full flow) contractions within the system.

Free Surface Contraction

Loss coefficient to be used in free surface (partial flow) contractions within the
system.

Bend Loss

Specify the methodology and source of bend loss computations. Method 1 utilizes
Modern Sewer Design, while Method 2 utilizes AASHTO methods.

Terminal Inlet / Junction

Loss coefficient to be used at terminal inlets or junctions (no upstream pipes)
within the system.

Simple Junction

Specify the methodology for computing junction losses at simple junction (one
pipe into the junction and one pipe out).

Complex Junction

Specify the methodology for computing junction losses at complex junctions
(more than one pipe in and only one pipe out).

INLET OPTIONS

The Inlet Options dialog establishes the default inlet variables to use in the Node Configuration
Properties dialog for each type of Inlet.

4-10
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(41 preferences - iniet Oprion NN = - x|

File

Options

Units

Project Components
Rainfall Parameters
Land Use Options
Frequency Options
Intensity Option
Junction Losses
Inlet Options

Mode Options

Link: Cptions

Profile Options
Plan Symbology
|Updates

Save Options

Inlet By Pass Options: By Pass as Total Discharge |

Link By Pass Flow Options: Do Mot Allow Inlet By Pass in Link Dischanges + |

Default Spread n Value: | 0.0150

[7] Bxtend Superelevation Shapes to Inlet at Shape Slope

Cancel

Inlet By Pass Options

This option indicates the method by which Inlet by pass flows are accounted for in
the system. By Pass as Total Discharge will account for by pass flows as the
difference between the total discharge to the inlet and the inlet capacity. This
difference, expressed in flow units, will be the total by pass from the inlet and can
be added at a subsequent downstream inlet.

VDOT spread calculations have typically been performed using this approach.

By Pass as C x Area Product, on the other hand, is determined from the total
bypass at the inlet as a product of runoff coefficient and drainage area that is
contributing to the total bypass at the inlets computed intensity. This product of
area and runoff coefficient will then be added to the composite runoff coefficient
and area at the downstream inlet.

Link By Pass Options

This option indicates the method by which Inlet By Pass flows are accounted in
the Link discharge computations. Do Not Allow Inlet By Pass in Link Discharges
will prevent the system from bypassing discharges from one inlet to the next when
Link discharges are computed. The total discharge that reaches the inlet will be
considered entering the Link at that point. This option in no way impacts the inlet
computations, bypass flows will be reflected in these computations.

VDOT uses this first approach.

Allow Inlet By Pass in Link Discharges will account for the discharge that
bypasses the inlets when the Link discharges are computed. Only the discharge
entering the inlet will be considered entering the Link at that location. Bypass
flows will be directed to the appropriate inlet and the Link accordingly.

Default Spread N Value

The default Manning's roughness coefficient for the spread hydraulic
computations.

Extend Superelevation
Shapesto Inlet at Shape
Slope

This option extends the slope of the last superelevation shape to the drainage
location point of the drainage node. E.g., sometimes roadway superelevation
shapes are not created to the extend of the whole pavement width.

VDOT GEOPAK Drainage
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NODE OPTIONS

The Node Options establish the default naming prefix for Node entries and option for automatic link
updates.

File

Options
Urits Default Mode 1D Prefoc: | 3-

Project Components )
Rairfall Parameters [7] Scale Nede Cells ~ Scale Factor:

Land Use Options Mirimum Freeboard: | 1.0000
Frequency Options
Intensity Option
Junction Losses
Inlet Options

MNode Options

Link Cptions
Profile Cptions
Plan Symbology
Updates

Save Options

Default Node I D Prefix

This prefix will be added to the beginning of the each defined Node element
automatically and then numerically sequenced by one. For example, the first
Node stored would obtain default ID in this case of 3— 1" followed by “3 — 27,
“3- 37, etc. for subsequent Nodes.

Scale Node Cells/
Scale Factor

When active, the node cells are scaled based on the specified scale factor. In this
way, the node cell can utilize standard node dimensions, but the cells are scaled
in plan view. VDOT cells should be placed at 1.0, so inactivate the Scale Node
Cells or set them to 1.0

Minimum Freeboard

This value does not affect the hydraulic computation in any way. It is used
solely to trigger a warning message (HGL Blowout) if the hydraulic gradient
causes less free board. GEOPAK measures freeboard from the hydraulic
gradient to the inlet elevation.

4-12
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LINK OPTIONS

The Link Options dialog establishes the default Link design constraints.

File

Options

Units

Project Components
Rainfall Parameters
Land Use Options
Fregquency Options
Intensity Option
Junction Losses
Inlet Cptions

Mode Options

Link Options

Profile Options
Plan Symbology
Updates

Save Options

Default Link 1D Prefoc | Pipe-
Link Profile Options
Design Optimization: | Minimize Depth of Cover |

Blevation Option:

Link Design Options
@) Design for Maxdmum Capacity

~1 Design for Full Capacity
~ Design Partial Capacity (d/D) Ratio: | 1.0000
~1 Design Partial Capacity (g/Q) Ratio:

Link Slope Decimal:

Link Criteria File
File Mame: Q,

Hydraulic GradeLine Options

Hydraulic Gradeline Basis: [Equal Hydraulic Gradeline |

Default Link 1D Prefix

This prefix, similar to the one found in the Node Options, is added to the
beginning of the each defined Link element automatically and then numerically
sequenced by one. For example, the first Link stored would obtain default ID in
this case of “pipe — 1” followed by “pipe — 27, “pipe— 3", etc. for subsequent
Links.

Link Profile Options
group box

A pipe profile envelope is developed which represents the minimum soffit
elevation and maximum invert elevations for each network. This envelope is
derived from an evaluation of all the constraints of the system; minimum and
maximum depth, minimum and maximum pipe rise, minimum and maximum
slope, and any elevations held through the system. These constraints are
established later in the Link and Node dialogs. Refer to the Link and Node
Chapters for additional information. The Minimize Pipe Size option will use the
entire envelope to size pipes. If a smaller pipe will fit within the envelope at a
steeper slope then it will be selected as the candidate of choice. If using the entire
envelope does not result in smaller pipes then the top of the envelope will be used
and the appropriate pipe fitting this slope configuration will be selected.

The Minimize Depth of Cover will size pipes based on the top of the envelope,
minimum soffit elevation and the pipe fitting this slope configuration will be
selected. One Design Optimization method per project may be selected, however,
the option may be changed anytime during the design process, the results
quantified, and the effects of the Design Optimization reviewed.

Minimize Pipe Size

Drainage bases the design on minimizing pipe size, even though this may
encourage deeper excavation.

Minimize Depth of Cover

Drainage designs the system with minimal excavation, but utilizes larger pipe
sizes.

Elevation Option

This refers to the elevation reported for the ends of the links. Two options are

VDOT GEOPAK Drainage
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supported: at Hydraulic Center and at Actual Link End. Hydraulic Center reports
the elevation at the center of the node structure. Actual Link End reports the
elevation at the inside of the structure wall. Use Actual Link End for VDOT
projects. The option selected is reflected in the Link dialog in the condition
option.

Link Design Options

Only one option may be selected for a project, however, this may be changed
during the design process.

It is not critical what is selected here, because the pipes will likely be adjusted to
meet standards after GEOPAK initially designs the system. .

Design for Maximum
Capacity

This option sizes pipe using maximum capacity. This typically occurs at some
percentage (90%) less than full.

Design for Full Capacity

This option sizes pipe using full flow (100%) by depth. If a pipe is designed, the
smallest size corresponding to a capacity greater than the discharge will be
selected.

Design Partial Capacity
(d/D) Ratio

The ratio of the diameter of the pipe capacity versus the diameter of the total pipe
to be used as the maximum capacity in pipe sizing as depicted in the graphic
below. Note the value is a ratio (in decimal format) which must be equal to or
smaller than one. If the value is equal to one, the pipe is designed for full
capacity.

Design Partial Capacity
(0/Q) Ratio

The ratio of the pipe capacity versus discharge to be used in computing maximum
capacity in pipe sizing algorithms. For example if the value is set to 0.5 then all
pipes designed will have a capacity of twice the discharge and if set to 2.0 the
pipes would have half the capacity of the discharge

Link Slope Decimal

Options range from none to four. This limits the number of decimal places
reported for most link slopes.

Link CriteriaFile

Name of criteria file which draws links onto cross sections.

VDOT does not draw drainage structure cross sections as a standard. Therefore,
this entry should be blank.

Hydraulic Gradeline
Options

Hydraulic Gradefine Basis- | » Equal Hydraulic Gradefine

"Hydraulic Gradeline Options

Equal Energy Gradeline

Equal Hydraulic
Gradeline

This option for computing hydraulic gradelines assumes that the starting
downstream hydraulic gradeline of one Link is equal to the upstream hydraulic
gradeline (plus junction losses if applicable) of the downstream Link.

Use this for all VDOT projects.

Equal Energy Gradeline

This option for computing hydraulic gradelines assumes that the starting
downstream energy gradeline of one Link is equal to the upstream energy

4-14
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gradeline (plus junction losses if applicable) of the downstream Link. The
hydraulic gradeline will then proceed from the energy gradeline less the velocity
head in the pipe. If the energy value in the downstream Link does not exist (too
low) in the upstream pipe, the minimum specific energy and critical depth are
used at the downstream end of the Link.

PROFILE OPTIONS

The Profile Options establishes the default naming convention for profiles along the links designed.

File

Options

Units

Project Components
Rainfall Parameters
Land Use Options
Frequency Options
Intensity Option
Junction Losses
Inlet Cptions

Mode Options

Link Cptions

Profile Options
Plan Symbology
|Updates

Save Options

Default Profile 1D Prefc: | Pro-
[] Create Cogo Chains and Profiles

Default Profile 1D Prefix

This prefix is added to the beginning of the each defined profile automatically and
then numerically sequenced by one. For example, the first Profile stored would
obtain default ID in this case of "PRO-1" followed by "PRO-2", "PRO-3", etc.
for subsequent Profiles. If the links are to be used for COGO chains or profiles,
the length of this prefix should be within the parameters for chain and profile
character limitations.

Create COGO Chainsand

Profiles

When toggled on, the links are stored in the coordinate geometry database (GPK)
specified in the Preferences - Project Components. The link name is used as both
the chain and profile name. Stationing starts at 0+00.

This is not applicable to VDOT projects.

VDOT GEOPAK Drainage
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PLAN SYMBOLOGY

The Plan Symbology dialog establishes the element symbology for drawing the drainage features

during the design process.

File

Options

Project Components
Rairfall Parameters
Land Use Options
Frequency Options
Intensity Option
Junction Losses
Inlet Options

Mode Options

Link: Cptions

Profile Options
Plan Symbology
|Updates

Save Options

Plan View Parameters

Units Component Linear

Areas:
Fipes:
Ditches:
Culverts:

MNodes

Set Mode Cell Symbology

Inlets:
Junctions:
Outlets:
Cther:

Headwall:

Text

These are “design process’ symbology, therefore it does not need to match VDOT CADD standards.
When the design is completed, GEOPAK Drainage will update automatically all the CADD elements
to be complied with VDOT standards using the Design and Computation Manager.

Linear Any valid MicroStation symbology may be specified for drawing the component.
To set the symbology, double click on the graphic, which opens the Set Feature
dialog.

Text Any valid MicroStation text parameters may be specified. To set the symbology,
double click on the graphic, which opens the Set Feature dialog.

Label GEOPAK Drainage will automatically label drainage areas, nodes and link to aid

during the design process when the toggle is activated

UPDATES

The Updates dialog enables you to determine whether various data is updated during the design
process. You may toggle on as many options as desired. When toggled on, the automatic updating is

activated. If the option is not toggled on, no automatic updating occurs.

4-16 © 2011 Bentley Systems, Incorporated
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File

Options

Units

Project Components
Rainfall Parameters
Land Use Options
Frequency Options
Intensity Option
Junction Losses
Inlet Options

Mode Options

Link: Cptions

Profile Options
Plan Symbology
lUpdates

Save Options

Automatic Link Updates on Node Relocations

Automatic Update Area data on Networls Design
Automatic Update Node data on Network Design
Automatic Update Link data on Networs Design
Automatic Lpdate Profiles on Metworls Design
Automatic Update Metwork on Profile Edit

SAVE OPTIONS

File

Options

Units

Project Components
Rainfall Parameters
Land Use Options
Frequency Options
Intensity Option
Junction Losses

Inlet Options
Mode Options
Link Options
Profile Options
Plan Symbology
|Updates

Save Options

Automatically Save Drainage Updates
[] Automatic Backup

[7] Automatic Save: |1 Minute -

Automatically Save
Drainage Updates

When activated, the Drainage project file (.gdf) is saved every time an Apply
command is issued from any Drainage dialog.

Automatic Backup

When activated, a backup file is always created (in the project directory with a
* bak extension) when the project is opened.

Automatic Save

To automatically save, activate the toggle to the left of the option, then select the
desired time interval.

PRINTING THE PROJECT PREFERENCES
Users may print all of the preferences by going to Project > Export > Preferences to ASCII.

VDOT GEOPAK Drainage
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LAB EXERCISE: PROJECT PREFERENCES

4-18

The Project Preferences control the graphic and computational options of the drainage system. The
Project Preferences may be changed at any time and the system can then be redesigned or analyzed

utilizing the new preferences.

>

Setup the Project Preferences

Execute c:\data\geo\vdot\drain1\LABO4_V8 SELECTseries.exe.
Open the MicroStation file, c:\data\geo\vdot\drain1\h17682.dgn.

1.

2.
3.
4

7.

Access GEOPAK Drainage ( MS Menu: Applications> GEOPAK > Drainage > Drainage).

Select the drainage

project, h17682.gdf

(c:\data\geo\vdot\drain1\h17682.gdf) (Drainage> Project > Open).
Select the Preferencestool (Drainage > Project > Preferences).

Establish the preferences by selecting each option in the columns and defining the various

values.
Highlight Units.

File

Options

Units

Project Components
Rainfall Parameters
Land Use Options
Frequency Options

@ English

Drainage Area = Acres
Length = Feet
Dimension = Feat

Intensity Option
Junction Losses
Inlet Options
MNode Options
Link Optiong
Profile Options
Plan Symbology
Updates

Save Options

Depth = Fest

Discharge = Cubic Feet per Second
Velocity = Feet per Second
Intensity = Inches per Hour

Drainage Area = Hectares

Length = Meters

Dimension = Meters

Depth = Meters

Discharge = Cubic Meters per Second
Velocity = Meters per Second
Intensity = Milimeters per Hour

Click Project Components. Populate the dialog as shown below.

(]

File

Options

Units

Project Components
Rainfall Paramaters
Land Use Options
Frequency Options
Intensity Option
Junction Losses
Inlet Options

MNode Options

Link Optiong

Profile Options
Plan Symbology
Updates

Save Options

Drainage Library File (DLB):
GPK Job Number: | 101
Drainage Cell Library:

Criteria Diractory:

DDB: | Cproj'supvii'geopakroad ddb'Wl
Water and Sewer Project:
Superelevation Shapes File:

[] Site Project:
Criginal Ground

TIM File | | surveytin

Design Surface

TIM File | | proposedtin

© 2011 Bentley Systems, Incorporated
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GPK Job Number Job101.gpk.
Original ground survey.tin
Design Surface Proposed.tin

Note Click the Road Preferences button to setup the proper location of the gpk file.

13. Click Rainfall Parameters.
We will use the Rational Method for the Storm Sewer design.

File

Cptions

Units

Project Components
Rainfall Parameters
Land Use Options
Frequency Options
Intensity Option
Junction Losses
Inlet Options

MNode Options

Link Options
Profile Options
Plan Symbology
Updates

Save Options

Rational Method
Rainfall Source: [Campbell

SCS Method
Rairfall Source: [Type 1]
() Antecedent Moisture Condition |
@ Antecedent Moisture Condition |1
() Artecedent Maoisture Condition 111
Hydrograph Time Interval: | 5.000

Rational Method

Campbell

SCS Method

Type Il

VDOT GEOPAK Drainage
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14. Highlight Land Use Options.

15. Set the Rational M ethod Single Land Useto VDOT .

File

Options

Units

Project Components
Rainfall Parameters
Land Use Options
Frequency Options
Intensity Option
Junction Losses
Inlet Options

Mode Options

Link Options

Profile Options
Plan Symbology
Updates

Sawve Options

Rational Method
@ Single Land Use tem:  [VDOT
() Muttiple Land Use tem:

Land Use tem Level |Color | Weight Style

VDOT + | Symbology: =
SCS Method
@ Single Land Use kem:  [WDOT |
() Muttiple Land Use tem:
Land Usze tem Level |Color | Weight Style

=) Smiioo:. [

16. Highlight Frequency Options. Set the Rational Frequency and the SCS Frequency options as

shown below.

File

Optiong

Units

Project Components
Rainfall Parameters
Land Use Options
Frequency Options
Intensity Option
Junction Losses
Inlet Options

Mode Options

Link Options

Profile Options
Plan Symbology
Updates

Save Options

4-20 © 2011 Bentley Systems, Incorporated

Drainage Library (DLE): ...\supv8i*geopakroad‘standards'\VDOT dlb
Rational Frequency Options

Computation
Frequency:

10 Year | | 1.0000

Runoff Coefficient
Peaking Factor:

SCS Frequency Options

Cumulative Funoff Coefficient
Frequency: Peaking Factor:

8.00 Depth =] | 1.0000

VDOT GEOPAK Drainage
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17. Highlight Intensity Options.

File

Cptions

Units

Project Components
Rairfall Parameters
Land Use Options
Frequency Options
Intensity Option
Junction Losses
Inlet Options

Mode Options

Link Options
Profile Options
Plan Symbology
Updates

Sawve Options

===

Drainage Library (DLB): ...\supv8i*geopakroad‘standardsVDOT dib

Minimum Time of Concentration: | 5.0000

Accumulate Pipe Flow Time by:
Intensity Options
@ Compute Intensity from Library Rainfall Data Source
(0) Absolute Intensity:
[] Weight Time of Concentration

Inlet Computation Cnby

Absolute Irtensity: | 4.0000

Minimum Time of Concentration

5 minutes

Accumulate Pipe Flow Time by

Uniform Velocity

Intensity Options Use Compute Intensity from Library Rainfall Data
Source
Inlet Computation Only Toggle ON, 4.0

Note

VDOT GEOPAK Drainage

The user should recognize that there are situations where roadway classification and design
speed will dictate that an “actual” calculated rainfall intensity be used in lieu of the Absolute
Intensity setting of 4 in/hr. Refer to Table 9-1 in Chapter 9 of the VDOT Drainage Manual, for
further guidance. In these situations, the switch for Inlet Computation Only should be Toggled
OFF; and the software will compute the rainfall intensity for the inlet computations.
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4-22

18. Highlight Junction L osses.
19. Toggle ON Disable All Junction Losses Computations.
[{ Preferences - Junctio . T

File

Cptions

Units

Project Components
Rainfall Parameters
Land Use Options
Frequency Options
Intensity Option
Junction Losses
Inlet Options

Mode Options

Link Options

Profile Options

Plan Symbology
Updates

Sawve Options

File

Options

Units

Project Components
Rainfall Parameters
Land Use Options
Frequency Options
Intensity Option
Junction Losses
Inlet Options

Mode Options

Link Options

Profile Options
Plan Symbology
Updates

Sawve Options

Disable Al Junction Loss Computat
Loss Velocity:

Description

Pressure Expansion:

Free Suface Expansion:
Pressure Contraction:
Free Surface Contraction:
Bend Loss:

Terminal Inlet/Junction:

Simple Junction

Complex Junction

ions

Loss Coefficient - K
0.3000
0.1000
0.5000
0.3000
1.0000
:
:

20. Highlight Inlet Options.
[ breterences - et oo I = ]

Inlzt By Pass Options: | By Pass as Total Discharge =

Link By Pass Flow Options: [Do Not Allow Inlet By Pass in Link Dischanges v |

Default Spread n Value: | 0.0150

[7] Bdend Superslevation Shapes to Inlet at Shape Slope

Inlet By Pass Options By Pass as Total Discharge

Link By Pass Flow Options

Do Not Allow Inlet By Pass in Link Discharge

Default Spread n Value

0.015

© 2011 Bentley Systems, Incorporated
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21. Highlight Node Options.

Cptions
Units Default Node ID Prefic: | 3-

Project Components [Ee
Rairfall Parameters [] Scale Mode Cells ~ Scale Factor:

Land Use Options Minimum Freeboard: | 1.0000
Frequency Options
Intensity Option
Junction Losses
Inlet Options

Mode Options

Link Options
Profile Options
Plan Symbology
Updates

Sawve Options

Default Node ID 3.

Prefix

Scale Node Cells Toggle OFF
Minimum Freeboard 1.00

22. Highlight Link Options.

Cptions Default Link |D Prefic: | pipe-
Units Link Profile Options
Project Components Deesign Optimization: | Minimize Depth of Cover

Rainfall Parameters . N
Land Use Options Elevation Option: |at Actual Link End

Frequency Options Link Design Options
Intensity Option

@ Design for Maximum Capaci
Junction Losses ' . pacty

Inlet Options (=) Design for Full Capacity
Mode Options () Design Partial Capacity {d/D) Ratio: | 1.0000

Hilsions (7) Design Partial Capacity {g/Q) Ratio: | 1.0000
Profile Options ] ) i
Plan Symbology Link Slope Decimal:

Updates Link Criteria File

Save Options File Mame:

Hydraulic Gradeline Options

Hydraulic Gradeline Basis: ual Hydraulic Gradeline +

Default Link ID Prefix pipe-

Design Optimization Minimize Depth of Cover
Elevation Option at Actual Link End

Link Design Options Design for Maximum Capacity
Link Slope Decimal No Rounding

Hydraulic Gradeline Options Equal Hydraulic Gradeline

VDOT GEOPAK Drainage © 2011 Bentley Systems, Incorporated 4-23
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23. Highlight Profile Options.
[

File

Cptions
Units Default Profile 1D Prefic: | Pro-
Project Componerts [T Create Cogo Chains and Profiles
Rainfall Parameters
Land Use Options
Frequency Options
Intensity Option
Junction Losses
Inlet Options

Mode Options

Link Options

Profile Options
Plan Symbology
Updates

Sawve Options

Cancel

Default Profile ID Prefix Pro-

Create COGO chains and Toggle OFF
profile

24. Highlight Plan Symbology.

25. Establish the symbology of the different project elements according to your standard
conventions. The Preferences may be changed at any time during the course of the project.

pESSe EEE

File

Cptions Plan View Parameters
Urits Componert Linear

Project Components .

Rainfall Parameters s =
Land Use Options Pipes: =
Frequency Options ) .
Intensity Option ENche=s =
Junction Losses Culverts: =
Inlet Options Nodes

Mode Options

Link Options

Profile Options Inlets:
Plan Symbology o
Updates Junctions:

— |
—
Sawve Options Outlets: =
R
_1

Cther:

Headwall:

EEEEE

Note These are “design process” symbology, therefore it does not need to match VDOT CADD
standards. When the design is completed, GEOPAK Drainage will update automatically all the
CADD elements to be complied with VDOT standards using the Design and Computation
Manager.

27. Highlight Updates.

28. Toggle ON all the options, so all the individual project elements will be updated every time
we recalculate our project.
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VDOT GEOPAK Drainage

(24 Preferences - Upda =S |

EI|E

Cptions
Units Automatic Link Updates on Node Relocations
Project Components
Rainfall Parameters Automatic Update Area data on Metwork Design
Land Use Options
Frequency Options
Intene?'rty Option Automatic Update Link data on Network Design
Junction Losses
Inlet Options Automatic Update Profiles on Metwork Design
Mode Options
Link Options Automatic Update MNetwork on Profile Edit
Profile Options
Plan Symbology
Updates

Sawve Options

Automatic Update Node data on Metwork Design

29. Highlight Save Options.
30. Toggle ON Automatically Save Drainage Updates.

Automatically Save Drainage Updates
Project Components
Rainfall Parameters [] Automatic Backup
Land Use Options
Frequency Options
Intensity Option

Junction Losses

[ Automatic Save: |1 Minute  +

Inlet Options
Mode Options
Link Options
Profile Options
Plan Symbology
Updates

Save Options

31. Click OK to accept the Project Preferences.
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5 VDOT Drainage Library

OBJECTIVES

In this chapter, we will learn more about the drainage library.

INTRODUCTION

The Drainage Library is used to store data and standards which may be shared by different projects and
designers. Each GEOPAK Drainage project simply accesses items within the library for use on the
specific project. The library contains five major categories:

o Rainfall Data
e Land Use Runoff Coefficients
o Nodes (Inlets, Junctions, etc.)
e Links (Pipes)
e Spread Sections
Note The Library is unit specific, i.e., Metric or English.

The VDOT CADD Support Section has created a drainage library (vdot.dlb) that will apply to most
projects.

The provided drainage library could be modified in order to address the designer’s specific needs.
Caution should be used since these changes may affect existing and new projects.

The Drainage Library is invoked by selecting Project > Drainage Library from the Drainage pull down
menu or the Drainage Library tool located on the Main Drainage tools tool frame.

File Edit

Rainfall | Land Use || MNodes || Links || Spread Section |

Element ID Description
York Rairfall tem
Wythe Rational
Wise Rational
Winchester City Rational
Williamsburg City Rairfall tem
Westmorland Rational
Washington Rational
Warmen Rational
Virginia Beach City Rational
Type ll SCS Unit Hydrograph
Tazewsl Rational
Sussex Rational

Five tabs are supported for the major categories within the Drainage Library:

e Rainfall
e Land Use

VDOT GEOPAK Drainage © 2011 Bentley Systems, Incorporated 5-1



RAI NFALL | TEMS

¢ Nodes
e Links
e Spread Section

RAINFALL ITEMS

Within the Drainage Library (beneath the Rainfall tab) are the Rainfall Items, which store all the
rainfall data sources to be used on subsequent GEOPAK Drainage Projects. GEOPAK Drainage
supports rainfall sources in the form of intensity duration frequency (IDF) tables, two SCS methods, or
as coefficients for three different preset intensity duration equation formats. Each curve is associated
with a certain zone of the state. Refer to the VDOT Drainage Manual for more information.

File Edit

Rairfall | Land Use || Nodes || Links || Spread Section |

Element ID Diescription
York Rainfall tem
Withe Rational
Wise Rational
Winchester City Rational
Williamsburg City Rainfall tem
Westmorland Rational
Washington Rational
Wamen Rational
Virginia Beach City Rational
Type |l SCS Unit Hydrograph
Tazewel Rational
Sussex Rational

When an Item is modified or added, the dialog displays the Rainfall Data Source information.

i+ | Whthe Description: | Rational Data Type: [Eguation

Equation Selection i=a/b+Tc)c
User Defined:
Frequency a b C
2.0000 50.7500 13.0000 0.5800
D) i=flab.cdin(Tc)) 5.0000 441800 112500 0.5000
10.0000 425700  10.7500 0.7500
25.0000 35.8000 852500 0.6700
50.0000 31.0300 65000 0.6100

0.00 0.0000 || 0.0000 | 0.0000

@ i=flab.ec.Tc)
() i =flab.c Frequency,Tc)

The dialog depicted above is divided into the following sections:

o User Defined Frequencies (years): User defined frequencies group box contain the return
period frequencies in years for the intensity value columns directly below.

e Duration (min): Listed vertically in column one of the list box is the duration of the
corresponding intensity values in the specific row.

e Intensities(inch/hr o mm/hr) : Comprises columns two through six in the table. They can be
manually entered or calculated utilizing the three populating options. These intensity values
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correspond to the duration specified in the far left column and are in inches or mm depending
on the units of the library.

User should not edit the rainfall source for typical rational method calculations on VDOT projects. If
needed for special occasions, three other Rainfall Data types are supported; Table, SCS Unit
Hydrograph, and SCS Cumulative Hydrograph. Selecting each of these dynamically changes the
dialog to reflect the selection.

LAB EXERCISE: UNDERSTANDING THE DRAINAGE LIBRARY
> Review the Drainage Library: Rainfall Data

1. Open the Microstation file c:\data\geo\vdot\drain1\h17682.dgn
2. Select the Drainage Librarian tool. (GEOPAK Drainage Menu: Project>Drainage Library).

At this point you may be looking at a default drainage library. We will now open our standard
drainage library and review the various items stored in our library.

Select File > Open.

Open the Drainage Library c:\data\geo\VDOT\drain1\standar ds\Geopak\vdot.dlb.
Click the Rainfall Tab.

Double click Campbell.

e | Description: | Rational Data Type: [Equation

Equation Selection i=a/b+Tc)c
User Defined:

Frequency a b C
2.0000 46.4600 122500 0.5500
() i=flab.cdin(Tc)) 5.0000 44,0300 10,7500 0.7900
10,0000  41.6300 | 10.0000 0.7400
25.0000 323500 7.2500 0.6400
50.0000 324800 72500 0.6200

0.00 0.0000 || 0.0000 || 0.0000

o g~ w

@ i=flab.ec.Tc)
() i =flab.c Frequency,Tc)

7. Review the data source item.
8. Click Cancel. Do not close the Library.
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LAND USE ITEMS

Land Use Items take advantage of the drainage area delineation tools in GEOPAK Drainage and are
used to store runoff coefficients and corresponding graphic symbology for various land uses contained
in Drainage projects. Under the Land Uses tab, the Department has included a basic land use item.
This item is shown below and has its Item ID Land Use. The designer may use this item or create
others. Land use items can have as few as one land use description.

The designer must draw MicroStation shapes matching the symbology below so GEOPAK Drainage
can recognize and compute the different types of land use areas inside the drainage basins. These
MicroStation shapes could be drawn in the active design file or in a referenced dgn file.

ftem ID: | VDOT

Description: | Land Use tem

Land Use Description
Res. 10K > 5%
Unimprov 0to 2%
Unimprov 2 to 5%
Unimprov = 5%
Impervious

Cuttivated Oto 2%
Cultivated 2to 5%
Cuttivated = 5%

Rurnoff C Symbology

0.50 Lv:Level 16, Co:38, Lc:0, Wi:2

0.20 Lv:Level 18, Co:40, Le:0, Wit:2

0.28 Lv:Level 18, Co:41, Le:D, Wh:2

0.35 Lv:Level 18, Co:42, Lc:0, Wi:2

0.50 Lv:Lewvel 20, Co:9, Le:0, Wit:2

0.50 Lv:Level 22, Co .46, Lc:0, Wi:2

0.60 Lv:Level 22, Co:47, Le:0, V-2

0.70 Lv:Level 22, Co 48, Lc:0, Wi:2 2

Impervious

Item 1D: Land Use Item Identification to recall the item from within a GEOPAK
Drainage project. (Maximum of 32 alphanumeric characters).
Description: Description of the Land Use Item. (Maximum of 32 alphanumeric

characters).

Land Use Description:

Description of each Land Use. (Maximum 32 alphanumeric
characters).

Runoff C:

Runoff coefficient for the Rational Method (C Value).

Symbology

Specified element parameters which uniquely identify the various land
use descriptions.

Edit Buttons:

Add - key in the required values in the edit fields directly below the list
box, then click Add.

OK / Cancel

Action buttons which also close the dialog
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VDOT GEOPAK Drainage

Review the Drainage Library: Land Use (Runoff Coefficients)

1. Continuing in the Drainage Library, click the Land Use tab.

File Edit

Rairall | Land Use | Nodes ” Links " Spread Section |

Element 1D

| Description

VDOT

Land Use tem

2. Double click the first land use item.

3. Review the different runoff coefficients for the land uses and associated MicroStation

symbology.

ftem ID: | VDOT

Description: | Land Use tem

Land Use Description Symbology

Res. 10K > 5%
Unimprov Oto 2%
Unimprov 2 to 5%
Unimprov = 5%
Impervious
Cuttivated Oto 2%
Cultivated 2to 5%
Cuttivated = 5%

Lv:Level 16, Co:38, Lc:0, Wi:2
Lv:Level 18, Co:40, Lc:0, Wi:2
Lv:Level 18, Co:41, Le:0, ViAt:2
Lv:Level 18, Co:42, Lc:0, Wi:2
Lv:Lewvel 20, Co:9, Le:0, Wit:2

Lv:Level 22, Co .46, Lc:0, Wi:2
Lv:Level 22, Co:47, Le:0, V-2
Lv:Level 22, Co 48, Lc:0, Wi:2

Impervious

4, Click Cancdl.

© 2011 Bentley Systems, Incorporated
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NODE ITEMS

Node Library Items define the type of Node structures used on subsequent GEOPAK Drainage
projects. The Nodes contain the Department's standard inlet configurations for Ditch Bottom Inlets
(grated), Curb Inlets as well as Junctions (i.e., manholes), Outlets, and Other generic Nodes (i.e., grade
breaks) as may be required for various Drainage projects. The description, plan view representation,
and dimension information for each Node item are included in the library and referenced by each
project.

Under each Node Types are various stored Node configurations. A typical listing may appear as
follows:

File Edit

| Rairall ” Land Use I MNodes | Links " Spread Section |
Node Types:

Blement 1D Description

DI-4FF 8 15TD. DI4FF REQD. L=8
DI-4FF 20 15TD. DI-4FF REQ'D. L=20"
DI-4FF 18 15TD. DI-4FF REQ'D. L=18"
DI-4FF 16 15TD. DI-4FF REQD. L=16"
DI-4FF 14 15TD. DI-4FF REQ'D. L=14"
DI-4FF 12 15TD. DI-4FF REQD. L=12
DI-4FF 10 15TD. DI4FF REQD. L=107
DI-4F 8 15TD. DI-4F REQD. L=8
DI-4F 20 15TD. DI-4F REQD. L=20"
DI-4F 18 15TD. DI-4F REQD. L=18"
DI-4F 16 15TD. DI-4F REQD. L=16"

GEOPAK Drainage supports the following node types:

e Curb: This is used to depict a curb inlet. This type of inlet could be placed on a On-grade or
Sag condition.

e Grate: This is used to describe a grate inlet. This type of inlet could be placed on a On-grade
or Sag condition.

e Slotted Drain: This node type is used to enter slotted drain inlets.

e Junction: This node type is used to enter data for any type of drainage structure required or
representing a confluence of pipes that is not considered an inlet or outlet. Typical uses are
manholes, junction boxes or Wye connections.

e Outlet: It is used to enter data for outlets to a storm drain system. This is typically a pipe
headwall or other structure to be placed at the outlet of a system.

e Bottom: It is used for the bottom portion of an inlet or node structure. VDOT does not use this
type of node.

e Other: It is used to enter data for any generic Node that is considered to be an inlet, junction,
or outlet. Typical uses could include pipe grade breaks, or just system connections where no
computations or structures apply to the Node. Type Other is commonly used as the node type
between ditch links.

e Headwall: It used to enter data for any node that is to be used as a headwall in conjunction
with the culvert tool. It has no hydraulic properties since it is used only for graphical
purposes.

All Node items have certain data that describe them. The typical Node item dialog and common data
requirements are shown below. For further explanation of the dialog contents, please refer to the
standard GEOPAK Drainage On-line Help.
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T )

Description: | 1 5TD. DI-4FF REQ'D. L=
Payltem: | 007420

Criteria File: Plan View Cell:

Q
Plan View Cell: | D4FF8
Node Type: |Curb hd
Profile Type: |Sag -

Length: | 8.000
Depression Width: | 2.000 No Depression
Depression Depth: | 0.167

Data for Sag
Curb Opening Hat: | 0.458

The bottom part of the dialog contains parameters used in the hydraulic computations of the inlet.
These parameters are needed for typical FHWA HEC-12 or HEC-22 calculations.

A key element in the node definition is to properly configure the MicroStation cell representing the
node. For that reason, GEOPAK Drainage supports the definition of certain key points within a cell
that can be used to increase the flexibility of placing Nodes, connecting Links, and reporting on Node
information.

VDOT GEOPAK Drainage

Pipe Connection Points — these points can be placed within a cell to indicate the points
around the structure to which the pipes shall connect. GEOPAK Drainage will subsequently
track the actual pipe length from this connection point to that of the other nodes. If omitted
from the cell, the pipes will connect to the cell origin. For circular nodes, a construction class
circle may be placed inside the cell to allow the pipes to connect at any location around the
circumference. These points are defined by using a MicroStation Construction Class Point,
Line Style 6. For circular nodes, a construction class circle with Line Style 6 may be placed in
the cell indicating the pipe location around the circumference.

Hydraulic Center Point — a single point may be placed in the cell representing the hydraulic
center of the structure. All hydraulic calculations will be based on hydraulic length from one
hydraulic center to the next. If omitted, the cell origin will be used as the basis for hydraulic
length. These points are defined by using a MicroStation Construction Class Point, Line Style
7.

Node Elevation Point — a single point may be placed in the cell representing the location for
elevation definition on the Node. This point location will be used for subsequent extraction of
the Node elevations from the DTM. If omitted, the origin of the cell will be used as the
location of elevation sources. These points are defined by using a MicroStation Construction
Class Point, Line Style 5.

Node L ocation Point — a single point may be defined in the cell representing the preferred
point to locate the Node. A typical example would be if the cell origin is in the middle of the
structure and the structure is usually offset from the curb. If placed at the cell origin, the Node
would always need to be placed at the offset from the curb. If the location point is placed
within the cell at the offset from the curb, the Node can subsequently be placed directly on the
curb. These points are defined by using a MicroStation Construction Class Point, Line Style
4,

Node Alignment Point — used for top and bottom of cell. VDOT does not configure these
points.
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LINK ITEMS

5-8

The Link Items are used to store all the pipe configurations that may be used on a GEOPAK Drainage
project.

File Edit

| Rainfall | Land Use | Nodes | Links | Spread Section |

Shape: [Circular ] Materiali [Concrete =)

Element 1D

Description

12 Inch Dia. Concrete Pipe
15 Inch Dia. Concrete Fipe
18 Inch Dia. Concrete Pipe
21 Inch Dia. Concrete Fipe
24 Inch Dia. Concrete Pipe
27 Inch Dia. Concrete Pipe
30 Inch Dia. Concrete Pipe
33 Inch Dia. Concrete Fipe
36 Inch Dia. Concrete Fipe
42 Inch Dia. Concrete Pipe
48 Inch Dia. Concrete Fipe

12" Diameter Circular Concre...
15" Diameter Circular Concre. ..
18" Diameter Circular Concre...
21" Diameter Circular Concre...
24" Diameter Circular Concre...
27" Diameter Circular Concre...
30" Diameter Circular Concre...
33" Diameter Circular Concre...
36" Diameter Circular Concre...
42" Diameter Circular Concre...
48" Diameter Circular Concre...

The Links Tab is the source of shapes, materials, dimensions, and hydraulic properties of these
features. When designing these components, the items serve as the means to specify design candidates.
If pipe items are deleted, these items will no longer be available for use on a project using the specific
library.

The Links are categorized by three types of properties for each pipe:

Shape
Material
Type or corrugations

© 2011 Bentley Systems, Incorporated
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The VDOT's library contains shapes for box, circular, and elliptical only. Manning's n of 0.012 is
applied to all of these and concrete is the only applicable material.

Each pipe contains the specific pipe sizes and default roughness coefficients for each shape, and
material combination. There are English and Metric libraries provided with GEOPAK Drainage, which

contain virtually every standard pipe configuration.

VDOT GEOPAK Drainage

L Drainage Library -

Pipe Properies

i | ch Dia. Concrete Pipe
r Concrete Pipe Reqg'd.
001182

Roughness:
Thickness:

Trench Details
1.000
0.150
3.000
0.750

© 2011 Bentley Systems, Incorporated
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LINKAGE TO AUTOMATED QUANTITIES

One important feature of the drainage library, apart from their hydraulic utilization, is the ability to
connect to the quantities database. This offers the designer the ability of computing final plan view
quantities at the end of the design process.

The drainage library connects to the Design and Computation Manager database (VDOTenglish.ddb)
thru the Payltem definition in the Node and Link item dialog box. The Payltem definition field in the
drainage library should correspond to the ItemID element in the Design and Computation Manager.
The method and units of computation (each, linear feet, etc) will be defined by the design database or
VDOTenglish.ddb.

WD 14FF g i Edit Settings Favorites Help

15TD. DI4FF REG'D. L+ E‘ﬁ id [

Payltem: | 007420

Criteria File: Plan View Czll: 20 DI-4A TO DI-4ACC
[ DI-4D TO DI-4FF
007304 DI-4D

007310 DI4E, L= &

Length: | 8.000
Depression Width: | 2.000

Q
Plan View Cell: | DAFF8
Node Type: 007306 DI-4DD
Profile: Type: [Sag - (07308 DIE, L= 6

[] No Depression

007312 DI4E, L= 100
007314 DI4E, =12
007316 DI-4E, L=14

007318 DIHE, L= 16"
007320 DIHE, L= 18"
007322 DIE, L= 20
Data for Sag _ 007324 DIEE, L= &
Curb Opening Hat: | 0.458 007326 DIM4EE, L= 8
007328 DIMEE, L= 10°
007330 DIMEE, L= 12
007332 DIHEE, L= 14'
007334 DIMEE, L= 16"
007336 DIEE, L= 18
007338 DIEE, L= 20°
007406 DI4F, L=8'
007408 DIF, L= 10°
007410 DI4F, L= 12
007412 DI4F, L= 14'
007414 DI4F, L= 16'
007416 DI4F, L= 18
007418 DIH4F, L= 20¢
007420 DI-4FF, L= 8
& 007422 DI-4FF, L= 10

Depression Depth: | 0.167 [ Slope: | 0.000
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SPREAD SECTION
The Spread Section tab is utilized to store roadway pavement spread information.

File Edit
Rainfall ” Land Use " MNodes ” Links | Spread Section

Element 1D | Description
2LANES & GUTTER CONC GUTTER & ASPHALT P...

When double clicking on an entry in the list box, the Spread Section dialog opens.

i | 2LANES & GUTTER|
Description: | SPHALT PAVEMENT

Width % Slope  Roughness
2.000 8.330 0.013
24.000 2.000 0.015

Input is available for the Spread Width, Slope, and Manning’s N value. The Department's library
contains several common spread sections. Note that some or all may not include the gutter. Users can

create additional spread sections as needed.
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SPREAD SECTI ON

> Review the Drainage Library: Spread Section

1. Select the Spread Section tab, highlight the 2Lanes+ Guttersection, and select M odify:

File Edit

Rainfall ” Land Use " MNodes ” Links | Spread Section

Element 1D | Description |
2LANES & GUTTER CONC GUTTER & ASPHALT P...

Description: | SPHALT PAVEMENT

Width % Slope Roughness
2.000 8.330 0.013
24,000 2.000 0.015

2. Review the spread cross section characteristics for each spread item.
3. Exit MicroStation.
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6 Advanced Storm Sewer Design

OBJECTIVES

The objective of this chapter is to review drainage design procedures on how to design a storm sewer
system.

DRAINAGE AREAS: INTRODUCTION

Drainage Areas in GEOPAK Drainage may be used to simply compute peak discharges or to attach
computed discharge values to Nodes within a GEOP AK Drainage Project. The physical drainage area
boundaries may be delineated using a digital terrain model, simply drawn with MicroStation, or keyed
in as a total area value.

The Drainage Library is an integral part of defining and computing discharges for Drainage Areas.
With graphical definition of the area boundary, runoff coefficients may be automatically computed
with the use of Land Use Items from a Drainage Library.

Intensity values for the peak discharge computations are computed using the FDOT Intensity-
Duration-Frequency curves that are part of the Department’s Drainage Library.

Graphical definition of Drainage Areas through the DTM Drainage Tools or MicroStation is
accomplished through the creation of MicroStation closed shapes and subsequent selection of the
shape during the Drainage Area creation process.

In order to assign Drainage Areas and the resulting peak discharges to Nodes of a storm drain network,
the Drainage Area ID must match that of the Node. The best option to match the Node and the Area is
thru Component>Node, then selecting the Edit Area button.

Alternately, the Area tools are invoked by selecting Tool Boxes > Area, then identifying the desired
tool from the tool box as depicted below.

[x]

@@a@@@@‘
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Drainage Area: Definition

Tools from left to right are:

e Add Drainage Area

e Modify Drainage Area
e Delete Drainage Area
e Rename Drainage Area
e Update All Areas

e Drainage Area Report

DRAINAGE AREA: DEFINITION

6-2

The Drainage Area Definition dialog is used for adding or editing Areas. The general properties of the
drainage area are displayed in a list box on the left side of the dialog under the Options group, while
the right side displays parameters for the highlighted Option. As different Options are selected in the
list box, the right side of the dialog will change dynamically to reflect the parameters for the
highlighted Option. When all the options have been reviewed and appropriate information supplied,
pressing the Apply button will update the Drainage database

'Ll Drainage Area Defir

AealD: 4 9 [] Window Center

[] Highlight
Details
Options Description: | Sample Area To Node ID: 31 é’@

Definition i i
- Drainage Area: | 2.000 Ares Selection / Creation

Computation Base C Value: | 0.750 | Select ‘ Create

Shape DTM Shape

Time of Conc.: | 5.000
Hydro. Method Compute TC Pick Boundary DP
@) Rational Elements Create Shape
=) 5C5

This dialog is divided into six different group boxes.

Description This may be used to better describe the drainage area.

Hydrologic Method Rational and SCS are supported. The VDOT Drainage Manual requires that
the Rational method be used for storm drain design.

Drainage Area Total drainage area can be entered here or the designer can select a valid
MicroStation shape and the software will automatically compute the area of
the shape. The area units are either Acres or Hectares, depending on the
project units.

Base C Value If no sub areas are delineated, the Base C value applies to the whole drainage
area. If sub areas are delineated within the drainage area, this Base C value
will be applied to all “remaining” sub areas that do not have their own C
Value. If the Land Use Library items address all the possible land uses on the
project, there would be no “remaining” sub areas for the Base C-value to
apply to. See discussion of Sub areas below.

Time of The overland Time of Concentration for the Drainage Area expressed in
Concentration minutes. The minimum time of concentration entered under
Preferences> Intensity Options will override smaller values if entered here.

© 2011 Bentley Systems, Incorporated VDOT GEOPAK Drainage



ComputeTC

Opens the Time of Concentration dialog box. This is a time of concentration
calculator that separates the flow into Sheet, Shallow and Concentrated flow.
Different formulas and methods are applied for each type of flow. The flow
path could be keyed in by the designer or could be extracted from DTM data.

Area Sdlection /
Creation:

Three methods of defining the area are supported: Select Shape, Pick
Boundary Element or Create a DTM Shape.

Select Shape: Select a previously drawn MicroStation shape, click Select
Shape, then identify and accept the existing shape. These MicroStation
shapes could be drawn in the active design file or be in a visualized reference
dgn at the time of selecting the shape.

Pick Boundary Elements: Click Pick Boundary Elements, then select all
required MicroStation elements which comprise the boundary of the area.
Note the vertices need not be trimmed but the elements must bound an
enclosed region. Once the elements are selected for the bounding area, click
DP Create Shape, and indicate a Data Point within the enclosed area. Upon
successful creation of the shape, a Data Point will accept the shape and reset
will undo the shape. If a solution cannot be found and numerous trials
through the bounding elements are occurring, hitting any key will cancel the
process.

Create DTM Shape Create a Drainage Area shape via the Delineate
Watershed-Drainage Area Tool. Drainage> Utilities>Drainage Area Tools.

VDOT GEOPAK Drainage
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Drainage Area: Sub areas

DRAINAGE AREA: SUB AREAS

In order to delineate and add sub areas for a particular Area, select the Sub areas item within the
Drainage Area dialog. Sub areas are defined as smaller components within a drainage area that exhibit

different land uses or runoff coefficients (C values).

BRY - m—

Details

Options
Definitian
Subareas
Computation

[7] Window Center
[] Highlight

To Node ID: 31 at

Hydra. Method
@ Rational
© 5C5

Subarea
0.1594
D0.0433

C Value
0.900
0.500

Description
Impervious
Grass

A Delineation

Display Only
X

The Sub areas and C-Values may be entered in the table manually or Sub areas may be delineated from
the land use boundaries automatically.

The Automatic Delineation button is used to define the sub areas within the current Drainage Area. In
order for the software to delineate the land use areas automatically, MicroStation shapes need to be
drawn into the active or reference dgn file following the symbology specified in the Department’s
Drainage Library under the tab Land Uses. The designer can also assign this MicroStation symbology
by using the land use definition tool located in Drainage>Components>Land Uses. Upon calculation
of the sub areas, GEOP AK will write the sub area values in the dgn file unless the Display Only check

box is activated.

6-4
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Drainage Area: Computation

DRAINAGE AREA: COMPUTATION

The Computation option will calculate the discharge for the selected drainage area, using the computed
weighted average or composite C value and the rainfall intensity associated to the entered or calculated
time of concentration. The computed discharge shown does not reflect the absolute intensity, if the
designer selected an absolute intensity for inlet computations in Preferences> Intensity Options.

A Drainage Area Com
Area ID: 4 p D lrdmCen s @ %) &

[] Highlight

Details

S;‘t.lﬂ;s Area C Value —
inition =
Subareas Total Subareas: 0.306 Discharge

Computation

Remainder:

Hydro. Method Composite:

@ Rational Computed Intensity:

) 5Cs Computed Discharge:

NODES: INTRODUCTION

Nodes in GEOPAK Drainage are used to define structure points within a drainage Network. Nodes
create all the Inlets, Junctions, and Outlets in the Network and provide for the connectivity of the Link
system. Nodes are also used to indicate physical changes in Link sizes or slopes. Links cannot change
size or slope, other than at Nodes. Although GEOPAK will support more, the Department provides
library items for six Node types as described below.

Node Description

Curb Used for Curb opening inlets with or without pipe confluences.

Grate Used for Grate opening inlets with or without pipe confluences.

Slotted Drain Used for S!otted I_Dra_in Inlets. The Department has no Library items for
slotted drain at this time (2007).

; Used for any confluence of pipes, structure location (that is not an Inlet),

Junction A o .
pipe size or slope change, or flow addition that does not require an Inlet.
The Library items include junction boxes and manholes.

Other The Department intends these to be hydraulic openings that accept flow
into the system. These node types can also be used for any miscellaneous
points in a system such as a confluence of pipes, structure location (that is
not an Inlet), pipe size or slope change, or flow addition that does not
require an Inlet. They are also used between links that are ditches.

Outlet Used for the Outlet, or outfall, of a storm drain Network.

Used for the bottom portion of an inlet or node structure. VDOT does not

Bottom -
use this type of nodes.

Headwall For culvert tool only.
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Node: Properties

The Drainage Library is

an integral part of defining Node properties. The Node types, names,

descriptions, physical dimensions, hydraulic properties, and plan view representation are all defined
within the Drainage Library and merely referenced and selected out of the library.

Several options are supp

orted to define, edit and delete Nodes. One option is invoked by the Drainage

pull downs Components>Node and another option is by selecting Drainage > Tool Boxes> Node

,then identifying the desi

red tool from the tool box as depicted below.

Drinage Noces NN [
| gl ey e T b %%'

Tools from left to right are:

e Add Drainage Node

e Modify Drainage Node
e Delete Drainage Node
e Rename Drainage Node

e Update All Nodes
e Update Nodes With

Pay Items

e Drainage Node Report — Sump
e Drainage Node Report — On Grade

NODE: PROPERTIES

6-6

To define a node as a part of the drainage network, the Node Configuration dialog needs to be setup
with the appropriate node data. The general Options are displayed in a list box on the left side of the
dialog, while the right side displays parameters for the highlighted Option. As different Options are
selected in the list box, the right side of the dialog will change dynamically to reflect the parameters
for highlighted Option. When all the options have been reviewed and appropriate information
supplied, pressing the Apply button will update the Drainage database.

b [ o Conter

Node ID 4

Details

[ Highlight

Options
Froperties
Location

Blevations
Junction Lo

Description:
Node Type: |Curb -

o le:
Spread Crteria Profile: |On Grade

Library ltem? [DI-3B 8 -]
a8 By Pass to Node: it

Discharge Cptions Max By Pass: | 0.000
Computations

MNode Bottom: |None Available
[] Ovemide Library Payitem:

Node ID

GEOPAK will automatically number the nodes based on the order in
which the nodes are entered. The nodes can be renumbered later in the
design process. This is discussed in the Chapter about Design
Revisions.

Description (optional)

This may be used to better describe the node.

Node Type

This will show the different node types defined in the drainage library.

© 2011 Bentley Systems, Incorporated VDOT GEOPAK Drainage




Profile

The designer needs to specify the profile condition of the particular
node to be placed. On Grade or in Sag condition. This affects the input
and calculations for spread.

Library Item

Depending of the Node Type selected above, the list box will only
show the available nodes that match the type condition.

By Passto Node

The designer can specify or 1D the node that will take the by passed
discharge from the active node.

Max By Pass

Defines the maximum allowable by pass flow from the inlet. No
specific computations are adjusted by this value; it is used to merely
query the system for by pass flows which exceed this value. Used for
On Grade Inlets only. This value could be left at zero (default) if no By
Pass to Node is specified.

Node Bottom

VDOT does not use this type of node.

OverrideLibrary Item

Each node in the drainage library is associated to a pay item or Item 1D
in the Design and Computation Manager database. This option will
override this linkage, allowing the user to select their own Item ID. The
Department uses that option to make the placed node an “existing”
node for quantity computations.

NODE: LOCATION

The designer will place the drainage node into the dgn file using different locating options. If a
geometric database (gpk) is used in the Project Components, the Chain and Profile options will be
activated, therefore the nodes could be referenced to a station and offset from the selected alignment or
chain, and the node elevation could also be computed from the profile selected. If no gpk file is
available, the node will be placed using the coordinate information from the MicroStation file.

Details

Nods 1D 4 p lWindowCenter o0 ose v

[ Highlight

Options
Properties
Location

Spread Criteria
Blevations
Junction Loss
Discharge Cptions
Computations

Chain: |MAINLINE -
Coordinates / Stationing

Aign: #

Station: | 205+00.00 : X
Offset: | -26.000 -

Profile: [MAINLINE h

+ Angle: | 0.000
2718233725
339357.329
Offset from Gutterto Inlet: | 0.000

Chain A previously defined horizontal alignment stored in the “gpk" file.
Activate the toggle to the left of the field and select the chain from the
list

Profile A previously defined vertical profile stored in the "gpk*" file. Activate

VDOT GEOPAK Drainage
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the toggle to the left of the field and select the desired profile from the
list.

Align: At Paint

When this option is utilized, the node is placed at the active angle in
the MicroStation file at the current or dynamic Node coordinates.

Align: Tangent to Chain

When this option is utilized, the node is dynamically moved along the
Chain, and is rotated maintaining tangency to the chain. The designer
can enter the station location or place the node dynamically.

Align: Tangent on Element

When this option is utilized, the I D button to the right of the option is
activated and the designer is prompted to identify and accept a
MicroStation element. The Node is placed tangent to and on the
identified element projected from the current or dynamic Node
coordinates. The designer can enter the station location or place the
node dynamically.

Align: Tangent to Element

When this option is utilized, the I D button to the right of the option is
activated and the designer is prompted to identify and accept a
MicroStation element. The Node is placed tangent to the identified
element at the current or dynamic Node coordinates

Angle

An optional angle rotation could be applied to the node. A 180-degree
angle is often needed to properly align the throat of curb inlets and is
sometimes used in conjunction with the Mirror Node toggle.

Station and Offset

Nodes may be located by entering the station and offset in reference to
the selected chain. If "Tangent on Element" is used, the offset is
computed.

Mirror Node

When activated, the node cell is mirrored, in order that the same cell
can be utilized to accommodate flow coming from either direction.

Offset from Gutter to Inlet

Inlet hydraulic equations assume the Inlet is at the edge of the
computed spread (i.e. the Curb). If the Inlet is offset from the Curb, the
discharge in the spread section will bypass the Inlet. This value,
expressed in terms of feet or meters, is used to compute this bypass and
adjust the actual flow to the Inlet. This may be used, for example, when
a Grate Inlet is actually set some distance away from the curb of the
road.

Therefore any flow calculated in that segment will not be added to the
inlet and it will bypass to the next assigned one.

This value should remain zero for standard VDOT inlet applications.

6-8
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Node: Spread Criteria

NODE: SPREAD CRITERIA

Inlets utilize this option to compute the node elevation and spread calculations and for other nodes, it is
used for elevations only. The dialog changes slightly depending on whether the Inlet is On Grade or in
a Sag. The following are the common components of the Spread Criteria for sections in Sag or On
Grade.

R ot s o

Node ID 4 P e T gy Oy )

[] Highlight

Details
Ont Longitudinal Slope Source: |Reference PGL =] 2666
ptions Spread Cross Section

Properties Spread Source: | User Supplied hd

Location
Spread Criteria Width % Slope Roughness

Elevations 12.000 2.000 n.012 & Madmum
Junction Loss Pond Depth: | 0.600
Dizcharge Cptions ¥

Computations 12000 | (2000 | [0.012 Pond Width: | 8.000

The Spread Cross Section Table in the box above is used to define the spread cross section including
the gutter section and/or pavement section which may encompass the spread of flow approaching the
Inlet. The top entry is at the outermost point of flow. In most situations, this entry is the section
abutting the curb. GEOPAK drainage refers to this part of the cross section as Slope 1, Width 1, and
Roughness 1. Adjacent parts of the cross section are identified as Slope 2, Slope 3 etc. as shown
below. The cross section defined here may also be used to compute the inlet elevation from the PGL,
so the sections should continue to the location of the PGL, if inlet elevations will be computed this

way.
= ——+—w |
W, W3 ‘

A spread section needs to be defined for every node, including junctions or outlets for the software to

design or analyze the system, since the spread section could also be used to compute the structure
elevation.

Note The slopes entered are positive in value if “going up” from the inlet's point of view towards the
centerline. Negative slopes are supported but not for the bottom (or last) one in the list since it
does not convey flow to the node.

The Spread Cross Section Table could leverage information from the drainage library, the gpk file or
the MicroStation Superelevation Shape file as described below.

User Supplied The designer will enter the width and slopes across the spread section
starting from the Inlet and continuing towards the edge of the section
farthest away from the inlet.

Reference TIN A spread cross section will be extracted at the inlet location from the
TIN file defined in the Project Components item under the Drainage
Project Preferences. The designer needs to be careful on what DTM is
using since for most VDOT projects the only TIN file generated is the

VDOT GEOPAK Drainage © 2011 Bentley Systems, Incorporated 6-9



Node: Spread Criteria

existing ground DTM.

Library Item

A spread cross section will be assigned to the inlet using a Spread
Section item defined in the Drainage Library. Once a Library Item has
been selected, the spread source can be changed to User Supplied and
the spread section defined by the Library Item modified to
accommodate non-typical situations such as pavement width
transitions.

Shape

A spread cross section will be extracted at the inlet location from the
Superelevation Shapes dgn file defined in the Project Components item
under the Drainage Project Preferences and shown in the Spread
Criteria table.

For curb inlets in superelevation or superlevation transition, the
designer can use this option or enter the spread source (cross section)
as User Supplied.

If the superelevation shapes are not defined to the edge of pavement,
the designer can take advantage of the toggle:”Extend Superelevation
Shapes to Inlet at Shape Slope”, located in Drainage > Project >
Preferences under the Inlet Options item. This will extend the last
slope of the shape to the node location point defined in the structure.

Therefore, if the shape file is used to define the spread, be aware that
the cross section starts at the edge of pavement creating a theoretical
section that is shifted from the actual spread section by the width of the
gutter. This is acceptable because the calculated spread width is the
same regardless of the shift. The gutter depression cannot be modeled
with this approach. To account for the gutter depression while using
the shape option, the "Shape and Library Item" would need to be used

Shapeand Library Item

A spread cross section will be assigned to the inlet combining the
section extracted from the Superelevation Shapes dgn file and Library
item from the Drainage Library. If the gutter section is made a library
item, this option can be used to account for the gutter capacity.

To properly use this option, the superelevation shapes need to be
defined to the edge of pavement line, and the "Extend Superelevation
Shapes to Inlet at Shape Slope” toggle must be off.

Note Some options could be gray out if no active elements are present. E.g. roadway
superelevation shapes files or TIN file not specified in the Project>Preferences.

To accurately depict the spread section for inlets along a special gutter grade, the designer can provide
the cross section as User Supplied, or use the Superelevation Shapes, if needed to account for a special

gutter grade.

The designer can specify threshold values for the spread at each node. When either of the following
values is exceeded, GEOPAK Drainage will issue a Warning Message while designing the Network.
After a networks is initially designed, it can be Queried for inlets that violate these values.

Maximum Ponded Depth

The maximum depth allowed for ponding in the cross section
(expressed in terms of feet or meters). This does not affect any
computations, but will produce a warning if the computed depth is
greater.

For sag inlets, this value is used to compute the capacity of the node.

6-10
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Maximum Ponded Width

The maximum width allowed for ponding in the cross section
(expressed in terms of feet or meters). This does not affect any
computations, but will produce a warning if the computed depth is
greater.

The Longitudinal Slope for Inlets On Grade can be identified several ways as shown below.

Reference PGL Slope will be extracted from the profile defined in the Location item of
the Node dialog box at the inlet location. The slope will update as the
.gpk file is updated.

User Supplied Slope will be entered by the designer in percentage format while
omitting the % sign.

Shape Slope will be extracted from the superelevation shapes dgn file defined

in the Project Components item in the Drainage Project Preferences.
For inlets in superelevation, superelevation transition, or other
transitions, the designer can use this option or enter the longitudinal
slope as User Supplied.

For an inlet in sag conditions, the approaching longitudinal slopes have no effect on the calculation of
the inlet capacity or spread at the inlet. The spread approaching a sag inlet needs to be calculated and
the approaching longitudinal slopes affect those calculations. The fields unique to Spread Criteria for
Sags relate to the spread along the approaching longitudinal slopes and are discussed below. The
designer must specify a value for Maximum Ponded depth for sag inlets. Although this value is not
needed to compute spread, it is used by GEOPAK to compute the capacity of sag inlets.

R conton R s e |

Nods 1D 4 p lWindowCenter o0 ose v

[ Highlight

Details

Options
Properties
Location

Spread Criteria
Blevations
Junction Loss
Discharge Cptions
Computations

% Slope Left: | 1.000 Right: | 1.000

% Discharge Left: | 50.000 Right: | 50.000
Spread Cross Section:

Spread Source: [Library fem ~] [2LANES & GUTT ~ |
Width % Slope  Roughness Mezdmum

2.000 8330 0.013 Pond Depth: | 0.600
24.000 2.000 0.015

Pond Width: | 8.000

12.000 2.000 0.012

% Slope L eft and Right

For defining the longitudinal slope to use in spread (ponded width)
computations for the flow approaching from the right and left side of
the inlets. The terminology (right and left) is somewhat arbitrary as
long as the designer recalls which side is intended as left and right.

% Discharge L &ft and Right

Defines the percentage of the total discharge to the inlet to allocate to
the left and right approach spread computations. The terminology right
and left are somewhat arbitrary as long as the designer recalls which
side is intended as left and right and is consistent with the definition of
% Slope Left and Right
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Node: Elevations

NODE: ELEVATIONS

The Node Configuration-Elevation dialog will assign the elevation of the drainage nodes from
different sources, dictate the vertical matching point of the pipes entering and exiting the structure, and
the minimum and maximum depth of the node.

[ o corteaton St S === = |

Node ID 4 P e T gy Oy )

Details

[] Highlight

Options
Properties
Location

Reference Suface: |TIN File ¥ | | proposed tin Q.
Blevation Source: [Reference Model x| 2020457

Spread Criteria Mode Blevation Option: [Same as Source =| 2020457

Elevations

Junction Loss
Dizcharge Cptions

Vertical Alignment: [Allow Drop Manhole
Minimum Depth: | 3.000

Computations Mazdmum Depth: | 8.000

[ Add Sump Depth: | 0.000

Refer ence Surface

Define the desired TIN File or a Model or Object within the site project
specified in the Drainage Preferences — Project Components.

Elevation Source

Defines the source of the Node elevation. With the source specified as
something other than User Supplied, the Node elevation will
automatically update as the Node is moved. The options are:

o Reference Surface: Computes the actual elevation from the X
and Y coordinates of the structure from the Location dialog
and the Reference TIN File or Site Model. This option may be
useful for placing Ditch Bottom Inlets at the existing ground
elevation depicted in a TIN file.

o Reference PGL: Utilizes the Station from the Location dialog
to ascertain the profile elevation on the Reference PGL. Note:
This option will report the elevation directly at the station on
the PGL.

e PGL+Spread Section: Utilizes the PGL and information from
the Spread Criteria cross section to compute the elevation. The
elevation is ascertained along the PGL at the specified Station
and then adjusted along the spread cross section width and
slope segments to the end of the cross section. Although it
says PGL "plus" spread section, the programs subtracts
positive values from the PGL.

Node Elevation Options:

The designer may adjust the inlet elevations up or down from the
Elevation Source item. These options are:

e Same as Source: matches the node elevation with elevation
source.

e Constant Offset: enables a plus or minus value to the elevation
source selected. For example, if the reference profile is PGL+
Spread Section to the flow line of the gutter, a Constant Offset
can be specified to have the node elevation be the edge of

6-12
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Node: Elevations

pavement (EOP) elevation. This is useful because the EOP is
used for curb inlet elevations. A plus offset will add to the
elevation value.

e  User Supplied: The user may specify an elevation.

For the outlet node elevation, the elevation is not a physical point
on the structure. The elevation should be at least 1 foot above the
tailwater to avoid a warning. In general, using the berm or ground
elevation that covers the outlet structure is acceptable for the outlet
node elevation.

Vertical Alignment

Alignment preferences for incoming and outgoing pipes from the
Node. As pipes are designed the elevations will be set according to the
selected preference. Options available are: Match Soffit, Match Invert,
Match Surface, Allow Drop Manhole and Min. Fix Drop.

e  Match Soffit: aligns all the pipes in the system by matching
the top of each pipe or crown elevation.

e  Match Invert: aligns all the pipes in the systems by matching
the bottom of each pipe or invert elevation.

e Match Surface: aligns the pipes following the elevation of the
water surface inside the pipes.

e Allow Drop Manhole: allows for “drops” inside the node for
the pipes arriving or existing the node. Not matching inverts
or soffits will be performed. This option allows for greater
flexibility. Since the design preference is to minimize
excavation, the first pass during the design will align all the
pipes at the soffit. As the designer needs to move the inverts
of certain pipes due to various factors, e.g. utility conflicts, the
change will only affect the selected pipe and others will
remain at the previously set elevation.

e Min. Fix Drop: sets a minimum drop in elevation between the
pipes arriving and exiting the node. VDOT uses this option.
(Min=0.1")

Minimum Depth

Minimum depth expressed in master units (i.e., feet or meters) for the
pipe to be buried (minimum cover) measured from the Node Elevation
to the soffit (top inside) of the highest pipe. This value is used to
establish the minimum cover elevation noted in the Link Configuration
Conditions dialog box. See the discussion below.

Maximum Depth

Maximum depth expressed in master units (i.e., feet or meters), for the
pipe to be buried measured from the Node Elevation to the invert of the
lowest pipe. This value is used to establish the Maximum Depth
elevation noted in the Link Configuration Conditions dialog box. See
the discussion below.

Add Sump Depth

.Extra depth to be allowed in the manhole structure after the maximum
depth of the structure has been computed. This has no effect in the
hydraulic calculations, but some designers add this extra depth for
pollution control measures. VDOT does not use this option

VDOT GEOPAK Drainage
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Minimum and Maximum Depth at Nodes Definition

The designer can use multiple combinations of the previous parameters in order to automate the computation of
the node elevations. Some of the project conditions that affect inlet elevations and spread are superelevation,
turn lanes, and through lane transitions.

GEOPAK has different ways to handle different project conditions. The options within GEOPAK that may
affect calculations of inlet elevations and spread are listed below. It is a the designer discretion to use them

depending on the structure and project conditions given.

Item

Options

1.- Shape Files: These are created by the
roadway designer.

Created to edge of travel way

Created to less than edge of travel
way.

2.- Extend Shapes to Inlet: This option is in
Preferences>Inlet Options. This affects the
entire project because it is in Preferences.

Yes (activate toggle) if shapes are
not created to the edge of travel
way.

No

3.- Longitudinal Slope Source: This option is
in Node Configuration> Spread Criteria.

User Supplied

Reference PGL

Shape

4.- Spread Source: This option is in Node
Configuration> Spread Criteria. This refers to
the cross section of the spread area.

User Supplied

Library Item

Shape

Shape + Library Item (this option is
not applicable if the shapes are
extended to the Inlet

4.- Elevation Source: This option is in Node
Configuration> Elevations

Reference PGL

PGL+Spread
5.- Node Elevation Option: This option is in Source
Node Configuration> Elevations

Constant Offset

User Supplied

MINIMUM AND MAXIMUM DEPTH AT NODES DEFINITION

The values entered for Minimum and Maximum Depth define the vertical limits that the program uses to place
the pipe. The Minimum Depth establishes the upper limit that pipes are designed in. The Maximum Depth
establishes the lower limit.

The minimum depth of a pipe is often established by cover requirements specified in the VDOT Drainage
Manual.
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Node: Junction Loss

Consider the following for the Maximum Depth: The approximate elevation of the outlet node should be known
while designing the storm drain. The outlet elevation may be controlled by the minimum pipe slope or by the
depth of the pond at the outlet. The designer will be able to lock the elevation of the outlet pipe in the Link
Configurations-Conditions dialog. Locking the elevation of the outlet will control the total drop through the
system. This will limit the allowable pipe envelope that the pipes are designed within. Reasonable results should
be obtained by setting the Maximum Depth for all nodes to be deeper than the outlet pipe (maybe use a tentative
20" depth). Again, GEOPAK will not fully use this depth to design the pipes if the outlet elevation is locked.

Regardless of what depths are used, the designer will still need to check for adequate depth, pipe slope, and
hydraulic gradient clearance later in the design process.

Mode Elevation |

[

— Min. Depth in Nodes Configuration

hin. Cover Elevation
---------------- = in Link Configuration

—— Max. Depthin Nodes Configuration el

Max. Depth Elewvation in
Link Configuration
-------------------- h 4

NODE: JUNCTION LOSS

4 Node Configuration - = =
Node 1D 4 b e e

Details

Options @ Defined Equations
Properties (") Eguations x Loss Reduction:

Location _ i
Spread Criteria () Absolute Loss:

Bevations () Supplied K -Outlet Velocity: 0.000
Junction Loss 7 Supplied K - Change in Velocity: | 0.000
Discharge Options

- () Mone
Computations N

Within this dialog the designer has the option to enter specific values for the junction losses in the
particular structure being analyzed. These settings will override the coefficients selected under the
Drainage Project Preferences, but the toggle Disable All Junction Loss Computation must be off.

NODE: DISCHARGE OPTIONS

The Node Configuration-Discharge option is used to select type and possible amount of flow entering
the drainage structure directly from its drainage area or from “offsite” locations.
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Node: Computations

=

Node 1D 4 p [l WindowCenter oo oogs vy

Details

[] Highlight

Options
Properties
Location

Spread Criteria
Elevations
Junction Loss
Discharge Cptions
Computations

@ Use Computed Discharge

n NN

() Supplied Discharge: | 0.000
[7] Disable Inlet Calculations  Capacity:
[[] [Link Base Fow Area | |31

The options are:

Use Computed Discharge

Indicates using the computed discharge from a stored Drainage Area as
the discharge to the Node.

Supplied Discharge

This option allows for a user supplied discharge, with disregard to any
calculated value from a drainage area.

DisableInlet Calculations
Capacity

When toggled on, the designer may provide the desired inlet capacity
overriding any GEOPAK Drainage calculated value.

Link Base Flow Area/ Link Base
Flow Discharge

When toggled on, an additional drainage area may be defined. The area
can be identified graphically by clicking ID and selecting the
MicroStation shape previously defined as a GEOPAK Drainage Area.

For the Link Base Flow Discharge. the designer can also enter a value
for the extra discharge in the proper units defined in the Project
Preferences (cubic feet per second or cubic meters per second).

This “extra” area or discharge is included in the pipe, but is not
included in the inlet spread calculations.

NoDE: COMPUTATIONS

Once all the information regarding a specific Node has been defined, clicking the Compute Option
computes and displays all pertinent information in the list box. If sufficient information has not been
provided, warning or error messages are displayed in the list field.

Node 1D 4 b e N S s ' 4

[ Highlight

Details

Options
Properties
Location

Spread Criteria
Blevations
Junction Loss
Discharge Cptions
Computations

Discharge = 6.0463

Total Ponded Width = 122535
Ponded Width Left = 9.1691
Ponded Width Right = 9.1691
Ponded Depth Left = 0.3100
Ponded Depth Right = 0.3100
Inlet Length = 8.0000
Depression Depth = 0.1670
Depression Width = 2.0000

Inlet Capacity = 12.3557
Computed Head = 0.3717
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Node: Computations

Note

VDOT GEOPAK Drainage

The designer should be aware that the computations shown are the spread calculations.
Therefore, the value of discharge may be different from the discharge calculated in the
drainage area, since VDOT uses an absolute intensity of 4 inches/hour intensity for inlet
computations. This discharge value also includes any bypass discharge added to the current
node.
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Lab Exercise: Drainage Design

LAB EXERCISE: DRAINAGE DESIGN

> Opening the Drainage Project
1. Execute c:\data\geo\vdot\drain1\LAB06_V8_ SELECTseriew.EXE
2. Open the MicroStation file, ¢:\data\geo\VDOT\drain1\h17682.dgn.
3. Access GEOPAK Drainage ( MSMenu: Applications > GEOPAK >Drainage > Drainage).
4. Open the drainage project, c:\data\geo\wdot\drain1\h17682.gdf (Drainage Menu: Project >
Open).
>

Define Properties and Locate Inlet 3-1
1. Visually determine (zoom to) the location of the Proposed Inlet Location: Station 205+86;
offset —26.

‘__'__.-.:-—

7~

e
——
e
-
—

Description:

. [ oK | Cancel |

Node D 4 p (0] Vi Corie

[] Highlight W & o @]
Details

Options
Froperties Node Type: [Curb
Location .

Spread Criteria . Profile : On Grade

Elevations iLibrany tem3 [DF-3B 10 -]

Junction Loss By Pass to Node: i)
Dizcharge Cptions

- Max By Pass: | 0.000
Computations

MNode Bottom: |Naone Available
[] Ovemide Library Payitem:

Description:

-

L4

3. Highlight Propertiesin the Options section.

4. Select the Node to be used from the Drainage Library and assign its properties.
Node Type Curb
Profile On Grade
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Lab Exercise: Drainage Design

Library Item

DI-3B 10

5.

Node 1D 4 p [l WindowCenter oo oogs vy

[] Highlight

Details

Options
Properties
Location

Spread Criteria
Elevations
Junction Loss
Dizcharge Cptions
Computations

6. Define the inlet’s location in the design plane.

[¥] Chain: [MAINLINE | [¥] Profile: |MAINLINE hd

Coordinates / Stationing

Align: #  +Angle: |0.000

Station:

205+86.00 ; ¥ 2718287634
Offzet: -26.000

Y. 339290323
Offset from Gutter to Inlet: | 0.000

Chain

MAINLINE

Profile

MAINLINE

Align

Select Tangent on Element. Activate
the Select MS Alignment Element

button '# and select and accept the
edge of pavement line. Activate the

Station DP button % and the node
will dynamically move along the
selected element. Using the left
mouse button, place the node close to
where it is desired. The station can be
revised by entering a different station
value.

Station

205+86

Offset

-26.00 feet

7. Click Apply.

This automatically places the inlet at the specified location.

> Define Additional Inlet Information
1. Highlight Spread Criteria.
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Lab Exercise: Drainage Design

6-20

Nose D 4 b L Widow Cote

Details

Properties
Location

[] Highlight

W @ % w4 [ feey |

Spread Criteria Width
Elevations 2,000
Junction Loss 24000
Dizcharge Cptions

% Slope  Roughness
8.330 0.015
2.000 0.015

]

X

Computations 2000

8.330 0.015

O Longitudinal Slope Source: | Reference PGL »| 0.076
ptions Spread Cross Section

Spread Source: | User Supplied -

Mazpdmum

Pond Depth: | 0.500

Pond Width: | 8.000

2. Define the roadway cross sectional characteristics directly in front of the inlet.

Max Ponded Width

Longitudinal Slope Source | Reference PGL
Spread Source User supplied
Max Ponded Depth 0.50

8.00

These values will be utilized to calculate inlet capacity and resulting by-pass flow.
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Lab Exercise: Drainage Design

Node 0 4 b (] Vindow Coner

[] Highlight

Details

Options Reference Surface: |TIN File w || Proposed tin

Froperties Blevation Source: |Reference TIN

Location
Spread Criteria Node Hlevation Option: [Constant Offset
?evmionio Vertical Alignment: [ Min. Fixed Drop
unction Loss - =

Discharge Options Minimum Depth: | 2.670
Computations Maxdimum Depth: | 8.000

[ Add Sump Depth: | 0.000

4. Assign the inlet's vertical elevation and vertical pipe alignment.

Reference Surface Proposed.tin
Elevation Source Reference TIN
Node Elevation Option Constant Offset, -0.500
Vertical Alignment Preference Min. Fixed Drop = 0.1
Minimum Depth 2.67 feet
Maximum Depth 8.0 feet

Note You need to click the Apply button after you select the Proposed.tin file.

5. Highlight Junction L osses.

Node 1D 4 p [l WindowCenter oo oogs vy

[] Highlight

Details
Options @ Defined Equations

Properties () Equations x Loss Reduction: 0.000

Location .
() Absolute Loss: 0.000

Spread Criteria - SOLLS L0ss

Hevations () Supplied K - Outlet Velocity: 0.000

Junction Loss () Supplied K - Change in Velocity: | 0.000

Dizcharge Cptions

- (71 None
Computations -

6. Use Defined Equations (defaults to Preferences> Junction Loss Settings).
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7. nghllght Discharge Options, and Toggle ON Use Computed Discharge

Nade 10 4 S Cimmes

[ Highlight

Details
Options @ Use Computed Discharge

Properies (™) Supplied Discharge: | 0.000
Location ) ) .

Spread Criteria [7] Disable Inlet Calculations  Capacity: | 0.0000
Elevations % [Link Base Flow Area v | |Mone Available - | 4
Junction Loss o

Discharge Cptions
Computations

> Complete Hydraulic Computations and Add Node to the Project

1. nghllght Computationsto verify the inlet’s hydraulic computations.

Node ID 4 . [L] indow Center

[ Highlight
Details

Options Inlet 3-1 - Emror Performing Inlet Computations
Properties Drainage Area 3-1 Mot Found

Location

Spread Criteria
Blevations
Junction Loss
Discharge Cptions
Computations

Note The Drainage Area for this node won't be added until the next step. Therefore, the

Computations for the node can't be completed until a discharge is known (Delineate Drainage
Areas section).

2. Click Apply to add/update this Node to the project.

DELINEATING DRAINAGE AREAS

The physical drainage area boundary may be delineated using a digital terrain model, simply drawn
with MicroStation, or keyed in as a total area value (in units of acres or hectares). After the drainage
area is delineated using MicroStation’s drawing tools, runoff coefficients can be automatically
computed with the use of Land Use Items from the Drainage Library.

> Design Drainage Area for 3-1

1. The basin limits were predefined and were drawn on the MicroStation Level: 63. A closed
shape will be created in the next steps in order to become the drainage area for each structure.
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2. Turn On Level 63 in the MicroStation dgn file. (MS Menu: Settings>Level>Display).

ekl

3. Still in the Node Configuration dialog, highlight Properties, and click Edit Area (to the left

of the Apply button).
F—'" ode * g FaTlo i

% ﬂﬁ"@@u

o

Node 1D 4

Details

Options
Properties
Location

Elevations

Spread Criteria

Junction Loss
Discharge Cptions
Computations

> [] Window Center
[ Highlight

Inlet 3-1 - Emor Performing Inlet Computations
Drainage Area 3-1 Mot Found

4. Select YES at the prompt of creating a new drainage area and enter the Definition

information.

Base C

0.50

Time of Concentration

5.0
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5. Click Select Shape and select the MS shape for this area. The drainage area value is
computed.

Area ID: 4 P e ) @) %)

[] Highlight
Details
Options Description: To Node ID: 3-1 %
Definttion
Subareas
Computation Base C Value: | 0.500 | g:hﬁd | DTCI'ru'IegthE ‘
Time of Conc.: | 5.000 i e

Drainage Area: | 0.210 Area Selection / Creation

@ Rational
© 5C5

Elements Create Shape

Hydro. Method Compute TC | Pick Boundany | oP

6. Highlight Subareas.

7. Toggle on Display Only. Then, the subarea values will not be written in the dgn file.
8. Click Automatic Delineation.

The file is scanned for closed shapes matching the Land Use symbology specified in the
Drainage Library (Land Use Tab).

e

Window Center
Area ID: O
=2 ¥ 5 Highiiaht

Details

Options To Node ID: 31 S
Defintion

Subarea C Value Description ]
Automat
El 01462 0900  Impervious it
Computation 0.0633 0.500 Shdr & Ditch Proposed | &

Display Onby
X

Hydro. Method
@ Rational
|:::| SCS

0.500 Shdr & Ditch Proposed

9. Click Apply.

This applies the land uses (and their “C” values) to the Drainage Area. Alternately, this table

may be populated manually using the key-in fields and add, modify and deleteicons to the
right of the table.

10. Highlight Computation.
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a0 4 b L Widon Ceter

[] Highlight

Details
Options Area
Definition
Subareas
Computation

Total Subareas:

Remainder:

Hydro. Method Composite:

i@ Rational Computed Intensity:

) SC3 Computed Discharge:

11. Click Compute Discharge.

12. Verify the computations.

13. Click Apply to add the Area to the Project.

14. Close the Drainage Area Computations dialog.

15. Return to the Node Configuration dialog, and highlight Computations.
16. Review and verify the computations.

17. Click Apply to update the node information.

Define Properties and Locate Inlet 3-2

1. Visually determine (zoom to) the location of the Proposed Inlet Location: Station 206+36;
offset —26.

2. Select the Add Drainage Node tool ( Drainage: Component > Node > Add) and click OK.

3. Highlight Propertiesin the Options section.

Node 1D 4 p [ WindowCemer oo o3ty s

[ Highlight

Details
Options Description:
i;operties Node Type: [Curb

cation L
Spread Criteria . Proflle.l Sag
Elevations iLibrary ltem} [DI-3C 6
Junction Loss
Discharge Options
Computations

MNode Bottom: |Mone Available
[7] Ovemide Library Payitem:

4. Select the Node to be used from the Drainage Library and assign its properties.

Node Type Curb
Profile Sag
Library Item DI-3C-6
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6-26

Highlight L ocation.
F—" ode O qura 1}

L

Node 1D 4 p L] Windon Certer

Details

Options
Properties
Location

Spread Criteria
Elevations
Junction Loss
Discharge Cptions
Computations

[ Highlight

[#] Chain: [MAINLINE > | [¥] Profile; |MAINLINE h

Coordinates / Stationing

HMign: +Angle: [ 0.000
Station: | 206+36.00 X 27838.976
Cffset: -26.000 ({?) Y. 335251366

Offzet from Gutter to Inlet: | 0.000

Define the inlet’s location in the design plane.

Chain

MAINLINE

Profile

MAINLINE

Align

Select Tangent on Element. Activate
the Select MS Alignment Element

button ¥ and select and accept the
edge of pavement line. Activate the

Station DP button % and the node
will dynamically move along the
selected element. Using the left
mouse button, place the node close to
where it is desired. The station can be
revised by entering a different station
value.

Station

206+36

Offset

-26.00 feet

Click Apply.

This automatically places the inlet at the specified location.
Highlight Spread Criteria.

NedelD 4 [E2 TR b RO gy g g 4

Details

Options
Properties
Location

Spread Criteria
Blevations
Junction Loss
Discharge Cptions
Computations

© 2011 Bentley Systems, Incorporated

[ Highlight

% Slope Left: | 4500 Right: | §.600

% Discharge Left: | 50.000 Right: | 50.000
Spread Cross Section:

Spread Source: | User Supplied -
Width % Slope  Roughness Madmum

2 00D 8330 0.015 1 Pond Depth: | 0.500
24000 2000 0.015

% Pond Width: | 8.000

2.000 8.330 0.015
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Longitudinal % Slope Left 4.50%
Longitudinal % Slope Right 8.60%
% Discharge Left 50 %
% Discharge Right 50%

10. nghllght Elevations and assign the inlet's vertical elevation and vertical pipe allgnment

Node 1D 4 b e T gy %

Details

Options
Properties
Location

Spread Criteria
Blevations
Junction Loss
Discharge Cptions
Computations

[ Highlight

Reference Surface: |TIN File w || Proposed tin Q,

Blevation Source: |Reference TIN ~| 2020281

Node Hlevation Option: [Constant Offset x| [0.500
Nertical Alignment: [Min. Fixed Drop =| | 0.100
Minimum Depth: | 2.670
Madmum Depth: | 8.000
[ Add Sump Depth: | 0.000

You need to click the Apply button after you select the Proposed.tin file.

11. Highlight Computationsto verify the inlet’s hydraulic computations.

Nods 1D 4 p [ Window Center oo oo5e e 48)

Details

Options
Properties

[ Highlight

Inlet 3-2 - Emor Performing Inlet Computations
Drainage Area 3-2 Mot Found

Location

Spread Criteria
Elevations
Junction Loss
Dizcharge Cptions
Computations

Note Elevation Source, Node Elevation Option, vertical Alignment, Minimum and Maximum Depth
should be filled out based on the previous node 3-1.

12. Click Apply to add this Node to the project.
13. Click the Edit Areaicon to associate this inlet with its Drainage Area.
14. Select Y esto the Alert dialog box, since no area for the inlet is created yet.

15. Enter the Definition information.
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Window Center
Avea ID: O
s ¥ vighight

Details

Options Description:
Definition
Subareas Drainage Area: | 0.050
Computation Base C Value: | 0.500

Time of Conc.. | 5.000

Area Selection / Creation

@ & W & [ el |

To Node ID: 32 S

Select
Shape

Create
DTM Shape

Hydro. Method Compute TC

@ Rational
|:::| SCS

‘ Pick Boundany

Elements

DP
Create Shape

Base C

0.50

Time of Concentration

5.0

16. Click Select Shapeand select the MS shape for this area. The drainage area value is

computed.

17. Highlight Subareas.

18. Toggle on Display Only. Then, the subarea values will not be written in the dgn file.

19. Click Automatic Delineation.

The file is scanned for closed shapes matching the Land Use symbology specified in the

Drainage Library (Land Use Tab).
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20.

21.

22.
23.
24.

25. Review and verify the computations.

Area ID: 4 >

Details

Options
Definition
Subareas
Computation

[] Window Certer
[ Highlight

To Node ID: 32 S

Hydro. Method
@ Rational
|:::| SCS

Click Apply.

Subarea
0.0680
0.0222

C Value
0.500
0.500

Description

Impervious
Shdr & Ditch Proposed

0.500

Shdr & Ditch Proposed

i Delineation

Display Only
x>

This applies the land uses (and their “C” values) to the Drainage Area. Alternately, this table
may be populated manually using the key-in fields and add, modify and delete to the right of

the table.

Highlight Computation and press the Compute Discharge button to obtain the drainage

area’s computations.

Click Apply to add the Area to the Project.
Close the Drainage Area Computations dialog.
Return to the Node Configuration dialog, and highlight Computations.

Node 1D 4 >

Details

Options
Froperties
Location

Spread Criteria
Elevations
Junction Loss
Discharge Options
Computations

Window C H
[l g 3%

Discharge = 0.2852

Total Ponded Width = 0.6670
Ponded Width Left = 1.0565
Ponded Width Right = 0.9362
Ponded Depth Left = 0.0880
Ponded Depth Right = 0.0780
Inlet Length = &.0000
Depression Depth = 0.1670
Depression Width = 2.0000
Inlet Capacity = 7.8065

Computed Head = 0.0556

26. Click Apply to update the node information.
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Complete the Inlet Locations

COMPLETE THE INLET LOCATIONS

1. Select from the Node Configuration dialog the Add Node icon.

2. Layout the inlets for the project using the same methodology as described above, and create
the correspondent drainage areas.

NodelD Type Profile Library Item Station Offset Elevation
3-3 Curb On Grade DI-3B 8 206+86 -26.00 Proposed TIN
3-4 Curb On Grade DI-3B 16 205+86 26.00 Proposed TIN
3-5 Curb Sag DI-3C 6 206+36 26.00 Proposed TIN
3-6 Curb On Grade DI-3B 8 206+86 26.00 Proposed TIN
3-7 Curb On Grade DI-3B 16 208+00 26.00 Proposed TIN

Outlet Outlet ES18 206+36 -42.00 El. 2020.00
Note It is recommended to input the Node Elevation for an outlet node at least one foot higher than

the tailwater elevation. This elevation is not used in the hydraulic calculations and does not
represent a physical point on the outlet node. E.g. pond’s top of berm elevation, ditch top of
bank, etc.

Note Remember to click the Apply button after you select the Proposed.tin file under the Elevation
option in the Node Configuration dialog.

3. Close the dialog box when done.

LINKS: INTRODUCTION

6-30

In GEOPAK Drainage, Links connect and convey runoff from the various Nodes within a Network to
the Outlet, and may consist of pipes, boxes, or ditches. A multitude of options for sizing, and profiling
Links are supported.

A Link represents a linear feature depicting a path connecting two Nodes. The path (upstream to
downstream) need not be indicated because GEOPAK Drainage will determine the direction of flow
purely based on connectivity. The path may be a straight line, line string, curvilinear, or a combination
and series of linear MicroStation elements.

The Drainage Library is an integral part of designing and analyzing Links. The library contains all the
standard pipe configurations based on shape, material, and, if applicable, corrugations which may be
used in a Drainage project. Link library items selected to specify pipe sizes or the shape and material
properties within the library may be used to establish the suitable candidates for design.

Several options are supported to add, edit, and delete Links. One option is invoked by the Drainage
pull down menu Component>Link. Another option is the tool box obtained by selecting Tools> Tool
Boxes > Link, then identifying the desired tool from the tool box as depicted below.

:Drainage Links

Tools from left to right are:

e Add Drainage Link
e Edit Drainage Link
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Links: Introduction

e ID Drainage Link
e Delete Drainage Link
e Rename Drainage Link

e Update All Links

e Update All Links with Pay Items
e Drainage Link Report — Configuration
o Drainage Link Report — Computation

Add Utilized to add a Link to the current GEOPAK Drainage project.

Edit Utilized to select and edit any previously defined and stored Link within
the current project. The Link Edit dialog is identical to the Link Add
dialog, however, when the Link is identified, all associated data is
displayed.

ID Utilized to ID the link in the design file.

Deete Utilized to select and delete the specified Link and associated data.

Rename Rename the link name in the GEOPAK database.

Update All Links

Updates all link graphics in the design file.

Update All Linkswith
Pay Items

Updates all link graphics with the designated pay items (specified in the
Drainage Library) from the Design and Computation Manager database.

DrainageLink Report
Configuration

Displays in table report the links configuration (size, inverts, and slopes)
after the design is performed.

DrainageLink Report
Computation

Displays in table report the links hydraulic computation (discharge,
capacity, HGL) after the design is performed.

A third option is to access the Links the Navigator (Utilities>Navigator).

View Tools

s v SRl Y

Description

Mone Available

X @D

-
i

[T] Highlight [ Window Center

VDOT GEOPAK Drainage

t=

[ Query
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Link Configuration Dialog: Introduction

LINK CONFIGURATION DIALOG: INTRODUCTION

The Link Configuration dialog box is the one used to properly place a link (pipe or ditch) into the
database.

. - Window Center

i = ’ /

nicID: 4 pipe ¥ 3 Highight vy ISE S
Details
Options

Description:

Definition From Node: [3-1 « | %@ o Node! [3:2 -]

Conditions Length: 0.0000 [[] Use MS Elemert Il
Constraints Corfiguration

Computation Shiape: Mateial:
Type Design Size  Size: MNone Select...
@ Pipe [] Design Bamels  Number of Bamels: Roughness: | 0.012
{5 Bt [] Ovemide Library Payitem:

The Link options are displayed in a list box in the left side of the dialog, while the right side displays
parameters for the highlighted Option. The options are:

o Definition

e Conditions

e Constraints
e Computation

As different Options are selected in the list box, the right side of the dialog will change dynamically to
reflect the parameters for highlighted Option. When all the options have been reviewed and
appropriate information supplied, pressing the Apply button will update the Drainage database.

LINK CONFIGURATION DIALOG: DEFINITION

This option will define the Link’s path, connectivity, shape, material, roughness coefficient, size, and

. - Window Center

Link ID: O ¥ /

nk D: 4 [pipe Y Bigage V7Y
Details
Options

Description:

Definition From Node: [3-1 « | %@ o Node! [3:2 -]

Conditions Length: 0.0000 [[] Use MS Elemert Il
Constraints Corfiguration

Computation Shiape: Mateial:
Type Design Size  Size: MNone Select...
@ Pipe [] Design Bamels  Number of Bamels: Roughness: | 0.012
{5 Bt [] Ovemide Library Payitem:

Description (optional) | Description of the Link. (Maximum of 32 alphanumeric characters.)

From Node Identification of the Node from which the Link originates. The flow
direction, upstream or downstream, need not be established. The
direction is determined by the connectivity of the Network in which the
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Link resides. If the designer identifies a downstream node as a From
Node, GEOPAK will reverse the From Node and To Node based on
actual flow direction of the Network. GEOPAK does this when the

network is built (See the Network Chapter).

It is recommended to use the ID button & to select the node since it
will connect the link to the proper pipe connection points defined in the
Department’s Drainage Library.

To Node

Identification of the Node from which the Link originates. The flow
direction, upstream or downstream, need not be established. The
direction is determined by the connectivity of the Network in which the
Link resides.

It is reccommended to use the ID button "% to select the node since it
will connect the link to the proper pipe connection points defined in the
Department’s Drainage Library

Identification of the Node from which the Link originates or ends. The
flow direction, upstream or downstream, need not be established. The
direction is determined by the connectivity of the Network in which the
Link resides.

Length

Once the From Node and To Node are identified, GEOPAK computes
the length of the Link based on distance between Nodes or the
MicroStation element selected as the Link path. GEOPAK Drainage
considers two lengths for a link: actual length and hydraulic length.

e Actual Length: this is the distance from the pipe connection

This is often called the construction length of the pipe.

e Hydraulic Length: this is the distance from the hydraulic point
of one node to the hydraulic point of the next node. This length
is used to perform the drainage calculations (travel time, HGL
slopes, etc). The Department has defined the hydraulic point of
every node at the center of the structure.

point of one node to the pipe connection point of the next node.

Use M 'S Element

To define and select the Link path with previously drawn MicroStation
elements. Activate the toggle, press the Select button, then identify the
element.

This is only used when the designer needs to model a link with a bend
without a node.

Type Group: Pipeor
Ditch

Selection of this option dynamically changes the Configuration group
box to reflect the selection.

Links in GEOPAK Drainage could be a pipe or a ditch.

The Configuration group box will change depending upon designer’s choice to use a pipe or ditch as a

link between nodes.

If a pipe is selected, then the Configuration Group box will allow the following:

VDOT GEOPAK Drainage
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. = Window Center
: = 7 /
Link ID: 4 [pipe-1 3 0 Highicht v S 7
Details
Options

Description:

Definition From Node: [3-1 ~ | % ToNodei 32 -

Conditions Length: 0.0000 [7] Use MS Blemert [y
Constraints Configuration

Computation Shape: Material:
Type Design Size Size: Mone Select...
9 Fipe [] Design Bamels  Number of Bamels: Roughness: | 0.012
© Ditch [] Ovemide Librany Payitem:

Shape Option button for pipe shapes. The Department’s Drainage Library
contains only box, circular, and elliptical shapes.

Material Option button for Pipe materials. The Department’s Drainage Library has
all the links stored as concrete material, so the designer must select
concrete. This does not control the pipe material for construction. The
pipe material constructed is controlled by the Department’s Optional Pipe
process.

Design Size Toggle on to indicate pipe size to be determined by the software based on
given design Configuration and Constraints.

If the pipe is an existing one or the designer wants to select a specific
pipe, then toggle off this option.

Pressing the Select button invokes the Select Size dialog, wherein the
desired size may be selected. Pipes listed in the dialog are based on the
sizes in the Drainage Library for the specified Shape and Material
configuration.

Design Barrés Toggle on to indicate the number of barrels (multiple pipes) GEOPAK is
to design based on given configuration and constraints. If the toggle is
not activated, GEOPAK designs for one barrel.

The designer can select from 2 to 10 barrels from node to node.

Manning'sn Manning's roughness coefficient. The default value is based on shape and
material found in the Drainage Library. All of the current Library items
have Manning's n = 0.012. This is consistent with the Drainage Manual
standards for acceptable Storm Drain and Cross Drain materials.

The designer can also override this value for each individual pipe.

OverrideLibrary Pay | Each pipe in the drainage library is associated to a pay itemor Item ID in
Item the Design and Computation Manager database. This option will override
this linkage, allowing the user to select their own Item ID.

The Department uses that option to make the placed pipe an “existing”
pipe for quantity computations.

If a ditch option is selected, then the Configuration Group box will allow the following:
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Link ID: 4 >

Details

mh
[ Highlight

v s s [

Options
Definition
Conditions
Congtraints
Computation

Description:

From Node: 3 To Node:
Length: 0.0000 [7] Use MS Blemert [y

Configuration
Ditch Type: [Fixed Geometry

0012

»| Roughness:

Type
@) Pipe
(@ Ditch

Ditch Width: | 5.0000
Ditch Depth: | 3.0000
Side Slope Ratio Left (H:1):

[] Design Width
[] Design Depth

3.0000 Right (H:1): | 3.0000

Ditch Type A ditch with fixed geometry or cross section based could be placed.
Ditch Width Ditch bottom width in master units (i.e., feet or meters).
Ditch Depth Ditch depth in master units (i.e., feet or meters).

Side Slope Ratio L eft

Left side slope of the ditch.

Side Slope Ratio Right

Right side slope of the ditch

Manning's

Manning's roughness coefficient.

Number of Cross
Sections

If the ditch type selected is cross section based:

Configuration

Ditch Type: [Cross Section Based

Mumber Of Cross Sections: | 4
Width Of Cross Sections: | 40.0000

Roughness: | 0.012

Number of cross sections to create along the path of the Link. A minimum
of four sections is suggested to balance energy.

The TIN file or Site Model to extract the cross sections is specified in the
Reference Surface option of the Node Definition dialog.

Width of Cross
Sections

Width of the cross sections created along the path of the Link. Cross
sections will be centered along the Link.

VDOT GEOPAK Drainage
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LINK CONFIGURATION DIALOG: CONDITIONS

Defines or reviews the elevation condition for the Link including minimum depth, soffit, invert, and
slope data. It also includes the profiling options for holding certain values constant.

6-36

The Minimum Cover and Maximum Depth values on this dialog represent calculated elevations based
on the values for the nodes connected to the link. The Minimum Cover elevation = Node Elevation -
the Minimum Depth of the node. The Maximum Depth Elevation = Node Elevation — Maximum

Depth of the node.

MWode Elewation |

F

— Min. Depth in Nodes Configuration

L/
\_.

Min. Cover Elevation
in Unk Configuration

——Max. Depthin Modes Configuration

Max. Depth Elevation in
Link Configuraton

The soffit, invert and slope of the pipes are the calculated elevations after the Network is designed. The
designer has the option to “lock” these elevations, therefore GEOP AK Drainage will not adjust them.
To lock one of these items, activate the toggle and type the desired value in the window. Another
option to lock the pipes elevations is thru the Edit Profile dialog box.

Link ID: 4 >

Details

Options

Definition
Conditions
Constraints
Computation

Soffit:

Inwert:

Type

@ Fipe
() Ditch

Note

Min Cover:

[] Window Center
[ Highlight

Profile Conditions

From Mode
2016673
0.000 |
0.000 [

Max Depth:  2011.343

v 2% 7 [ oy |

To Nede
2017.110
0.000
0.000
2011.780

]
]

GEOPAK Drainage cannot accommodate adverse pipe. If locked or held flow lines result in

one of these conditions, GEOPAK will adjust the flow lines to fix the problem, thus giving the
appearance that the Lock or Hold Invert option does not work. A Warning message will inform
the designer of the changes made to the pipe elevations after the design is performed.

© 2011 Bentley Systems, Incorporated
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The Constraints establish further design criteria for Links. GEOPAK Drainage utilizes the physical
constraints of minimum and maximum size and slope to determine a suitable pipe size.

ki 4 T T b e

Details
Options Design Constraints

Definition

Minimum Maxdmum

Conditions Rise: | 1.000 4,000

Constraints Slope: | 0.500 10.000

Computation Velocity: | 1.000 10.000
Type

@ Fipe
~) Ditch

GEOPAK Drainage will perform the following steps to determine the “allotted pipe envelope”

VDOT GEOPAK Drainage

Starting upstream, GEOPAK computes each link slope by connecting the nodes at the
elevation set by the node elevation minus the minimum depth.

If this slope is less than the minimum slope, GEOP AK Drainage sets the slope equal to the
minimum slope. This will provide the upper limit of the envelope. Then, it continues
downstream.

To setup the bottom part of the “envelope” , it starts from the outlet elevation, move upstream
and setup the minimum invert of the pipes by using node elevation minus the maximum depth
values on each node.

If the invert falls within the minimum and maximum slopes the link is placed at the calculated
elevation. If not, the link is once again placed at the minimum specified slope from that node
to the upstream end of the system.

If during the construction of the envelope, any elevations that the user has held will be
accommodated if physically possible and the envelope constrained to that elevation.
However, if a held elevation of a pipe violates the minimum or maximum depth line, the
elevation will not be held. With the minimum and maximum depth profiles computed,
GEOPAK Drainage can then design a suitable pipe within this envelope that satisfies all the
constraints possible.
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The other constraints, minimum and maximum velocities are for querying purposes and evaluating the
adequacy of the design.

Minimum Rise Constraint - Minimum rise (diameter, height) for pipe or ditch in master
units (i.e. feet or meters). The Department’s minimum round pipe size is
1.5'(18").

Maximum Rise Constraint - Maximum rise (diameter, height) for pipe or ditch in master

units (i.e. feet or meters). Unless the designer knows a constraint, it is
recommended that this be set for a large pipe such as a 6' (72").

Minimum Slope Constraint - Minimum physical slope for pipe or ditch expressed in
percentage. The minimum pipe slope varies with the pipe size (0.15% for
18", 0.102% for 24" etc.) See the discussion in the Storm Drain Handbook.
During the initial design, the pipe sizes are not known, so this constraint
may need to be changed as the design progresses. In moderately sloped
terrain, using 0.15% may be acceptable for all pipes, because the terrain
will force the pipes to be steeper than that. In flat terrain, using 0.15% for
all pipes may cause the downstream pipes to be too deep.

Maximum Slope Constraint - Maximum physical slope for pipe or ditch expressed in
percentage. The Department does not have a maximum slope constraint, so
it is recommended that this be set high for all pipes.

Minimum Veocity Query - Minimum velocity for pipe or ditch expressed in feet per second or
meters per second. This value must be something greater than zero for the
program to do the hydraulic calculations.

Maximum Ve ocity Query - Maximum velocity for pipe or ditch expressed in feet per second or
meters per second.
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Link Configuration Dialog: Computation

LINK CONFIGURATION DIALOG: COMPUTATION

The Computations option allows for evaluating the computed hydraulic properties of the Link. Link
hydraulics are not available for review until a Network has been established containing the Link and
the Network hydraulic computations have been successfully performed.

. : [ 1||"hf'inI:|.l::¢'\-\' Center 8
ek D: 4 fped w] b Gy, g

Details

Options
Definition
Conditions
Constraints
Computation

Type

@ Fipe
() Ditch

Upstream Sofft = 2017.810

Exceeds Maximum Alowed by Envelope = 2016673
Downstream Soffit = 2017.563

Exceeds Maximum Alowed by Envelope = 2016426
Discharge = 0.918

Capacity = 2710

Rise = 1.000

Roughness = D.013
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LAB EXERCISE: LINKS

> Link Placement

1. Select the Add Drainage Link tool (Drainage: Component > Link > Add).

2. Click OK. We are using the default Link ID.
F—,‘ O guration D EEE'

. : [ 1||"hf'inI:|.l::¢'\-\' Center 8
ek D: 4 fped w] b Gy, g

Details
Options Description:

Defintin From Node: W To Node:

Conditions Length: 0.0000 [[] Use MS Blement [

Constraints Corfiguration

Compuation Shape: Material:
Type Design Size  Size: MNone

@ Fipe [ Design Bamels  Mumber of Bamels: Roughness: | 0.013

(© Dich [ ]iOvenide Library Payitem:;

3. Highlight Definition. This sets the pipe's spatial characteristics including From and To Nodes
ID’s, pipe shape, material, library items, etc.

4. Graphically identify the From Node (3-1) by selecting the ID Button  and left clicking in
the proper pipe connection point of the structure.

5. Accept the highlighted point by left clicking one more time.

6. Graphically identify the To Node (3-2) by selecting the ID Button . and left clicking in the
proper pipe connection point of the structure

7. Accept highlighted point by left clicking one more time

8. Set the other pipes properties under the Definitions option.

Shape Circular

Material Concrete

Design Size Toggle ON

Design Barrels Toggle ON and Select 1 for the Number of Barrels,
then Toggle OFF.

Manning’s n 0.013

5. Highlight Conditions.

The elevations shown are based on the From-Node and To-Node elevation minus the
min/max depth, as specified in the Node Definition Dialog Box for Nodes 3-1 and 3-2
respectively.

In this case, no entries are necessary; Drainage will design all the profiles for this project.
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Lab Exercise: Links

Lik ID: 4 ey

[ Highlight

Details

Options
Definitian
Conditions
Congtraints
Computation

Type
@ Pipe
{© Ditch

6. Highlight Constraints.

Profile Conditions
From Mode To Node

Min Cover: 2016673 2017.110
Sofft: o0 [ o 0000 [
Invert: 0.000 | 0.000 [l
Max Depth:  2011.343 L 2011.780

ik iD: 4 fpped T b ey g

Details

Options
Definition
Conditions

Constraints
Computation

Type
@ Fipe
() Ditch

[ Highlight

Design Constraints
Minimum Mazdmum

Rize: | 1.000 4.000
Slope: | 0.500 10.000
Velocity: | 2.000 10.000

7. Establish the min/max design criteria for Links.

Rise min/max

1.0/ 4.0 (feet)

% Slope min/max

0.5/10.00 (%)

Velocity min/max

2.00/10.00 (fps)

8. Highlight Computations.
This displays the computed hydraulic properties of the Link.
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Networks: Introduction

Lik ID: 4 ey

[ Highlight

Details

Options Link is not cumently part of a network

Definition Computations Unavailable - Perform Network Computations
Conditions
Congtraints
Computation

Type

@ Pipe
) Ditch

Note Link hydraulics are not available for review until a Network has been established and
designed or analyzed (next exercise) successfully. Check here for computations after the
Network has been added and designed or analyzed.
9. Click Apply. This incorporates the link to the project.
10. Add the remainder of the link conveyance system by clicking Add Link.

Note As Links are added, most dialog values default from the previous Link with the exception of
the node and elevation information.

Link Traverses From Node To Node
PIPE-2 3-3To 3-2
PIPE-3 3-4To3-5
PIPE-4 3-7To 3-6
PIPE-5 3-6 To 3-5
PIPE-6 3-5To3-2
PIPE-7 3-2 To Outlet and set the invert elevation at the Outlet node at el. 2013.00
using the Conditions option in the Link Configuration dialog box.

11. Close the dialog box when done.

NETWORKS: INTRODUCTION

A GEOPAK Drainage Network is defined as a series an interconnected Nodes and Links draining to a
single outlet . GEOPAK Drainage can maintain multiple Networks in a single project.
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Networks: Introduction

MODE A4 — % MODE A - 4

6 -3
N p NODE 4 — & OUTLET
-7
. . o
A - Ly
NODE 4 -1 g6 =9 NODE |4 -2 NODE |A -5 wopp A - 7
85 -5
L
o
¢
NODE |4 - 9

The Network computations serve as the final calculation process in the design or analysis of a storm
drain system. Drainage Areas and Inlets may be computed individually and are not dependent on any
type of Network topology. Pipes and Ditches, however, are dependent on the connectivity and
Network characteristic and therefore, require a Network be defined and successfully built, in order to
complete the hydraulic computations on these features.

Several options are supported to add, edit, and delete Networks and are invoked via the Network pull
down on the main menu bar as depicted below. Alternately, the Network tools are invoked by selecting
Tools> Tool Boxes > Network, then identifying the desired tool from the tool box.

Drainage Netwol

i._
|¥%$¥%¥ﬁ|

Seven tools are supported in the Network tool box (from left to right).
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Network Configuration Dialog

Tools Description

Add Initially utilized to define the Network and associated data. When
invoked, the Network Configuration dialog is blank.

Edit Utilized to edit any previously defined Network. When selected, the
Select Network dialog is invoked, wherein the desired Network is
highlighted. Note the Network Edit dialog is identical to the Network Add
dialog, however all associated data is displayed.

Deete Utilized to delete the specified Network and associated data.
Rename Utilized to rename any previously defined Network.
Design This mode enables when an Active Network is defined. It's a shortcut to

the Design procedure without having to invoke the Network dialog.

Analyze This mode enables when an active network is defined. It's a shortcut to the
Analyze procedure without having to invoke the Network dialog.

Set Active Networ k GEOPAK Drainage uses an Active Network as a shortcut and
organization tool. Many of the reporting, query, and navigation tools
support the use of the Active Network to limit the information viewed to
the system currently under design (the Active Network). When selected,
the Active Network dialog is invoked, wherein a previously defined
Network may be specified as active. The current Active Network is
displayed on the main menu bar for quick reference.

NETWORK CONFIGURATION DIALOG

It is within this dialog where a network is built and computed. The dialog box is divided into two
major groups: Validation and Computations.

Network ID: 4 [Systemi __ ~] P ¥K W W

Details
Description: Outlet Mode: n
Validation Computations [ Lock Sizes ] [ Unlock Sizes ]
T}i }:: dﬂ"‘\f: P}:: [ Lock Elevations ] [Unlock EIevations]
Validation: Build Build Network: Builds the storm drain network starting from the Outlet
Network. Highlight Node. The purpose of building a Network is to check the topology and
Network. connectivity and determine whether this storm drain system is ready to
Validation be analyzed or designed. It is at this time that all the flow directions
2 through the Links are established.
U The Network is established by traversing from the Outlet Node upstream,

splitting off into multiple paths at a fork, until terminating nodes are
reached on all paths. For a gravity system, the topology must be a tree
structure.

This process validates all the interconnected components for errors
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Network Configuration Dialog

and/or unexpected conditions like: no or multiple outlets identified,
indeterminate flow path due to loops, duplicate links, or multiple
downstream links from a single node.

Highlight Network: Highlights all elements (Areas, Nodes, and Links)
contained in the current Network for visual inspection of the system.

Computations: Design: Performs the hydraulic design of all the components contained
Design. Analyze in the Network. It evaluates the current Network, and designs any
features that were indicated as such.

Computations
s P Analyze: Performs the hydraulic analysis of all components contained in

the Network. It evaluates the current network, ignoring all design toggles
and maintaining current feature sizes. This can be helpful when
evaluating a system that has already been designed to see how it
accommodates a different design storm. This is also helpful when the
designer is changing the size of certain pipes to meet the hydraulic
gradient clearance requirements. In this case the designer may want to
change only one pipe while holding the size of the others.

L ock/Unlock Sizes Lock or Unlock the sizes prior to computing. Be careful with this option
since it will lock/unlock all pipes sizes, even the ones manually defined
by the designer.

L ock/Unlock Lock or Unlock the pipe invert elevations prior to computing. Be careful
Elevations with this option since it will lock/unlock all pipe inverts, even the ones
manually defined by the designer.
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LAB EXERCISE: NETWORKS
> Network Design
1. Select the Add Drainage Network tool (Drainage: Network > Add).

MNetwark 1D: | System 1

Description:

Outiet Node [Outlet ~|

| OK | | Cancel |

2. Enter the network information.

Network ID: Systeml
Outlet Node Outlet
3. Click OK.

In the Validation section, click Build Networ k.

This feature verifies the nodal topology and link connectivity. The Highlight Network
feature hlghllghts all components (areas, inlets, pipes, etc.) connected to the Actlve Network.

Network ID: 4 > ¥ %W
Details

Description: Ourtlet Node: k=
LI R [ Lock Sizes ] [ Unlock Sizes ]
}:: j"‘\i: P}:: [ Lock Hlevations ] [Unlock EIevations]

5. Click Apply. The Network SYSTEML1 has been added to the project.
6. Inthe Computations section, click Design Networ k.

GEOPAK Drainage designs the network and issues the pertinent Warning Messages, if
necessary. These warning messages are also written in an ASCII file named: drgmsg.txt
located in the GEOPAK’s working directory.

Network ID: 4 [System1 ~ ~] b

Details
Description: Outlet Node: |Outlet
Validation Computations [

Lock Sizes ] [ Unlock Sizes ]

T}:: }f: P}f: [ Lock Elevations ] [Unlock EIevations]

Design Metwork

7. Click Set Active Network (to the left of Apply).
8. Now we can review some of the provided reports of this network.

9. Select the Drainage Area Report tool (Drainage: Reports > Drainage Area). Review some of
the available reports.

10. Close the dialog box when done.
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VDOT Drainage Input

VDOT DRAINAGE INPUT

The Drainage Input application will read and accept user input, and export the user input to GEOPAK

Drainage. The application also allows the LD-229 and LD-204 files to be imported into the
application, and then exported to GEOPAK Drainage.

&| || Q| eefeees |

™ use Ermoft Data
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The Drainage Input application requires the job number, and a GEOPAK Drainage file to be selected.
Drainage Preferences are set by pressing the Preferences button. This allows the Time of
concentration, the Beginning Pipe Name, and the link minimum and maximum rise, slope and velocity
to be set.

Drainage Input Preferences ﬁ

Time of Concentration: | 10|
Beginning Pipe Mame: |Pipe

— Link Design Constraints

Minimum  Maximum

Rise: |1.5
Slope: (0.4
veodty 2 s

o
T

Once the job number, drainage file, and preferences have been selected, enter the drainage data into the
appropriate fields for each node/link.

VDOT GEOPAK Drainage

Chain Name - Selected from the provided list.
Station — Entered by the user.
Offset — Entered by the user.

Node ID Upper/Lower (required) — Entered by the user. Upper and lower node id’s are
required for non-outlet type nodes. For outlet type nodes, only the upper node id is required.

Node Type (required) — Selected from the list Curb, Grate, Slotted Drain, Curb and Grate,
Junction, Outlet, Other, Bottom, or Headwall. The node type is required by all nodes.

Name of Structur e (required) — Selected from the list based on the Node Type provided.
The name of structure is required by all nodes.
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6-48

e Drainage Area C Values (required) — Entered by the user for each sub area. The C value is
only required by non-outlet type nodes.

o DrainageArea Areas (required) — Entered by the user for each sub area. The drainage area
is only required by non-outlet type nodes.

e Spread Cross Section Cross Slope— Entered by the user for each section.
e Spread Cross Section Width — Entered by the user for each section.
e Pipe Shape- Selected from the list Arch, Box, Circular, Ellipse, or Pipe — Arch.

o PipeMaterial — Selected from the list based on the pipe shape, Aluminum, Concrete, Plastic,
or Steel.

e Pipe Type- Selected from the list based on the pipe shape.

e PipeSize(required) — Selected from the list based on the pipe shape, pipe material, and pipe
type. The pipe size is only required by non-outlet type nodes.

¢ NodeElevation (required) — Entered by the user. The node elevation is required by all node
types.

e Invert Elevations Upper/L ower (required) — Entered by the user. The upper/lower invert
elevations are only required by non-outlet type nodes.

Once all of the pertinent data is entered, press the Add button Q to the right if the data fields to add it
to the list. Additional nodes/links can be added to the list as needed. Each lower node must have a
matching upper node for the project to be imported.

The project outlet nodes can be stored by entering just the upper node information. No pipe or
drainage area information will be used for the outlet nodes. The outlet node elevation is required.

To modify an entry in the list, select the entry in the list. This displays the entry in the entry fields.
Make the desired changes. Press the Modify button = to make the changes in the list.

The Delete button ﬁ or the Delete All button Ewill delete the selected entry or all of the entries
from the list respectively.

To import the data from the LD-229 and LD-204 spreadsheets, toggle on the Use Ensoft Data toggle.
This will activate the required fields. Select the LD229 file and the LD204 file respectively. Select the
chain name. Press the Import Ensoft Data button to import the data to the list. The list entries can then
be modified to complete any missing data.

Note NOTE: GEOPAK Drainage requires some data that is currently not available from the Ensoft
spreadsheets. This data will need to be manually entered.

Once all data has been entered, press the Write Data to GEOP AK Drainage button to import the data to
GEOPAK Drainage.

Note The drainage project file (.gdf) must be opened in GEOPAK Drainage prior to pressing the
Write Data to GEOPAK Drainage button.

The user has the opportunity to save the dialog settings into a settings file. When the Drainage Input
application is opened, it will search the current directory for the settings file. If a settings file is found,
the dialog will be populated with the information from the first settings file it finds. If another settings
file is desired, the Open Settings File icon on the dialog is used to search for another settings file. Also
available on the dialog are a Save Settings and Save Settings to Another File option.

© 2011 Bentley Systems, Incorporated VDOT GEOPAK Drainage
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LAB EXERCISE: CREATE DRAINAGE DATA WITH VDOT DRAINAGE INPUT FORM

Creating the VDOT Drainage Input Form

1. Open the Drainage Input Form Application by clicking on the Drainage Input Formicon
located on the VDOT Macro’s Tool Frame. (Last Icon on Far Right)

oo 5 o o] ] o]

2. Set the Job Number to 101 and Drainage project to h17682.gdf.

Cida

| | |y ereferences Job: - Drainage Praject File: |C:\data\Geo\vdot\drain1\h17682.gdf ﬂ Write Data To GEOPAK Drainage
I Use Ensoft Data [ ﬂ [ S Chain: Import Ensaft Data

3. Press Preferences button and set as shown.

Time of Concentration: | [T

Beginning Pipe Name: | pe-100

— Link Design Constraints
Minirmum  Maximum

Rise: |15 5.0
Slope: ,r IID—
velocity 0.4 |10

4. Close the Drainage Input Preferences dialog.
5. Toggle on Use Ensoft Data

& Gl Y meeee ¥ rr—— e Prisject Pl [ it Yiea ot yh a1 7682, ) irie Deta To GEOPAK Crainege
F sz EnsoftData  LD22% Ple: [C:'ddataoeo'ivdoticran 111 6420229 vy Q| L0204 Pie: [CatalGeo'ivdotidran 1\ MARD 4. 5 Q| Chanc | WAMDE b Import Ensoft Data

6. Select the LD229 File: C:\data\geo\vdot\drain1\17682L.D229.xls
7. Select the LD204 File: C:\data\Geo\vdot\drain1\17682L.D204.xls
8. Set the Chain to Mainline.

9. Click the Import Ensoft Data button.

| || §y eefeence A T | et Fle: |C:\datalGeot 2.0 al Wite Ciats To GECPAK e sinage
W Use Ermcft Diata LD Flle: |C: 'rlaba'{oma vddo! i ar 111 TRRILD 229, v ﬂ L0 Fle: | C:glata'Gea oot i air 1 || TERL D204 xie. N Chain: MAIMLINE j Import Ersadft Data
DRAINAGE SPREAD
LOCATION AREA CROSS
oe {ac o1 ha) SECTION
UPPLR END NODE 1D AREAL CROSS SLOPEL PIRE INVERT ELEVATIONS
AREA Z CROSS SLOPE?
CHAIN NAME AREAY | CROSS SLOPE 3 £
z E
= ] =
W 5 -~ | @ 2 g
[ - B E - E = El | &
EsE F] s E El @ g 5 E| BE
£Es NAME OF £ 5|28|5=| % 3 § 2o £3
stanion | & & £ ueeer | LOWER | mwone Tvpe STRUCTURE i = |Salzs| & SHAPE MATERLAL TYPE SIZE = 55| S =2
MATNING o > Curh -2 w 0.5 o9 o1 l e Q1% Lrcular Concrete 15 Inch D, Ora, 20195 el A5
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6-50

10. You will need to make changes to the rows in the table. The procedure is to highlight the row

11.
12.
13.
14.
15.
16.

and then make the necessary change then click the modify icon on the right side of the table.

Set the Offset Distance for Nodes 3-10 thru 3-12 to -26.0 feet.

Set the Offset Distance for Nodes 3-13 thru 3-16 to +26.0 feet.

Set the Material to Concrete and select the appropriate size.

When finished click the Save icon to save the file. Give it the name h17682.did.
Click the Write Data to GEOPAK Drainage button.

Review the data in GEOPAK Drainage.
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REPORTS: INTRODUCTION

GEOPAK Drainage provides a number of tools to create and generate both custom reports and quick,
standardized reports. The standardized reports for Drainage Areas and Inlets are updated dynamically
as any of the components contained in the report are updated, so the impact of the changes can be
reviewed on the entire system. The Storm Drains/Links report dynamically tracks the condition of the
data and provides notification whether the data is current in the report. These summaries are
dependent on the Network computations being performed successfully and whenever the Network is
designed or analyzed, these report summaries are updated automatically.

All report functions are invoked by selecting Drainage > Tool Boxes > Reports, then identifying the
desired tool from the tool box as depicted below.

Tools from left to right are:

Drainage Area Report

e Drainage Node Report — Sump

e Drainage Node Report — On Grade

e Drainage Link Report — Configuration

e Drainage Link Report — Computations

e Drainage Report Builder

e Drainage Generate Report
Of these reports, Drainage Areas, Inlets, and Storm Drains / Links are standardized reports, while the
Builder and Generate menu selections are utilized for the customized reporting capabilities. Both

standardized reports and customized reports can be viewed and subsequently, hard copy output can be
produced.

Several useful features are common in most of the standardized reports at the bottom of the dialog as
depicted in the fragment below.

Metwork:  AllNetworks ™ [ window Center
ASCII File: [ Q | e I™ Highlight _ Aol |

Network When initially activated, all components within the project are reported. The option is All
Networks. By selecting Active Network, only those components in the active network are reported.
Note in order to use this option, an Active Network must be defined prior to selecting the option. If an
Active Network is not defined, no warning message is displayed and the list box is not updated.

Edit (/) To edit an element directly from the report summary, highlight the desired element in the list
box, then press the Edit (/) button, invoking the specified dialog in an update mode. When the desired
updates have been made, press the Update button which closes the dialog, returns to the report dialog

and automatically updates the report with the edited information.

Highlight When the toggle is activated, double click on a line in the list box. The MicroStation
highlight color is applied to the specified item in the list for easy visual reference. Note the screen
maintains the relative window, i.e., it does not perform any Zoom In or Zoom Out commands. Note
the Window Center and Highlight toggles may be active simultaneously.

Window Center When the toggle is activated, double click on a line in the list box. The highlighted
item in the list is window centered on the screen. Note the screen maintains the relative window, i.e., it
does not perform any Zoom In or Zoom Out commands. Note the Window Center and Highlight
toggles may be active simultaneously.
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VDOT Storm Sewer Tabulation

ASCII File The data may be written to an ASCII file. Manually type in the optional path and name of
the file, or utilize the Files button to select from Create Area Summary ASCII File dialog. Note the
default extension is *.sum.

VDOT STORM SEWER TABULATION

6-52

The Storm Sewer Tabulation application will read a GEOP AK Drainage file, and populate the Storm
Sewer table in Excel format. When the Storm Sewer Table is completed, the LD-229 report will also
be completed.

Prior to processing the Storm Sewer Tabulation application, the user must have 2 files created. First,
the GEOPAK Drainage (.gdf) file must be created with at least one drainage network completed and
saved. If multiple networks are created in the drainage file, the desired network for the table can be
selected in the Storm Sewer Tabulation dialog.

The second file is the ASCII form of the GEOPAK Drainage Preferences file used for the GEOPAK
Drainage network. Once the preferences have been set, in GEOPAK Drainage the user goes to Project
> Export > Preferences to ASCII to create the drainage preferences (.drp) file.

In addition to the GEOPAK Drainage file (.gdf) and the GEOPAK Drainage Preferences file (.drp) the
user needs to select the appropriate drainage network, and can provide the road name, project number,
county, the name of the network to show on the tabulation, name of the person creating the drainage
network and the date it was created, and the name of the person checking the project and the date it
was checked.

i Storm Sewer Tabulatiol It X |

=/

Drainage Project File:

|C: \data\Geolwdot\drain 1Y 17682, gdf E

Drainage Preferences File:
|o'n,vdot'n,clrain1HDrainage_Preferences_1?682.dr|::| Q,

Report Metwork: |5\,rstem 1 j

Road: |

Project Number: |

County or City: |

Network Name: |

Prepared By: |

Date:

Checked By: |

Date:

Generate Storm Sewer Tab

The user has the opportunity to save the dialog settings into a settings file. When the Storm Sewer
Tabulation application is opened, it will search the current directory for the settings file. If a settings
file is found, the dialog will be populated with the information from the first settings file it finds. If the
user desires another set of settings to be used, they can use the Open Settings File on the dialog to
search for another settings file. Also available on the dialog are a Save Settings and Save Settings to
Another File option. The user will also be prompted when closing the dialog to save the settings file.

When ready to create the tabulation report, the user presses the Generate Storm Sewer Tab button.
This will copy the seed report, and populate the table with the current drainage network information.
Once the table is complete, the user is prompted that the process is complete, and allows the user to
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open the created file. The Storm Sewer Tabulation Report is found on the first worksheet. The LD-
229 report can be found on the second worksheet tab at the bottom of the Excel window.

VDOT STORM SEWER TABULATION REFORT

HOAD: Mainlise UNITS:  US Customan X NETWORK HAME: Network System 1 sheet o
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VDOT Spread Analysis Tabulation

VDOT SPREAD ANALYSIS TABULATION

6-54

The Spread Analysis Tabulation application will read a GEOPAK Drainage file, a GEOPAK Drainage
Preferences file, and a GEOPAK Drainage Report file, and populate the Spread Analysis table in Excel
format.

Prior to processing the Spread Analysis Tabulation application, the user must have 3 files created.
First, the GEOPAK Drainage (.gdf) file must be created with at least one drainage network completed
and saved. If multiple networks are created in the drainage file, the desired network for the table can
be selected in the Spread Analysis Tabulation dialog.

The second file is the ASCII form of the GEOPAK Drainage Preferences file used for the GEOPAK
Drainage network. Once the preferences have been set, in GEOPAK Drainage the user goes to Project
> Export > Preferences to ASCII to create the drainage preferences (.drp) file.

The third file is a GEOPAK Drainage Report file. Once a GEOPAK Drainage file is opened (Project >
Open), and an active network is set (Network > Active Network), the user can go to Reports >
Generate in the GEOPAK Drainage toolbar to create the GEOPAK Drainage Report file. The file
SpreadAnalysisReport.drf needs to be selected as the format file. This process will create a .csv file
that is used in the Spread Analysis Tabulation application.

In addition to the GEOPAK Drainage file (.gdf), the GEOP AK Drainage Preferences file (.drp), and
the GEOPAK Drainage Report file (.csv), the user needs to select the appropriate drainage network,
and can provide the road name, project number, name of the person creating the drainage network and
the date it was created, and the name of the person checking the project and the date it was checked.

- 3
Spread Anlysis Tabulation ﬁ

EIR= )

Drainage Project File:

Drainage Preferences File:

4|
| 4l
Q|
-

Drainage Report File:

Report Netwaork: |

Road: |

Project Mumber: |

Prepared By: |

Date:

Checked By: |

Date:

Generate Spread Tab

The user has the opportunity to save the dialog settings into a settings file. When the Spread Analysis
Tabulation application is opened, it will search the current directory for a settings file. If a settings file
is found, the dialog will be populated with the information from the first settings file it finds. If the
user desires another set of settings to be used, they can use the Open Settings File on the dialog to
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VDOT Spread Analysis Tabulation

search for another settings file. Also available on the dialog are a Save Settings and Save Settings to
Another File option. The user will also be prompted when closing the dialog to save the settings file.

When ready to create the tabulation report, the user presses the Generate Spread Tab button. This will
copy the seed report, and populate the table with the current drainage network spread information.
Once the table is complete, the user is prompted that the process is complete, and allows the user to
open the created file.
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Lab Exercise: Create VDOT Storm Sewer Tabulation Sheet

LAB EXERCISE: CREATE VDOT STORM SEWER TABULATION SHEET
Saving the Drainage Project Preferences Report

1. Create the drainage preferences report for the project. (Drainage: Project >
Export> Preferences to ASCII.

2. Sawe the file as : Drainage Preferences 17682.drp.

Creating the VDOT Storm Calculation Sheet

1. Open the Storm Sewer Tabulation Application by selecting the Storm Sewer Icon located on
the VDOT Macro’s Task tool frame. (4™ Icon from Left)

2. Set the Drainage project, Drainage preferences report file and network in the Storm Sewer
Tabulation dialog.

Drainage Project File:

|C: \data\Geo\wdot'drain 1\h 17682, gdf Q
Drainage Preferences File:

|n'|,vdot'|,|:|rain 1\Drainage_Preferences_17582.drp| 4

Report Netwark: |System 1 ﬂ

Road: |

Project Mumber: |

County or City: |

Metwark Mame: |

Prepared By: |

Date:

Checked By: |

Date:

Generate Storm Sewer Tab

3. Press Generate Storm Sewer Tab
4. Provide a name for the new storm tabulation Excel spreadsheet: Stor m.xls
5. Open Storm.xIs with Microsoft Excel. Review the Stormtab and Spread worksheet.
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Lab Exercise: Create VDOT Storm Sewer Tabulation Sheet
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P
| |
5 Road: Mainline Units: Metric (SI) Sheat: of
& |Project# 8365 ¥ US Customary Prepared by: A M
7 Checked by:
DRAINAGE 5 HYDRAULIC GRADELINE = Z| 7
LOCATION ; AREA (ac. or ha.) £ _ ELEVATION Z€ |z EZ €
o = : |z T |z Ix 235 :
s | £ £ £2
L UPPER END g BASE s2| 5 | E : : CROWN ELEVATION 7 EEg g
i =} cE| @ 5 £ = | FLOWLINEELEVATION | E z =
2 = = =z - 2 = E
2 € COMPOSITE 23 = F it =] 5 w =)
0 CHAIN NAME ; s : = g H E E pe v 2
5 R 2 =2 2| 5| 7 g z |2 2 =] 2 7| 3
8= S2 | w2 = w = 5= | o E [} H = L | W= = | v |IgEEl S
CEZE| |uePer| OF | oG | E El e S| s |2 o o B | xE | =E E| | g [8G:| <
SEs|y|LowER | B2 &2 | 2 | g |§ |=2= |BEz| g || E g |5 |gs5 85|35 |5|E EZ. B
2| sTaTION |S 5 £ |F E R = 5 |2 | 8L |88 ] E H 2 2 Z |32 |32 |fg |2 | 2 |52
s MAINLINE 31 0.500 | 0.000 0.000 20M6.70|2016.22 0.48 0956% | 3.02
DL3E 10| Curb 2477 5.87 0.30 B0 | D169 103 | 201999 [201732[201707] 025 | 1.25 491
LR 5 -
. 205+86.00 ‘ 26 |L1 32 0.806 | 0.210 | 0.163 07507 201582 D25 0.50% | 3.08
i MAINLINE 33 0.500 | 0.000 0.000 20772 [2006.02( 170 3390% [ 392
| D3B8 Curb 5477 557 023 E.10 0.081 037 2021.01 | 2018.34 | 2017.11 1.23 125 10.¢
P 208+88.00 ‘ -26 |L1 32 0.607 | 0.100 | 0.081 ST e 2015 e[ 123 247% [ 238
I MAINLINE 34 0.500 | 0.801 0.400 201657 [2016.08( 0.49 0976% [ 4.09
e | DI3B 16| Curb 5477 537 0.2 E.10 0.568 347 201934 | 2016.67 [ 2016.42[ 0.25 125 49
. 205+86.00 ‘ s |Rt. 35 0.563 | 1.009 | 0.568 M4z 2015 17| 035 0.50% [ 4.50
22 MAINLINE MH-1 Fii H A 202062 [2017.40( 321 BBI%|[ B73
e MH-12 [Junction | 51.77 524 0.10 E.10 0.338 208 202389 | 2021.02 | 2018.34 [ 2.68 125 165
. 207+35.00 ‘ s |Rt. 36 0.000 | 0.000 | 0.000 S019.77 [2017.09| 263 570% [ 375
25 MAINLINE 36 0.500 | 0.000 0.000 20M7ES (201636 1.34 2674% [ 678
28 | DISEE | Curb 2477 837 013 B0 0.500 3.05 202101 [2018.14 (201711 1.03 | 1.25 9.9¢
- 206+86.00 ‘ 2% |Rt. 35 0.860 | 0.120 | 0.164 M [ 201E | 103 207% [ 4.29
28 MAINLINE 35 0.500 | 0.000 0.000 20ME.08 [2015.69( 0.40 0765% [ 482
2a | DI3CE | Curb 56.00 587 0.19 B0 1.143 B.97 |2019.78 | 2016.42 [2016.16[ 0.26 15 7.
» 206+36.00 ‘ 2% |Rt. 32 0.825 | 0.020 | 0.074 S01452 (201486 0.5 0.50% [ 5.43
El MAINLINE 32 0.500 | 0.000 0.000 2014.80 (201475 005 0.308% [ 517
2| DI3CE | Curb 18.00 562 0.08 B0 1.447 8.82 |2019.78 | 201483 [2014.75[ 0.08 | 1.75 120
- 206+36.00 ‘ -26 |L1 QUTLET 0.824 | 0.020 | 0.074 S013.08|2013.00 003 0.50% [ 5.52
a1 MAINLINE 37 0.500 | 0.000 0.000 2023.72 (202030 342 S4X%%([ 810
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Saving the Spread Analysis Calculations from Drainage
1. Open the Select Active Network dialog. (Drainage > Network > Active Network)
Select Active Networl
Description
2. Select System 1 and click OK.
3. Generate the Spread Analysis report file for the project. (Drainage: Report > Generate.)
P:j Generate E
Drainage Report Format File: | cros®\SpreadAnalysisReport.df | &
Output File Name: | SpreadAnalysisCalcs.cav Q,
| Generate | | Wiew |
4. Select the Drainage Report Format File SoreadAnalysisReport.drf file located in the
C:\proj\supv8i\geopakiroad\macros\ directory.
5. Click Generate.
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Lab Exercise: Create VDOT Storm Sewer Tabulation Sheet

6-58

Creating the VDOT Spread Analysis Tabulation Sheet

1. Open the Inlet Spread Analysis Tabulation application by selecting the ISAT Icon located on

the VDOT Macro’s Task tool frame.

2. Set the Drainage project, Drainage preferences and the Drainage report file and Report

network in the Spread Analysis Tabulation dialog.

Drainage Project File:

|C: \data\Geo\vdot'drain 1\h 17682, gdf Q
Drainage Preferences File:

| Cildata\Geolwdot\drainl\Drainage_Preferences_176 Q

Drainage Report File:
|C: \data\Geo\wdotdrain 1\SpreadAnalysisCales.cs. O

Report Network: |System 1 j

Road: |Main|ine

Project Mumber: | 15782

Prepared By: |1,'D

Date: |5/23/2011

Checked By: |1-'D

Date: | 5/23/2011

Generate Spread Tab

3. Press Generate Spread Tab.

4. Provide a name for the new storm tabulation Excel spreadsheet: System 1 Spread Analysis

Tab.xls

5. Open System 1 Spread Analysis Tab.xls with Microsoft Excel. Review worksheet.

6. Exit MicroStation.
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7 Service Utilities and Utility
Conflicts

OBJECTIVES

e The objective of this chapter is to review the GEOPAK’s functionality of locating possible
utility conflicts in plan and profile view.

e Run VDOT Test Hole Utility Application
e Run VDOT Drainage Profile Application

DRAINAGE PROFILES: INTRODUCTION

A Profile is a path between two nodes, spanning one or more links. Profiles allow you to define a path
running in any direction (upstream or downstream) in a drainage Network and visualize profiles
(ground, pipes, depth of cover...) along that path. All that is needed to define a profile is the
identification of the From Node and To Node, and GEOPAK Drainage automatically traverses the
Network and finds the Links connecting the two Nodes. .

Several options are supported to add, edit, and delete Profiles and are invoked via the Component pull
down on the Drainage menu. Alternately, the Profile tools are invoked by selecting Tools > Tool Boxes
> Profiles, then identifying the desired tool from the tool box as depicted below.

B B G E

The Drainage Profiles tool box contains seven tools (from left to right). In addition, the tools can be
invoked via the Navigator.

Tool Description

Add Drainage Profile | Utilized to add a Profile to the current GEOPAK Drainage project.

Drainage Profile List List of profiles in the current drainage project.

ID Drainage Profile Allows selecting a previously plotted profile from the screen and making
it the active one.

M odify Drainage Utilized to select and edit any previously defined and stored Profile
Profile within the current project.

Delete Drainage Utilized to select and delete the specified Profile and associated data.
Profile

Update All Drainage Recalculates and redraws all the profiles in the active gdf file.
Profiles
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Drainage Profiles: Introduction

Auto Create Profile The Auto Create Profile tool draws a series of profiles based on the
specified network.

When the Add, Edit, or Delete options are selected, the dialog depicted below is displayed.
| Egit Drainage Profi [ )

File
Description: View Mumber:

Registration | Display || Drainage Information || Grid & Labels || Link Profile |
Registration Paint Projection

¥ | 2724747 620 [ Praject to Chain: Idertify Profile Cell
Y: | 339554 307 Chain

Scale Grid Stationing and Blevations

Horizontal: | 25.000 Begin Station: 0=00.00
Vertical: | 5.000 End Station: 1+21.52
Max. Blevation: | 2025.000

o 5t Min Bevation: | 2010.000
et

Node Information

Reference Surface

TIN File » | | proposed tin

[7] Wertical Offset:

Ta: |Dutlet -
Reset Profile

The dialog is comprised of the Description area and five tabs. The fields detailed in the table below are
independent of which tab is selected.

Profile ID Identification of the Profile is displayed in the Dialog Title bar.
(Maximum of 16 alphanumeric characters.)

View Number Select the view in which the profile is to be drawn.

Center Profile When clicked, the profile is centered in the specified view.

Description Description of the Profile. (maximum of 32 alphanumeric characters.)

This field is always at the top of the dialog, above the tabs.

Apply Applies the current Profile information in the project.
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Registration

REGISTRATION

The Edit Drainage Profile dialog under the Registration tab is the one that control the display of the
profile. Its setup is reviewed in the table below.

Registration Point: X coordinate corresponding to the specified Station, Elevation. Y
coordinate corresponding to the specified Station, Elevation.

DP Identify X, y coordinates using a data point. Click, then identify and
accept the desired point on the screen. Be aware that profile plotting does
not support rotated views. The vertical direction should always be due
North.

Scale: Horizontal and vertical scales. All profiles are drawn to true dimensions
in the horizontal, so the scales are used to determine the distortion factor
of the vertical. Example: 10 Horizontal : 1 Vertical means that the
vertical elements are distorted 10 times larger than the horizontal.

Node I nfor mation: Node used as the starting point of the profile. This is populated using the
From Node in the New Profile dialog. The From Node is on the left side
of the profile and the To Node is on the right side.

Reset Profile This will reset the profile display to the current setting of the dialog after
the Project to Chain option is deactivated.

Project to Chain If the Profile is to be projected onto a chain in order to utilize its
stationing, the toggle is activated and chain parameters specified by
selecting a profile cell previously plotted in the dgn file.

Grid Stationing and If Chain Projection is not used, the Stationing at the From Node is set to
Elevations: 0+00 and is assigned to the Registration Point. If Chain Projection is used,
the Station matches the Begin Station in the Projection group box.

The ending station is automatically computed based on the length of the
profile and the Beginning Station.

Reference Surface Surface utilized to draw the ground profile above the Profile. A site
model/object may also be specified. If blank, individual Node elevations
are utilized.

DiSPLAY PROPERTIES

The Display Tab determines what information is drawn for each profile. Activate the toggles for the
desired components of the profile drawing and set the desired element symbology. For the Water,

Drainage, Sewer Line and Misc. Utilities Crossings, labels may be placed by activating the toggle to
the left of label. A separate set of symbology is used for the textual label from the crossing elements.
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Drainage Information

R e R == ==

File

Description:

View Mumber:

| Registration | Diisplay | Drainage Information || Grid & Labels || Link Profile |

Soffit

—

Fipe Center

(]

Invert
| ——— |
Design Surface
Criginal Ground
Ref Surface

(]

DRAINAGE INFORMATION

Water Line Crossings

] —_
Drainage Crossings
_— Ol
Sewer Line Crossings

] —_
Misc. Utility Crossings

O = Label:

1D: |Mone Available A

Label:

Label:

Other information from the drainage GDF file may be optionally drawn. This information is generated
after the design or analysis of the network. Simply activate the toggle to the left of the desired drainage

information, and set the symbology.

o e ]

File

Description:

View Mumber:

Registration || Display | Drainage Irformation | Grid & Labels || Link Profile |

Hydraulic Grade Line
e
Critical Depth

=] —

Uniform Depth

=] ——

Energy Grade Line

] —

Meimum Soffit Drainage Mode
] _ _

Minimum Invert

=] —

Minimum Cover

=] |

Mamimum Depth

] |

GRID AND LABELS

A variety of Grid and labels options are supported to enable the user to customize the profile drawings.
Six Grid & Labels options are listed on the left side of the dialog. To activate an option, double click to
fill the option box to the left. Double click again to turn off, which ghosts the right side of the dialog.
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Link Profile

File

Description: View Mumber: E
| Reagistration || Diisplay || Drainage Information | Grid & Labels | Link Profile |

MNode Labels

=Node Position: |Along Profile -
Link Label

(W Elevations Label Offset: | 4.000
W] Grid Boundary [C] Library tem Name m

W] Horizontal Grid [ Library tem Description
W] Vertical Grid [F] Profile Name
Station
Elevation
[] Place Label: Prefix:
Sufie:

LINK PROFILE

In this tab, each node of the link profile can be reviewed and modified. Clicking on any Link ID in the
list box populates the fields below. To modify, change the desired field(s), then click Modify (to the
right of the list box.) To Hold an Invert, toggle on the button to the left of Hold Invert. The Slope can
also be held by toggling on in the lower right corner. A pipe size could also be change selecting the
Drainage Library Item option.

The user can also identify a Link ID, click ID then graphically identify one link of the profile. The
associated line is highlighted in the list box.

After performing the changes, click Apply to accept all modifications. Depending on your Update
options under Project>Preferences, Geopak Drainage will redesign your network using the same
design parameters and constraints specified under the Nodes and Links menus.

4 Edit Drainage Pra )
File

Description: Wiew Mumber: E

| Registration || Display || Drainage Information || Grid & Labels | Link Profile |
Drainage Profile Points

Link ID' | Node Hevation Mode Blewvation Slope
pipe-3 34 2015.423 35 2015176 0.500
pipe-6 35 2014.926 32 2014 660 0.500
pipe-7 32 2014.266 Outlet 2013.000 10.000
Details

MNode Node

Min. Cover: 2016.673 Min. Cover: 2016.426

[C] Hold Invert: | 2015.423 4[] Hold Invert: |2015.176

Drainage Library ttem |:| Hold Slope: | 0.500

R

[15 Inch Dia. Concrete Pipe = |

[] Center View: |1 =

Note Geopak Drainage cannot accommodate adverse pipe. If locked or held flow lines result in this
condition, Geopak will adjust the flow lines to fix the problem, thus giving the appearance that
the Lock or Hold Invert option does not work. A Warning message will inform the designer of
the changes made to the pipe elevations after the design is performed.
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Preferences

PREFERENCES

The setup of the Edit Drainage Profile dialog box could be could be saved into a preferences file with
default extension .ppf. This allows greater flexibility to the users since properties and display
information of most profiles in the same project are very similar.

(|50 Edit Drainage Prof )
File

Open... View Mumber:

Save n | Grid & Labels | Link Profile |
Save As... offit Drainage Node

— F —

WAroadistandardshdrain_profile,ppf

Critical Depth Mimimum Invert

=] e O —

Uniform Depth Minimum Cawer

=] HE O |

Energy Grade Line Mamimum Depth

] — B |

MISCELLANEOUS UTILITIES

Miscellaneous utilities can be stored within a drainage project and utilized within the utility conflict
tool. Each group of utilities is stored as a group, then the group is referenced for conflicts. Therefore, it
is prudent to group by location for subsequent location of conflicts, rather than grouping by utility
type. For example, all utilities in an intersection, (i.e., gas, power, cable TV) can be placed within a
single group, rather than all gas for an entire subdivision as a group.

This tool checks for conflicts in elevation but it does not address conflicts in the horizontal plane.

Miscellaneous utilities for a drainage project are defined thru Components>Miscellaneous
Utilities>Add.

Description:

Alignment Elevation Source Offset Size
Hem Level 53,00 surveytin -4.000 D.500

Details
Alignment: e
Blewation Source: | TIM File * | | survey tin Q

Size: | 0.500 Offset: | -4.000

To properly define a utility location, the user needs to specify the horizontal and vertical location of the
buried utilities in the Details section of the dialog box. The options available are:

Alignment Element: specify the MicroStation symbology of the drawn utility.

Chain: select the desired chain from the list of chain available in the
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Miscellaneous Utilities

gpk database

Elevation Sour ce

Model: it can be selected from the list of all models in the current
site project or GSF file.

Object: it can be selected from the list of all models in the current
site project or GSF file.

Tin file: select the DTM or tin file of project.

Size Defines the diameter of the utility in terms of master units, feet or
meters.
Offset Vertical distance (in master units) from the top of the utility to the

specified model, TIN file, object or profile. Negative offsets indicate
below the terrain, while positive offsets are above it.

VDOT GEOPAK Drainage

© 2011 Bentley Systems, Incorporated 7-7



Lab Exercise: Profile Design

LAB EXERCISE: PROFILE DESIGN

7-8

Creating a Drainage Profile

1. Select the Add Drainage Profile tool (Drainage: Component > Profile > Add).

Profile |D:

Description:

From Node
To Node

2. Enter the Add Profile information.

Profile ID: Profilel

From Node: Select 3-4

To Node: Select Outlet
3. Click Apply.

File

Description: View Mumber: E

Registration | Display || Drainage Information || Grid & Labels || Link Profile |
Registration Paint Projection

¥ | 2724747 620 [ Praject to Chain: Idertify Profile Cell
Y: | 339554 307 Chain

Scale Grid Stationing and Blevations
Horizontal: | 25.000 Begin Station: 0=00.00
Vertical: | 5.000 End Station: 1+21.92
Max. Elevation: | 2025.000

o 5t Min Bevation: | 2010.000
et

Node Information
To: [Qutlet - Reference Surface
| proposed tin

Reset Profile i
[7] Vertical Offset: | 0.000

4. Enter the Edit Drainage Profile information.

Min. Elevation: 2010.00
Max. Elevation: 2025.00
Horizontal Scale: 25
Vertical Scale: 5

5. Click DP and select a data point in the MicroStation design plane.

This is the location where the profile is drawn.
6. Select File> Open and select c:\data\geo\vdot\drainl\standards\Geopak\Drain_Profile.ppf.
7. This loads the profile plotting preference file.
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Lab Exercise: Profile Design

>

VDOT GEOPAK Drainage

Click Apply. GEOPAK Drainage draws the profile.
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Dynamically Editing Profiles

Select the Link Profile tab.

Click ID. Select and accept the link you want to modify from the profile view. (pipe-3). This
will make pipe-3 the active link.

In the Details section, click Edit Invert in the left Node group.

File
View MNumber:

| Reagistration || Diisplay || Drainage Information " Grid & Labels | Link Profile |
Drainage Profile Points
Link ID | Node
pipe-3 34

pipet 35

pipe-7 32

Details
MNode Node
Min. Cover:  0.000 Min. Cover:  0.000

[] Hold Invert: | 0.000
Drainage Library kem
< Mo Entries >

Description:

Elevation MNode
2015423 35
2014526 32
2014 266 Outlet

Elevation Slope
2015176 0.500
2014.660 0.500
2013.000 10.000

4 [ Hold Invert: | 0.000 &
[7] Hold Slope: | 0.001

[] Certer View: [1 =

Move your cursor into the profile view. There is a circle around the downstream invert at
node 3-4.

Move the cursor into the circle and drag the invert now. Link pipe-3 will dynamically follow
your cursor.

Data point to define a new invert location in the profile.

Click Apply. For this example, the "Automatic Update Network" dialog was activated in the
Preferences, so the network is automatically redesigned after clicking Apply.

Click NO to the alert dialog box if you do not want to display any warning or error message
generated by the design process.
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VDOT Test Hole Utility Application

Note GEOPAK Drainage redesigns your system aligning the pipes following the vertical alignment

options (Match Soffit, Match Inverts, Allow Drop Manhole, etc.) of your node configuration.
The inverts of the modified pipe get automatically locked but if there are other pipe sizes or
inverts that you do not want to change, you must lock them in the Link Configuration
Conditions dialog before changing an invert as shown above.

VDOT TEST HOLE UTILITY APPLICATION

The Test Hole Utility application imports user provided utility data to GEOPAK Drainage to be used
for plotting on the drainage profiles. The data can be either manually entered or imported from the
VDOT Utility Test Hole Information spreadsheet.

Teoeuiy . $Z .
@ QR e o e I

=

Write Data To GEOPAK Drainage

Link Search Distance: [5 Import Test Hole Data Spreadsheet: | S Import Test Hole Spreadsheet

Test Hole Top Elevation Size (Transverse or
Designator Baseline Station Offset X/E ¥/N (ft or m) {in or mm) Longitudinal} Description

utility
Utility Utility Qrientation to Road

MAINLINE Longitudinal

le.

EXEY =]

The Test Hole Utility application requires the job number, and a GEOPAK Drainage file to be
selected. The user can provide a Test Hole Name Prefix and a Link Search Distance. The Test Hole
Name Prefix is appended to the beginning of the test hole designator to use for the name of the
drainage nodes and links. The Link Search Distance determines how far from the test hole the
application will search for an intersecting link.

Once the job number, drainage file, name prefix, and search distance are selected, enter the utility data
into the appropriate fields for each test hole.

Note

Test Hole Designator — Enter Name/Number of the test hole.
Baseline — Select the chain name along which the station/offset are measured.
Station — (Optional; see below) Station of test hole along baseline. Entered by the user.

Offset — (Optional; see below) Offset of test hole measured from baseline. Entered by the
user.

X/E — (Optional; see below) X (Easting) coordinate of test hole. Entered by the user.
Y/N - (Optional; see below) Y (Northing) coordinate of test hole. Entered by the user.
Top Elevation — Elevation of the top of the utility. Entered by the user.

Utility Size — Diameter (in inches or millimeters) of the utility. Entered by the user.

Utility Orientation to the Road — Select it the utility runs longitudinal (along the roadway) or
transverse (perpendicular) to the roadway.

Description — Text to describe the utility. Entered by the user.

Either the station and offset or the X and Y coordinates must be entered. If both station/offset
and coordinates are entered, the coordinates will be used.

Once all of the pertinent data is entered, press the Add button Q to the right if the data fields to add it
to the list. Additional utilities can be added to the list as needed.

7-10
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VDOT Test Hole Utility Application

To modify an entry in the list, select the entry in the list. This displays the entry in the entry fields.
Make the desired changes. Press the Modify button to make the changes in the list.

The Delete button < or the Delete All button %! will delete the selected entry or all of the entries
from the list respectively.

Data can be imported from the VDOT Utility Test Hole Information spreadsheet. This data will be
imported directly to the utility list.

Once all data has been entered, press the Write Data to GEOPAK Drainage button to import the data to
GEOPAK Drainage. For each test hole, the application compares the test hole location to each link in
the drainage project. If the distance between the test hole and the link is less than or equal to the
search distance, then a drainage link is added to the drainage library. The link is created to be
perpendicular to the drainage link at the test hole location. This link can then be used to plot the utility
location and size on the drainage link profile. The utility link is create with the name of the test hole
name prefix and the test hole name. (i.e. For test hole 1A and prefix TH, the link name will be TH1A).
The nodes used for the utility link are given a name using the test hole name prefix, the test hole name,
and the location of the node, at the test hole (TH) or at the link (LNK). (i.e. For test hole 1A, prefix
TH, and located at the link end, the node name will be THLIALNK.) If more than one link is found
within the search distance for the link, the link and node names will be numerically incremented. (i.e.
TH1A-1, TH1A-2, etc. and THIALNK-1, TH1IALNK-2, etc.)

To plot the utility on the drainage profile, in the GEOPAK Drainage > Edit Drainage Profile dialog,
select the Display tab, and toggle on Drainage Crossings. When apply is selected, the profile will be
drawn/updated with the utility crossing links.

> Adding Test Hole Utilities to GEOPAK Drainage

1. Open the Test hole Utility Application by selecting the THU icon on the VDOT Macro’s Task
tool frame (6" icon from left).

] | o o] ] o]

2. Setthe Job to 101, select the Drainage Project File:h17682.gdf, and Import Test Hold Data
Spreadsheet: Utility Test Hole Information.xIs

5

ﬂ E % abfios ] RACHAE MESE Pomile {1 Dranage Fropect Fle: [CridassGeatratiornnn 1 76a2.gar Wirte Data To CEOPAK Drarace. |

£

Link Samrich Distance: [ Terport Toeet Hole Clanta Spreacutwst: |Cians\Geodotiar mn Ly Test Mok bnformation. ds Impar't Tiest boke Soreadchest |

ity Lriliey

Test Hole Top Elevation Size

Designator Baseline Station Offset R/E Y/N (ftorm) [in or mm)
MADUDE

Deseription

e

[ |x @

3. Press the Import Test Hole Spreadsheet button.
Joe s . Y 1L R . U

= B % P | Tt rioke tiame Frefi: [ Dramage Project Fie: [CriensiGen otienn |0 17652 gaf Wirite Giata To GECPAK Dranage |
Lk B ch Distance: [10 Tergprt Toeet Hoke Clnts Sprmaciubwent: [ci\cata\Geatdaticrant iUty Test Hoke tnformaton.ds o, Impart Test ok im. |
Uity N
utility utiliy Orientation 1o Aoad
Test Hole Top Elevation|  Size [Transverse or
Deégignatar Baseling Station Dffset R/E ¥IN (ftorm) [ cor i) Longitudinal) Description
oy Longhudnal aj
Maiciee: 207435 » 271837188 139184.53 FiT 0.3 Trarmvere ¥ 0as
Marire LR » 7184681 112744 2152 0.33 Longhuxdnad +EEC o
b
e

4. Press the Write Data to GEOPAK Drainage button.
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VDOT Test Hole Utility Application

Click the Save icon and save off the test hole data. Name the file h17682.thd
Close the Test Hole Utility dialog.

Open the Node Configuration dialog in Drainage and review the data.

Open the Link Configuration dialog in Drainage and review the data.

Close the dialogs when finished.

© o NG
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VDOT Drainage Profile Labeler

VDOT DRAINAGE PROFILE LABELER

This application labels multiple drainage objects in a profile view from both the graphics and objects
obtained from a GEOPAK Drainage project.

In order for this application to run GEOPAK must be activated. If GEOPAK is not activated the user
will be notified and the application will not start.

When started, this application will present the following dialog:

Drainage Profile Labele |t |
Job: 101 - Reference Chain: |D1'I'CH

Drainage Project: |C: \data\Geo'wdot\drain1th 17682, gdf

Test Hole File: |C: \data\Geo\wdot\drain 1\h 17652, thd

Identify Profile Cell | Profile Mame:

Profile Objects to Label
| Nodes [ Lirtks | Crossing Links [ Test Hole Utilities | Misc. Utilities

Move Label Label Profile Objects

The Job combo box will contain all GEOPAK COGO job files (.gpk) in the active directory (either that
of the current design file or that set in GEOPAK Preferences) and the first one will be selected. The
Reference Chain combo box will automatically be filled in from all chains in the selected Job and the
first one will be selected. The Drainage Project and Test Hole File will be filled in automatically from
a resource file created the last time the application was used.

The user will first select the COGO job that contains the chain they wish to reference stationing from,
then select the reference chain itself. These may already be selected by default but the user should
check to make sure.

Next the user will select the GEOPAK Drainage file (.gdf) the profile to be labeled was generated
from. This is done through a standard Windows file selector presented when the magnifying glass icon
is clicked next to the Drainage Project field.

If any test holes were dug for this project and the Test Hole Utility VBA used to store the test holes the
user should identify the Test Hole Data file (.thd). This is done through a standard Windows file
selector presented when the magnifying glass icon is clicked next to the Test Hole File field.

The next step is to identify the profile cell in which labels will be placed. This is done by clicking the
Identify Profile Cell button, issuing a data point anywhere on the profile cell object in graphics (grid
line, border line, axis text, etc.), and issuing another data point to accept the highlighted graphics as the
profile cell to evaluate.
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VDOT Drainage Profile Labeler

Once the profile cell is identified the application will extract information from that cell and the
elements contained within its boundaries and enter it into the dialog. The result will look similar to
this:

Drainage Profile Labele If x |
Job: [101 v Reference Chain: |MAINLINE -]

Drainage Project: |C:‘n,dam‘n,Geo‘n,vdot‘n,drainl‘nh1?682.gdf

Test Hole File: |C:‘n,dam‘n,Geo‘n,vdot‘n,drain1‘|.hl?682.ﬂﬂd

Identify Profile Cell | Profile Mame: |Pro-1

Profile Objects to Label

| Nodes [ Lirtks | Crossing Links [ Test Hole Utilities | Misc. Utilities
34 [w] pipe-3 [w] pipe-5
3-5 [w] pipe-6 [w] pipe-1
32 pipe-7 pipe-2
Cutlet

Move Label Label Profile Objects

Any of the Profile Objects to Label can be unchecked if the user does not wish to label them.

Once the user has reviewed those objects found within the profile to be labeled they will click the
Label Profile Objects button which will commence the labeling process.

The Move Label button allows the user to click on a label placed by this tool and move its location so
as not to interfere with another label or Drainage object. Depending on the label identified the user will
either simply identify the new label location, or identify the new location as well as the leader line
placement.

When the dialog is closed the GPK and THD file names and locations will be saved to a resource file
that will be read the next time the application is started.

> Labeling the Profile with VDOT Drainage Profile Labeler

1. Open the Drainage Profile Labeler Application by selecting the DPL icon located on the
VDOT Macro’s Task tool frame. (7" Icon from left)

EEEEEETES

2. Setthe Job to 101, the Reference Chain to MAINLINE, select the Drainage Project File:
c:\data\geo\vdpt\drain1\h17682.gdf, and the Test Hole File:
c¢:\data\geo\vdot\drain1\h17682.thd.
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VDOT Drainage Profile Labeler

Drainage Profile Labele 5 )

Job: | 101 A Reference Chain: “'—.‘I.‘ LINE}

=

Drainage Project: |C:‘l,dam‘l,Geo‘l,vdot‘l,drainlb1?682.gdf

]
Test Hole File: |C:‘l,dam‘l,Geo‘l,vdot‘l,drainl‘lh:l?GSZ.H‘ld

Q|

Profile Name:

Identify Profile Cell

Profile Objects to Label
| Nodes | Links

| Crossing Links | Test Hole Utilities | Misc. Utilities

Move Label

3. Click the Identify Profile Cell and select the grid for Profile Pro-1 and Accept with a data

Label Profile Objects

point. The dialog should fill out as shown.

Job: [101 Reference Chain; |MAINLINE |

Drainage Froject: |C:‘l,dam‘l,Geo‘l,vdot‘l,drainl‘lh1?682.gdf

Test Hale File: |C:‘-,da'ﬁ‘n,Geo‘n,vdot‘n,drainl‘nh1?682.ﬁ1d

Identify Profile Cell

Profile Name: |Pro-1
Profile Objects to Label
| Nodes | Links
34
35
32
Outlet

| Crossing Links | Test Hole Utilities | Misc. Utilities
pipe-3 pipe-5

pipe-6 pipe-1
pipe-7 pipe-2

Move Label

Label Profile Objects

4. Click the Label Profile Objects button.

5. Close the Drainage Profile Labeler dialog and the VBA Project Manager dialog.
6. Review the labels.

Note

We need to remove the labels placed by GEOPAK Drainage.
7.

Open the Edit Drainage Profile dialog. (Drainage > Component > Profile > Edit List)

VDOT GEOPAK Drainage © 2011 Bentley Systems, Incorporated
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VDOT Drainage Profile Labeler

[Select Profile to Edi

Description

8. Highlight Pro—1 and click OK.
9. Switch to the Grid & Labels tab.
(4 Edit Drainage Profile [

File

Description: View Number:

| Registration || Display | Drainage Information | Grid & Labels | Link Profile |
Labels & Grid Lines MNode Labels

ENode Posttion: |Along Profla~ w
Link Label

[ Bevations Label Offset: |4.000 m
] Grid Boundary Library tem Name
W] Horizontal Grid Library tem Description
] Vertical Giid Profile Name
Station
Blevation
Place Label: Prefic:

Suffoe:

10. Turn off the Node, Link Label, and Elevations options by double clicking on each name in the
left hand list.

11. Switch to the Display Tab and turn off the Drainage Crossings Label and the Misc. Utility
Crossings Label options.

EAESK Drainage Proties [
File

Description: View Number:
| Registration | Digplay | Drainage Information || Grid & Labels || Link Profile |
Soffit Water Line Crossings
1 _ Label:

Pipe Center — —
[ e rainage Crossings

et | ——— I
= Sewer Line Crossings

Design Suface E —— | Lohel:
] Misc. Lhility Crossings

e B e
Ref Suface ID: [Service_LUtilties hd

O

12. Click the Apply button.
13. Close the Edit Drainage Profile dialog.
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8 Plans Preparation

OBJECTIVES
e Review plans preparation procedures under GEOPAK Drainage.
e Plan View Labeling of drainage structures and pipes.
e Plotting flow directional arrows along the pipes.
e Plotting a sketch of the drainage network.
e Create Drainage Cross Sections
e Create Drainage Summary

e Create Drainage Descriptions

LAB EXERCISE: SKETCH OF THE GEOPAK DRAINAGE NETWORK
Creating a Sketch of the Network

1. Open the Drainage Network Sketch application by selecting the DNS icon from the VDOT
Macro’s Task tool frame. (2™ icon from the |eft)

lll@@@l

2. Set the drainage project and drainage network in the Drainage Network Sketch dialog.

I Drainage Network Sketc

Drainage Project File: |C: \data\Geowdot\drain 1Yh 17582, gdf Q

MNetwork: |System 1 hl

I
3. Upon selection, the sketch will be displayed in the dialog box.

VDOT GEOPAK Drainage © 2011 Bentley Systems, Incorporated
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Lab Exercise: Sketch of the GEOPAK Drainage Network

Drainage Network Sket:

Drainage Project Fie: [C:\data\Geo\vdot\dran1)h17682.odf ﬂ Adjust: Scale Move

Link Labels ~|| pipe-2 (12 Inch Dia

. ry
Network: |System 1 - pipe-6 (15 Inch Dia. -~
pipe-3 (15 Inch Dia. 4 »
H| ~ s pipe-5 (12 Inch Dia. — hd -

pipe-4 (12 Inch Dia.

4. Using the Scale and Move buttons adjust the size of the node labels, node cells and link
labels.

5. Click on the Saveicon to store the network sketch as a JPG image file.

Drainage Metwork Sket

Drainage Project File: |C: \data\Geowdot\drain 1Yh 17582, gdf Q

MNetwork: |System 1 hl

[
6. Close the dialog when done.
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Lab Exercise: updating the design to vdot cadd standards

LAB EXERCISE: UPDATING THE DESIGN TO VDOT CADD STANDARDS
Updating the Drainage Design to VDOT CADD Symbology.

>

Note

VDOT GEOPAK Drainage

1.

2.
3.
4

Open the Drainage Preferences dialog.(Drainage: Project > Preferences).
Select the Plan Symbology item.

Toggle OFF the Labels option.

Disable the Set Node Cell Symbology.

File

Ciptions Plan View Parameters
Urits Component  Linear

Project Components .
Rainfall Parameters freas:
Land Use Options Pipes:
Frequency Options ) _
Intensity Option PR che=
Junction Losses Culverts:
Inlet Options Nod
MNode Cptions odes
Link Options (| Set Node Cell Symbology
Profile Options Inlets:
Plan Symbology .
Updates Junctions:
Save Options Outlets:

Cther:

Headwall:

gy
HE

¥

¥ ¥
L

Click OK when done and click Yes when prompted to store the changes.

Open the Design & Computation Manager. (Applications > GEOPAK > Road > Design &
Computation Manager)

In the Design & Computation Manager, open the VDOTenglish.ddb database located in the
c:\proj\supv8i\geopakiroad\ddb\ directory. (Design and Computation Manager : File >
Open)

om0y s o

File Edit Settings Favorites Help

s id B mnie

&3 \projsupv8i'geopak‘road"ddb VDO Tenglish ddb
1 Road Design
3 Survey
7 Right of Way
7 Lkilities
1 Environmental
3 Traffic
£ Geatechnical

The VDOTenglish.ddb file should come up automatically due to a configuration
variable that is set up by the CADD administrator.
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Lab Exercise: updating the design to vdot cadd standards

8-4

8. Select Settings > Design in order to change the updating properties for the drainage structure

File Edit | Settings | Favorites Help

cells.

N Display N
e it
g id [| Design |
& \proj'sy O Tenglish.ddb
f1Road[ COmpute
£ Survey|  Computation Units
3 Right o
£ Utiities|  Dialog
3 Enwiror] —
£ Traffic Criteria Viewer

£ Geatechnical

9. Toggle ON the Influence Graphic Cell Symbology option. Then, close the dialog box.
[0 Design Settings B .l

Bement Connectivity

Maimum Gap Tolerance : | 0.50000
Deduction Tolerance : | 0.50000

Custom Line Style Creation

Scale Factor : | 1.00000

Cell Creation

Plot Scale : | 1.000 / Creation Scale
{Influence Graphic Cell Level Symbology!

10. Execute the Area Update All option. (Drainage: Component> Area > Update All).GEOPAK
Drainage will clear the previously place drainage area labels.

11. Execute the Nodes Update with Payltems option. (Drainage: Component> Nodes > Update
Wth Pay Items). GEOPAK Drainage will update the drainage structures level symbology
according to VDOT CADD Standards.

12. Execute the Links Update with Payltems option. (Drainage: Component> Link > Update
Wth Pay Items). GEOPAK Drainage will update the drainage structures level symbology
according to VDOT CADD Standards.
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Plan View Labeling

PLAN VIEW LABELING

The
tool

Labeling automates the composition and placement of plan labels onto drawings. This interactive
permits the creation of very simple to complex labels using many of the following features:

Numerous Computed Text Inserts permit standardized computed values to be easily incorporated
into labels. These standardized computed values are based on the type of element to be labeled and
change as you select different elements. Types of elements available for computed inserts include
points, lines, arcs, complex graphic elements, COGO features, and drainage features.

User Text Inserts facilitate the simple inclusion of user defined text strings into the label. These
User Inserts can be customized to include frequently used labeling terms and be saved for
continual use.

Standard shapes can be placed around labels and to accommodate different plan label formats.
Standard leader lines and leader line terminators can also be utilized to create the desired label
formats.

Frequently utilized labels can be stored as Label Styles for subsequent recall. The complete label,
including computed text inserts, user inserts, shapes, and leaders, are all stored within the Style.
Tools to edit, move, and extract labels are also provided to make manipulation and plan changes
easier.

Enhanced ASCII is supported by use of the (\) symbol.

Styles are supported, whereby often used labels and associated settings can be saved off and
recalled in subsequent sessions.

Updating options provide for efficient changing as the project dictates changes in the design.

While the labeler can be used for generic purposes, several of the fields are set up for specific
applications. The specialty modes include:

Plan View
Profile

Cross Section
Drainage

Site

Water and Sewer

Under each mode, the types of elements available to label and the associated text inserts change.

VDOT GEOPAK Drainage
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Lab Exercise: Plan View Labeling

LAB EXERCISE: PLAN VIEW LABELING

> Labeling Drainage Structures

1. Open the Drainage Labeler. (Drainage: Utilities> Labeler).
2. Select the Text Tab and set the Component to Node.

I Drainoge Laboles - oF

Style Files  Options  Scale Tools

Tent | Params. || Shape || Leader || Rotate || Styles |

g @ Computed Inserts () User Inserts
O o g

BElement 1D Computed Text
MNode - 1D

Mode - Description [ Space l ’ Retum

Mode - Type

Mode - Library tem Mame [ Clear l l Delimit

Mode - Library kem Description
Mode - Reference Chain [

Flace Label

Mode - Reference PGL

Automatic Label

[ Highlight ~ [] Window Certer Mot Awailable

3. Select the first Element ID: 3-1.
4. Double-click the Computed Text: Node-ID to add it to the Editor box.

Style Files  Options  Scale  Tools

Text | Params. || Shape || Leader || Rotate || Styles |

@ w / ’g’cé) @ Computed Inserts (7 User Insers

Element 1D Computed Text

Node - 1D
Node - Description \ [ Space ] [ Retum

Mode - Type

Mode - Library kem Name [ Clear ] [ Dielimit

Mode - Library tem Description
Mode - Reference Chain [

Flace Label

A Mode - Reference PGL

Automatic Label

H

5.

[ %0 Drainage Labeler - 5

Style Files  Options  Scale Tools

|Text | Params. | Shape || Leader || Rotate || Styles |
Tent Preferences / Symbology Sample Output

Y
Samp le i

Line Spacing: | 1.000

[ Space l l Retum ]

[ Clear ] l Delimit ]

[

Flace Label ]

Automatic Label

8-6 © 2011 Bentley Systems, Incorporated
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Lab Exercise: Plan View Labeling

Symbology
Level: |Lewel 31 -
Color

iWeight? | 1 ~|

Text Preferences e
Set Justification
Th: | 4.000

Tw: | 4.000 a Sﬂmp I e

ft: (22 3 ENGINEERING -]

I Cancel I

6.

Style Files  Options  Scale  Tools

Text | Params. I Shape | Leader || Rotate || Styles |

Shape Preferences Sample Output

mﬂ@@@@@
A f (5] e fe] I8
Symbology:
Offset: [ 1.00 | Cear | [ Deimt |
l Place Label ]

[ Space I I Retum J

Automatic Label

7. Move to the Leader Tab and set the Leader Type as shown below.
EAYDreinone Labeles s Gt [ E——c—I

Style Files  Options  Scale  Tools

|Text || Params. || Shape | Leader | Rotate | Styles
Leader Type Teminator Sample Output

v ] L=

>0 {= AT

Symbology: = [ Space I I Retum J

[ Clear I I Delimit J

[ Place Label ]

Automatic Label

8. Move to the Rotate Tab and select the Current Angle option as shown below.
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Lab Exercise: Plan View Labeling

Style Files  Options  Scale Tools

|Taxt || Params. || Shape || Leader | Rotate | Styles |
Sample Output
Teat Angle

Cument Angle: 0.000

“ Current Angle

l‘a Alignment Angle: | 0.0

| Space | | Retum |

| Clear | | Diedimit |

Set Angle By
[ DP | [Bement] | Place Label |

Automatic Label

9.

Style Files  Options  Scale Tools

|Taxt || Params. || Shape || Leader | Rotate | Styles |
Sample Output
Text Angle
‘?‘ Cument Angle: | 0.000
+4%  Element Angle

l‘a Alignment Angle: | 0.0 |z| | S0ace | | feam |
| Clear | | Diedimit |

Set Angle By
[ DP | [Bement] [ AA | | Place Label |

Automatic Label

10. Create a new Style by moving to the Styles Tab and clicking on New Style. Provide a style
name for the label, and press OK.

[ 20 Drsinage Labeler - Sty [————

Style Files  Options  Scale Tools

|Taxt || Params. || Shape || Leader || Rotate | Styles
ltem Selector 71 Style Preview

[ Labels
7 Line Labels
7 Arc Labels
g E';i;'; Labels | Space | | Retum |
£ Right of Way | Cear | [ Deimt |
3 Hydraulic

Seale - N/A [Mode and Shape Only |

| Place Label |

Automatic Label
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Lab Exercise: Plan View Labeling

Style Name: | Struct #
Style Scale: | 1.000

[ 814 ] | Cancel |

11. Save the Style by selecting Style Files > Save.
(721 Drainage Labeler - Styie ()

Style Files | Options  Scale  Tools

Mew.. EQ

Open... Style Preview
| Save

Save As...

= | Space | | Retum |

LAsupvBitgeopakiroadlabels\vdot. sf
LAgeopakibinidef_drg.lsf

New Style.. | | Update Style..

~tegory | Scale 1 1.00 &

| Clear | | Delimit |

| Flace Label |

Automatic Label

[Mode and Shape Cnly ~|

12. Move to the Text Tab, and select the second structure: 3-2. By activating the Highlight and
Window Center toggles, the Drainage Labeler will navigate to the correspondent drainage
structure location in the dgn file.

Style Files  Options  Scale  Tools

| Text | Params. || Shape || Leader || Rotate || Styles |

@ w / ’g’cé) @ Computed Inserts lUser Inserts

Computed Text
31 Mode - 1D

32 Mode - Description

33 Mode - Type

34 Mode - Library kem Name

35 Mode - Library tem Description
36 Mode - Reference Chain Place Label
37 A Mode - Reference PGL Automatic Label

Highlight Window Center 3-2

13. Label the remaining drainage structures.

> Labeling Pipes

1. After labeling the drainage structures, click on the Clear button in order to empty the Editor
box.
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Lab Exercise: Plan View Labeling

8-10

Select the Text Tab and set the Component to Links.

Style Files  Options  Scale  Tools

| Tent | Params. || Shape || Leader || Rotate || Styles |

@ y ﬂ %Cg @ Computed Inserts  (7) User Inserts

Element 1D

pipe-1 Link - Actual Velocity Downstrea =

pipe-2 Link - Actual Velocity Upstream
pipe-3 Link - Pay ttem

pipe-4 Link - Library Description
pipe-3 Link - terative Velocity

pipe-6 Link - Full Velocity

pipe-7 Link - Upstream Freeboard

[ Space ] [ Retum ]

[ Clear l l Deelimit ]

[ Place Label ]

Automatic Label

[7] Highlight [~ Window Center 12" Diameter Circular Concrete Pipe Req'd.

Select the first Element ID: pipe-1.
Compose the label by double-clicking into the Computed Text: Link-Library Description.

Style Files  Options  Scale Tools

| Tent | Params. || Shape || Leader || Rotate || Styles |

@ Computed Inserts  (7) User Inserts
® W g %

Element 1D

pipe-1 Link - Actual Velocity Downstrea =
pipe-2 Link - Actual Velocity Upstream
pipe-3 Link - Pay tem

pipe-4 Link - Library Description

pipe-5 Link - tterstive Velocity

pipe-& Link - Full Velocity

pipe-7 Link - Upstream Freeboard

()

Concrete Pipe Reg'd.

Space l l Retum ]

Clear ] l Delimit ]

Flace Label ]

Automatic Label

[] Highlight ~ [] Window Center 12" Diameter Circular Concrete Pipe Req'd.

Click on the Parameters Tab and double click on the Text Preferences/Symbology and set as

shown below.

Symbology
Level: [Level 31
Color: [ 0
Weight: |

Text Preferences
Th: | 2.000

Set Justification

Jsoro1s

Rt [33 3 ENGINEERING ~|

Move to the Shape Tab, and set the Shape Preferences and Symbology as shown below:

© 2011 Bentley Systems, Incorporated
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Lab Exercise: Plan View Labeling

Mo e e R =)

Style Files  Options  Scale Tools

Text || Params. | Shape | Leader || Rotate || Styles Concrete Pipe Reg'd.
Shape Preferences Sample Output

| | mee®o o
A B e E R

Symbology: = | Space | | Retum |

Offset: | 1.00 | Cear | [ Delimt |

| Flace Label |

Automatic Label

7. Move to the Leader Tab and set the Leader Type, Terminator and Symbology as shown
below:

J P:] Drainage Labeler - Sty | E EJ
Style Files  Options  Scale Tools

Text | Params. | Shape | Leader | Rotate | Styles Concrete Pipe Reg'd.
Leader Type Teminator Sample Output

L1~ L=

0 I= AT

Symbology: = | Space | | Retum |

| Clear | | Diedimit |

| Flace Label |

Automatic Label

8. Move to the Rotate Tab and select the Current Angle option as shown below:

Style Files  Options  Scale Tools
Text || Params. || Shape | Leader | Rotate | Styles Concrete Pipe Reg'd.
Sample Output

Text Angle

‘?“ Cument Angle: | 308.818

Element Angle

l‘a Aignment Angle: | Space | | fehm |
| Clear | | Delirnit |

Set Angle By
[ DP | [Bement] [ AA | | Place Label |

Automatic Label

Note If the element angle is not correct then reselect the Element from the Text tab.

9. Place the label in the design file by clicking Place L abdl.

10. Move to the Text Tab, and select the second pipe: pipe-2. By activating the Highlight and
Window Center toggles, the Drainage Labeler will navigate to the correspondent drainage
pipe location in the dgn file.
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Lab Exercise: Plan View Labeling

Style Files Options Scale  Tools

| Text | Params. || Shape || Leader || Rotate || Styles | 12" Dismeter Circular

@ w ﬁ !E/L@F @ Computed Inserts () User Insens

): Computed Text
pipe-1 Link: - Actual Velocity Downstrea =

pipe-2 Link: - Actual Velocity Lpstream
pipe-3 Link - Pay ftem

pipe-4 Link - Library Description
pipe-5 Link: - terative Velocity

pipe-& Link; - Full Velocity

pipe-7 Link: - Upstream Freeboard

Space ] [ Retum l

Clear ] [ Delimit ]

Flace Label ]

Automatic Label

l

l

[
[7] Highlight ~ [] Window Center 12" Diameter Circular Concrete Pipe Fklaq

11. Label the remaining pipes and close the Drainage Labeler when done.

> Plotting Flow Arrows along the Pipes

1. Open the Drainage Flow Arrows application by selecting the DFA icon located on the VDOT
Macro’s Task tool frame. (1% icon from the | ft)

o4 ] 50 ] o ] o] s o]

2. Setup the Drainage Profile dialog as shown below.

Drainage Project File: |C: \data\Geo\wdot\drain 1\h 176562, gdf

Cel Network: | STEauEl

Mame: |FLOWA
Scale: Draw Drainage Arrows

3. Click on the Draw Drainage Arrows button to plot the flow lines along the pipes.
4. Close the dialog when done.
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Automated Quantities

AUTOMATED QUANTITIES

The Design and Computation Manager (D&C Manager) is a tool that enables the user to standardize graphics
elements for drafting and pay item quantities.

A D&C Manager Pay Item can be used for Node and Link items within the Drainage Library for use in
performing quantity takeoffs and applying D&C symbology. Pressing the Select button within the specific
Drainage Library Node or Link item invokes the Design and Computation Manager, in order to select the
desired Pay Item.

File Edit Settings Favorites Help

i B mn

=2 \projhsupv&itgeopalroad \ddb\VDO Tenglish .ddb
[ Road Design
1 Drainage Generic
3 Alignments
23 Box Culverts
3 Construction Limits
23 Curbing
[ Drop Inlets
== DI-1 TO DI-2CC
006740 DI
006741 DI-1A
006745 DI-24
006746 DI-2AA
006747 DI-2B. L= 4
006748 DI-ZE, L=§

OPERATIONAL MODES: COMPUTE

Several operational modes are supported within the Design and Computation Manager; one of them is
the Compute mode.

Through the Compute mode of the Design and Computation Manager, GEOPAK offers tools that
make the completion of this task much quicker and easier. In addition, since the software utilizes the
plan view construction drawings to compile quantities, discrepancies between the drawings and the
tabulated quantities are non-existent. Chosen items within either the View or a Fence are calculated.

File Edit Settings Favorites Help

& \projsupv Bi\geopalroad \ddb VDO Tenglish ddb
[ Road Design
] Drainage Generic
7 Alignments
£ Box Culverts
1 Construction Limits
{7 Curbing
[ Drop Inlets
(7= DI-1 TO DI-2CC
006740 DI-1
006741 DI-1A

006740 DI
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Operational Modes: Compute

Job: (101 |Q,  Edents: [Active DesignFile | [Inside ] 07
Baseline Reference

[Chain =] [MAINLINE | ¥ [¥] Begin Station: | 200+00.00
¥| Range: |100.00 V| End Station: | 222+06.84

| Hilight During Computation: | N = - | Compute Quartities |

Once the MicroStation plan view design file is accessed, the first step is to invoke the Design and
Computation Manager and click the shortcut button at the top of the dialog box to Compute.

The dialog box changes dynamically to reflect the compute operation.

The Design and Computation Manager dialog box is resizable. Within the dialog box, the sash (long,
thin bar between list boxes) enables the user to adjust the partition between the list and collection
boxes while the overall dialog box size remains constant. Simply place the cursor over the sash and
dynamically move.

In addition to dynamically adjusting the main dialog box to reflect the compute operation, the auxiliary
dialog box is invoked as depicted below. Note if the auxiliary dialog box was already invoked from
another operation, it dynamically changes to reflect the Compute operation.

The next step is the selection of the correct item from the hierarchy. GEOPAK computes quantities
only for those hierarchical items that are configured for the computation of quantities.

Two selection methods can be employed. The first method is to select an entire category. GEOPAK
computes quantities for every item found in the selected category as well as any child categories. This
is accomplished by double clicking through the groups until the desired category is contained in the
Content list box. Single click onto the desired category and click the Add to Collection button at the
top of the dialog box.

The second method involves the selection of individual features. This is accomplished by double
clicking through the categories until the desired item appears in the hierarchy list box. When seen in
the hierarchy list box, a single click onto the desired item and subsequent click of the Add to
Collection button places the item in the Collection box.

Several output formats are available as described in the table below.

Iltem Report Quantities Summary lists pay items, descriptions, units and total quantities for
located elements. File is in ASCII format.

Comp Book A more detailed report that lists not only quantity summaries, but also geometric
properties such as plan view coordinates and station/offsets for located elements.
File is in ASCII format.

Item Tables Contains the same information as the Item Report, but formatted in tabular form.

CSV by Item Quantities Summary lists pay items, descriptions, units and total quantities for
located elements. Format is in CSV format.

SDF by A more detailed report that lists not only quantity summaries, but also geometric

Element properties such as plan view coordinates and station/offsets for located elements.

Format is CSV format.

DBMS Very detailed information including calculated and rounded quantities, geometric
properties, pay item numbers, descriptions, station / offset values, etc. The format
is the selected database (i.e., Microsoft Access, Oracle, SQL Server, and dbase.

Table Places the report into the active design file.

8-14 © 2011 Bentley Systems, Incorporated VDOT GEOPAK Drainage



Operational Modes: Compute

An option button located on the left side of the Compute auxiliary dialog box dictates the Output.
Options that apply to various Output types are detailed in the table below

View / Fence

File / Preview

Description
Display
Highlight in
Computation

Compute

Job Number

Chain

Select

Range

Phase

Run

VDOT GEOPAK Drainage

If the View toggle is selected, only selected items that can be seen in
MicroStation view one will be computed. If the view includes area outside of
the Range, the Range will override. If the Fence toggle is selected, a fence
must be placed, and all specified graphical features, which are inside both
the fence, and the Range will be tabulated. The Fence mode is sensitive to
the MicroStation Inside, Overlap and Clip modes.

If set to File, GEOPAK creates the file whose file format is based on the
Output type and whose name is defined in the key-in field to the right of the
File option. The name can be manually entered or selected via the Files
(folder) icon. The file can be created or appended to an existing file. If
desired, a full path may be specified, otherwise, the report will be found in
the current directory.

If the option is set to Preview, the file is not created and the output is
displayed in a GEOPAK window.

Any description keyed within this field will be printed at the top of the report.
There is a maximum of 48 characters supported for this field.

These short cut icons are functionally identical to the Display mode in the
main dialog box and are discussed in the next section.

When activated, all MicroStation elements utilized in computations are
highlighted.

Commences the computation process.

GEOPAK Coordinate geometry database (GPK) file wherein the specified
chain is stored.

Requires a minimum of one chain, which must be stored in the specified job
number.

When selected, the Chain Selector dialog box appears, wherein the user can
select the desired chain.

Left and right offset limits (in master units) from the chain where the
guantities will be computed. Any specified item located outside of the limits
is not included in the report

Quantities can be separated into various phases, as a means to group
various pay items. Default phases include: Design, Preliminary, and Final.
Note the user can add new phases, but must be aware of naming limitations
of downstream applications (i.e., Transport links in Quantities Manager.)

The user may also runs as a method of grouping various quantities and / or
pay items.

© 2011 Bentley Systems, Incorporated 8-15



Lab Exercise: automated plan view quantities

LAB EXERCISE: AUTOMATED PLAN VIEW QUANTITIES

8-16

Computing Automated Quantities

1. Utilize the MicroStation command Window Areato view the entire Drainage Network in
view.

2. Inthe Design and Computation Manager, set the Mode to Compute by pressing the
‘calculator' icon button.

File Edit Settings Faverites Help

[ Road Design
] Drainage Generic
7 Alignments
7 Box Culverts
7 Construction Limits
23 Curbing
1 Drop Inlets
1 End Sections
7 Endwalls
7 Erosion Control

3. Highlight the Drop Inlets Category under Location&Design, then press the Add to Collection
button on the Design & Computation Manager toolbar.

File Edit Settings Favorites  Help

#id B ¢ERile]

& \projsupvBi\geopalkroad \ddb VDO Tenglish.ddb &
[ Road Design |Add Highlighted to the Collection
1 Drainage Generic
3 Alignments
7 Box Culverts
1 Construction Limits
{7 Curbing
3 Drop Inlets
7 End Sections
3 Endwalls
{7 Erosion Control

4. Set the Compute dialog as shown below.
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Lab Exercise: automated plan view quantities

6.
7.

VDOT GEOPAK Drainage

Job: |101 |Q,  BEdents: [Active DesignFile | [Inside | O3

Baseline Reference

Hilight During Computation: [HEEEE | [ Compute Quantities

ftem Description

300333 DI-3B, L=10
300405 DI-AC. L=F
300331 DI-3B, L= 8
300393 DI-3B. L= 18

Export Format: Q

Run: Phase: | DesignEstimate Display

Close the dialog when done.
Exit Microstation.
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VDOT Drainage Cross Sections Applications

VDOT DRAINAGE CROSS SECTIONS APPLICATIONS

DRAINAGE PATTERN LINES

8-18

This application draws pattern lines (lines used to cut GEOPAK cross sections) in plan view at
locations obtained from a GEOP AK Drainage project.

In order for this application to run GEOPAK must be activated. If GEOPAK is not activated the user
will be notified and the application will not start.

When started, this application will present the following dialog:

Drainage Pattern Line: — |

Job: [ 101 »| Chain: | mMAmLINE ~] i

Drainage Project:

|C: \data\Geo'wdot\drain 1%h 17682, odf ﬂ

[¥ Pattern Lines for Cross-Line Pipes = gﬂ

I+ Pattern Lines for Drainage Nodes = ﬂﬂ
v Pattern Lines for Utilities _ gﬂ

Test Hole File: |C: \data\Geo\wdot\drain 1Yh 17652, thd ﬂ

Pattern Line Offsets Tolerance: |10.5

Left: 200 Right: {200

Draw Pattern Lines

The Job combo box will contain all GEOPAK COGO job files (.gpk) in the active directory (either that
of the current design file or that set in GEOPAK Preferences) and the first one will be selected. The
Chain combo box will automatically be filled in from all chains in the Job selected. The remainder of
the dialog will be filled in automatically from a resource file created the last time the application was
used.

The user will select the GEOPAK Drainage file (.gdf) they wish to obtain pattern lines from. This is
done through a standard Windows file selector presented when the magnifying glass icon is clicked.

Three pattern line options will determine the source(s) for pattern lines:

1. The first is used to generate pattern lines for all Drainage pipes (links) that cross the chain
specified. The pattern line will be created at the same skew as the pipe.

2. The second is used to generate pattern lines for all Drainage inlets (nodes) that lay within the
chain limits.

3. The third is used to generate pattern lines at each utility location defined by test holes created
with the Test Hole utility. If this option is turned on the Test Hole File must be selected using
the magnifying glass icon next to the field. As before, a standard Windows file selector will
be presented for locating the desired file.

—_— 4
— 0 4
. ¢ &

Each of these options allows the user to define the symbology to be used in creating the pattern line for
that type:
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Drainage Pattern Lines

The example graphic gives an approximation of the resulting pattern line look, and hovering over this
image results in a pop-up help detailing the symbology currently set for this type of pattern line.

The symbology button allows the user to select symbology from the standard MicroStation options for
level, color, line style, and line weight through the use of an auxiliary dialog:

FDraw Attributes ]|

Level: |Leve| 50 ﬂ ﬂ

Color: I:‘ 7
Style: |D J ﬂ

-

Weight: |2 -

This provides the ability to set the symbology from an element in the active design model.
gf Simply click this button and select and accept an element.

This provides the ability to highlight all elements in the active design model that match the
&7 set symbology in order to verify the settings are correct.

The D&C button allows the user to select symbology from the GEOP AK Design and
Computation manager J items through the use of another auxiliary dialog:

@ u =
@@ C:\projisupvai\geopakiroad\ddb WDOTenglish. ddb

3 Road Design

3 survey

23 Right of Way

3 Utilities

3 Environmental

3 Traffic

0 Geotechnical

This provides the ability to open a D&C database (.ddb) other than the default one.
=g

This provides the id | ability to select the D&C item by selecting a MicroStation element
that was drawn with a given item.

Pattern Line Offsets Tolerance: [10.5 o

Left: 200 Right: | 200

Draw Pattern Lines

Back on the main dialog there are two fields for defining the pattern line offsets. These values will
define how far left and right of the alignment the pattern line will extend.

Finally, the Tolerance field defines the distance an object must be from another pattern line before it
will be used to generate another pattern line. This helps eliminate pattern lines that are so close to each
other they result in essentially the same cross section.
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Draw Drainage Features in Cross Section

DrRAW DRAINAGE FEATURES IN CROSS SECTION

This application draws GEOPAK Drainage elements in cross section at locations obtained from a
GEOPAK Drainage project.

In order for this application to run GEOPAK must be activated. If GEOPAK is not activated the user
will be notified and the application will not start.

When started, this application will present the following dialog:

" Draw Drainage Features in ==

E ﬂ Move Label

General lSide-Line Pipes ] Cross-Line Pipes | Test Holes

Job: [101  +| Chain: [MamLINE

Drainage Project File:
|C: \data\Geo'wdot\drain1th 17682, gdf

Tolerance: |1

[+ Honor %5 Exaggeration

Process Cross Sections

The Job combo box will contain all GEOPAK COGO job files (.gpk) in the active directory (either that
of the current design file or that set in GEOPAK Preferences) and the first one will be selected. The
Chain combo box will automatically be filled in from all chains in the Job selected. The remainder of
the dialog will be filled in automatically from a resource file created the last time the application was
used. In addition, the user can open a previously saved resource file other than the most recent.

The user will select the GEOPAK Drainage file (.gdf) they wish to obtain drainage objects from. This
is done through a standard Windows file selector presented when the magnifying glass icon is clicked.

The Tolerance field indicates the distance within which a drainage object will be considered to fall on
a cross section. If a drainage object is farther away than this from the cross section location (pattern
line) it will not be drawn on the cross section. Keep in mind that a cross section must be cut at the
pattern line location in order for drainage objects to be drawn on that cross section. A drainage objects
proximity to a pattern line in plan view does not necessarily mean it will be drawn in cross section
unless a cross section exists for that pattern line.

The Honor XS Exaggeration option will, when turned on, distort the items drawn according to the
exaggeration at which the cross section was originally drawn. This most noticeably results in ellipses
drawn rather than circles for round pipes.

Three types of drainage objects can be drawn in cross section and are turned on or off through three
drawing tabs in the dialog which also allow the user to establish settings for the drawing of those
objects:

1. The first drawing tab is used to generate Side-Line Pipes (longitudinal pipes) for all Drainage
pipes (links) that cross the cross section pattern line.
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Draw Drainage Features in Cross Section

VDOT GEOPAK Drainage

Draw Drainage Featur ===

g E ﬂ Move Label

General Side-line Pipes lCross-Line Pipes ] Test Holes ]

Symbology: mﬂﬂ

[+ Draw Qutside of Through Pipes Line Style: | 0

[+ Draw Front Pipes Symbology: mﬂ ﬂ

[+ Draw Outside of Front Pipes Line Style: | 0

[¥ Draw Back Pipes Symbalogy: n ﬂﬂ

[+ Draw Outside of Back Pipes Line Style: | 0

Side-Line Pipe Label Draw Symbology: ﬂ ﬂ

Process Cross Sections

Several options allow the user to draw pipes that intersect the cross section (Through Pipes),
begin at the cross section (Front Pipes), or end at the cross section (Back Pipes) with options
to draw the outside of the pipe with a different line style.

The second drawing tab is used to generate Cross-Line Pipes for all Drainage pipes (links)
that cross the alignment and have both begin and end node that fall within the tolerance of the
cross section pattern line (typically from cross sections created from pattern lines generated
using the Drainage Pattern Lines utility).

Draw Drainage Featur ===

g E ﬂ Move Label

General | Side-Line Pipes  Cross-Line Pipes | Test Holes |

Symbology: mﬂﬂ

[+ Draw Qutside of Through Pipes Line Style: | 0

Cross-Line Pipe Label Draw Symbology: ﬂ ﬂ

[# Label the Ends of Cross-Line Pipes with FL Elevation and Station

Process Cross Sections

Again, several check boxes allow the user to set options for this type of item including the
outside of the pipe and labeling.

The third drawing tab is used to generate Test Holes for all Drainage pipes (links) added with
the Test Hole utility.
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Draw Drainage Features in Cross Section

8-22

g E ﬂ Move Label

General | Side-Line Pipes | Cross-Line Pipes  TestHoles ]

Test Hole Data File:
|C:\dab\Geo‘wdot\drain11']11?682.ﬂ1d

Test Hole Label Draw Symbology: ﬂ ﬂ

Process Cross Sections

The Test Hole File must be selected by clicking on the magnifying glass icon next to the field
which will present a standard Windows file selector for locating the desired file.

In each of the drawing tabs described above there are multiple symbology settings that can be
established. This is done through a standard set of tools described as follows:

The example graphic gives an approximation of the resulting look of the drawn object, and hovering
over this image results in a pop-up help detailing the symbology currently set for this item.

Symbology: =ﬂﬂ

The symbology button allows the user to select symbology from the standard MicroStation options for
level, color, line style, and line weight through the use of an auxiliary dialog:

Level: |Default

Color: |:| i}

weight: |0

Style: [1

This provides the ability to set the symbology from an element in the active design model.
._!' Simply click this button and select and accept an element.

This provides the ability to highlight all elements in the active design model that match the
set symbology in order to verify the settings are correct.

The D&C button allows the user to select symbology from the GEOPAK Design and Computation
manager items through the use of another auxiliary dialog:
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Draw Drainage Features in Cross Section

£ Road Design

£ survey

23 Right of Way
3 Utilities

3 Environmental

3 Traffic
0 Geotechnical

This provides the ability to open a D&C database (.ddb) other than the default one.
=

In order to save the user from having to input all of these settings again the next time they
want to draw drainage objects in cross section the application provides icons across the top of the

dialog to save and retrieve these settings:
=/ dl %

e Open a settings file previously saved. A dialog will open asking for the file name to open. The
default folder will be the current design file folder.

e Sawe the current settings. If a settings file was opened during this session the same name will
be used. Otherwise, a dialog will open asking for the file name to save.

e Savwe the current settings to a different file name. A dialog will open asking for the file name
to save.

When the application starts it will automatically open the most recent settings file found in the current
design file folder. When the application is closed the user will be asked if they wish to save the settings
if they haven’t already done so. The file extension for DrawDrainageXs settings files will be .dxs.

Once all settings have been established and saved, the user will click the “Process Cross Sections”
button to begin drawing drainage objects in the cross sections. If the user isn’t in a design file
containing cross sections for the indicated chain they will be notified and asked to open the appropriate
cross section file before they can continue. If cross sections are found a process dialog will appear:

The user will have the option to pause as each cross section is processed so they can review what has
been drawn before continuing on to the next one. The Begin button will be clicked when the user is
ready to start processing the cross sections. If the Pause option is checked the first cross section will be
processed and centered in the view and the dialog will change as follows:

The user can continue to the next cross section or abort processing and return to the main dialog. If the
Pause option is not checked every cross section will be processed in order and the user will be notified
when it is complete.
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Draw Drainage Features in Cross Section

One final tool at the top-right corner of the main dialog allows the user to Move a Label once it has
been placed. This tool will prompt the user to select a label placed by this tool and enable them to
change its location as well as the configuration of its leader lines.
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Lab Exercise: Creating Drainage Cross Sections

LAB EXERCISE: CREATING DRAINAGE CROSS SECTIONS

>

>

VDOT GEOPAK Drainage

Create Pattern Lines for Drainage Cross Sections

1.
2.
3.

6.
7.

Open the MicroStation design file, ¢:\data\geo\VDOT\drain1\h17682work.dgn.
Open the Drainage Project file, c:\data\geo\VDOT\drain1\h17682.qgdf.

Open the Drainage Pattern Lines application by selecting the DDP icon located on the VDOT

Macro’s Task tool frame. (8" icon from Ieft side)

Job: | 101 =] Chain: | MAINLINE

Drainage Project:

|C:\daiﬁ\Geo\vdot\drain1‘\[11?682.gdf

[+ Pattern Lines for Cross-line Pipes
[+ Pattern Lines for Drainage Modes
[¥ Pattern Lines for Utilities

Pattern Line Offsets Tolerance: |10.5

Left: 200 Right: | 200

Draw Pattern Lines

Toggle on all three Pattern Lines options and set the symbology for the Draw Attributes as
shown.

Draw Atiributes ==

Level: |Level 50 j ﬂ
Color: .2
J ﬂ

Style: |D -

Weight: |2 -

Press the Draw Pattern Lines button.
Close the Draw Pattern Lines dialog when finished.

Create Existing Ground Cross Sections

1.
2.
3.

Open the MicroStation design file, c:\data\geo\VDOT\drain1\h17682xsmainline.dgn.
Open the Drainage Project file, c:\data\geo\VDOT\drain1\h17682.gdf.
Open Project Manager dialog. (Applications > GEOPAK > Road > Project Manager).
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Lab Exercise: Creating Drainage Cross Sections

Projects  Directory  Admin

ChdataGeo wdot \drain 1%
Fitter: | *.pr Type:

Projects: Directories:
17682 prj

[HECRAS]
[projdbs]
[standands]

[C]

(D]

Job Mumber: 101 Unit System: English

Description:

4. Select 17682.prj and press OK .
5. Select VDOT user and press OK .
6. Press the Existing Ground Cross Sections button.

File Remember Options
Working Directory:

Working Alignment Influence Runs
Working Alignment | Untitled

User: VDOT  Job #: 1071
[ Select ] [ Define ] [ Port Viewer ]

Existing
Ground

Existing Ground Existing Ground l
Eenfdi ‘ Cross Sections ‘ Profile

Coordinate
Geometry

Calculzte Superelevation Proposed
Superelevation Shapes Cross Sections

Horizontal
Alignment

Plan View Earthwork
Dlesign ‘

Plan View Tabular
Quartities Summaries

Plan & Profile Limits of Reports & XS5
Sheets Construction Quantities

7. Select the Run MAINLINE and press OK.
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Lab Exercise: Creating Drainage Cross Sections

VDOT GEOPAK Drainage

Run

MName Time

MAINLINE 11/06/2002 10:39:29
Untitled 11/06/2002 10:27:55

Description
Bxisting Ground Xsections for Chain MAINLINE

8. Verify that the dialog is filled out as shown.

File Edit WUpdate Options

Job Number: Chain: [MAINLINE
X5 Cells | Surfaces

Pattem

By DGN File hd

Design File: | h17682work dgn o}
[ Levels: 50 |
Colors: Line [ Line Sting

DP Crigin

Styles: | Match || Resst |

Weights: Display

Scale
Horizontal: | 10.00000 Horizontal: | 1000.000
Vertical: | 10.00000 Vertical: | 500.0000
Mumber of X5 by Column: | 20

Switch to the Surfaces Tab and verify that the dialog is filled out as shown.
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Lab Exercise: Creating Drainage Cross Sections

File Edit Update Options

Job Number: Chain: [MAINLINE ~| [ Drew

DP Origin

¥5 Cells I Surfaces

Type | Name Display Settings Method
TIN  survey tin EXGR Triangles

Details

sunvey tin Q
Method: Type:

Digplay Settings Fitter Tolerances

[ By Feature -| _ Horizontal: | 0.3000

Featurs: [EXGR | Variance: | 0.1000

Teat Settings

Elevation - void |

10. Press the Draw button.

11. Data point in the design file to plot the cross sections.

12. Close the Draw Cross Sections dialog and click Y ES to save the settings.
> Draw the Drainage Cross Sections

1. Open Draw Drainage Features in Cross Section application by selecting the DDX icon located
on the VDOT Macro’s Task tool frame. (9" icon from | eft).

o= d e 1] 4 e
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Lab Exercise: Creating Drainage Cross Sections

VDOT GEOPAK Drainage

4. Select the Cross-Line Pipes tab and set as shown.

Set the drainage project, Job, Chain, and Tolerance in the Draw Drainage Features in Cross
Section dialog.

]Side—Line Pipes ] Cross-Line Pipes ] Test Holes ]

Job: 101 | Chain: [MAINLINE

Drainage Project File:
|C :\data\Geo\wdotdrain 1%h 17682, gdf

Tolerance: |1

¥ Honor X5 Exaggeration

Process Cross Sections

Select the Side-Line Pipes tab and set as shown.

Move Label

General Side-line Pipes ]Cross-Line Pipes ] Test Holes ]

¥ Draw Through Pipes Symbology: H ﬂﬂ

¥ Draw Outside of Through Pipes Ling Style: | 0

Iv Draw Front Pipes Symbology: mﬂﬂ

I+ Draw Outside of Front Pipes Ling Style: | 0

Iv Draw Back Pipes Symbology: m ﬂﬂ

v Draw Outside of Back Pipes Ling Style: | 0

Side-Line Pipe Label Draw Symbalogy: ﬂ Q

Process Cross Sections

© 2011 Bentley Systems, Incorporated 8-29



Lab Exercise: Creating Drainage Cross Sections

General | Side-Line Pipes  Cross-Line Pipes | Test Holes |

|¥ Draw Cross-line Pipes  Symbology: H ﬂﬂ

¥ Draw Outside of Through Pipes Line Style: | 0

g E ﬂ Move Label
=

Cross-Line Pipe Label Draw Symbology: ﬂ ﬂ

[¥ Label the Ends of Cross-Line Pipes with FL Elevation and Station

Process Cross Sections

5. Select the Test Holes tab and set as shown.

g E ﬂ Move Label

General | Side-Line Pipes | Cross-Line Pipes  TestHoles l

Iv Draw Test Holes Symbology: = ﬂ Q

Test Hole Data File:
|C:‘ldaiﬁ‘|.Geo‘l,vdot\drain1‘h 17582.thd

Test Hole Label Draw Symbalogy: ﬂ Q

Process Cross Sections

6. Press Process Cross Sections button
7. Toggle on Pause on each Section and press Begin.

8. Press Continue to step through the sections.

|7 .
ErE Pause on each section .
Station: 201+856.00

9. Click Yes to create the log file when done.
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Drainage Summary

10. Close the Draw Drainage Features in Cross Section dialog.
11. Close the VBA Project Manager.
12. Exit MicroStation.

DRAINAGE SUMMARY

The Drainage Summary application reads a GEOP AK Drainage file, and populates the drainage
summary spreadsheet in Excel format.

Test Hole Name Prefix: |1H

Drainage Praoject File:

Create Summary

The user selects the GEOPAK Drainage file, and sets the Test Hole Prefix. The Test Hole Prefix
allows any drainage nodes or links that are created as a part of the Test Hole Utility application to be
excluded from the drainage summary.

Once the GEOPAK Drainage file is selected, and the test hole prefix is set, the user can press the
Create Summary button. This will read the GEOP AK Drainage file, and import the data to the
Drainage Summary spreadsheet.

Pipe Concrete Pipe EndSections End Wall Jlets - Length, Type, and [ Manholel
Elliptical/Arch EllipticalfArch [ ES-10r2 Es-3 DI-2 SERIES | DI-3 SEIRES

Height
ofDrop
Inlet

Structure Remarks

Cover
2 [ew-1: 36" Conc, Pipe
2 ew-2: 1.5:1 28" cane. pipe

15
[ u 57
T lssx 116
15
18
21
Tfaznw 2
18
{2820
o [a2w20
o(or3g Lag
[ [AERTS]

w|plor2a

31 4.25
32
3-1to3-2 48.78
EE]
33032 50.00
34 118.07

35 75.57
3-4t03-5 50.00
MH-1 1
35 4.25 1
MH-1to 3-6 43.87
36035 50.70
35to3-2 52.00

CUTLET 1
3-2 to OUTLET 16.00
37 4.25 1

27toMH-1 §2.52
Summary| 5000 | 50.70 | 43.87 | 111.77 | 52.00 | 16.00 50.00 1 1 1 79.57 | 118.07 | 12.75 1 2 1

LAB EXERCISE: DRAINAGE SUMMARY
Creating a Drainage Summary
1. Exit the Drainage Project (MS Menu: Drainage> Project>Exit)
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Lab Exercise: Drainage Summary

2. Open the Drainage Summary application by selecting the DS icon located on the VDOT
Macro’s Task tool frame. (2" icon from the Right)

] 9 1 e o ] s ] |

3. Set the drainage project in the Drainage Summary dialog.

Drainage Summary

Test Hole Name Prefix: ITH

Drainage Project File:
IC:‘lDaE‘lgeo‘l,vdot‘ydrainl‘h 17682, gdf

Drainage Summary

Test Hole Name Prefix: I'I'H

Drainage Project File:
IC:‘,Daiﬁ‘lgeo‘l,vdot‘ldrainl‘h 17582.qdf

—k Create Summary |

5. Enter the name 17682DrainageSummary.xls in the Microsoft Excel File dialog that opens
and click Save.

When the dialog “Done Writing Data to Spreadsheet.” appears, click the OK button.
Review the Excel spreadsheet that opens.

Close the spreadsheet when done.

Close the Drainage Summary dialog when done.

© © N o
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VDOT Drainage Descriptions

VDOT DRAINAGE DESCRIPTIONS

The Drainage Description application will import the nodes and links from a GEOPAK Drainage file,
and plots each item with a standard or user-defined description. The application allows the user to
modify the standard descriptions for each drainage item, as well as arrange the drainage items into
sheet categories to match the plan sheets.

= E Drainage Project File: |

Test Hole Prefoc: [ TH

Import Drainage Data

4
L
ink/Mode
2 |

From Mode To Node

Sheet Mo,
-

Description

Plot Drainage Descriptions Modify Drainage Item

The user must first import the Drainage Project File by selecting the file and pressing the Import
Drainage Data button. The drainage nodes and links will be placed in tree on the left side of the
dialog. If any items are added to the drainage file, the file can be re-imported. Only the new items will
be added to the drainage item list.

If there are test hole nodes or links present in the drainage project, they can be filtered out by
specifying the Test Hole Prefix used to create the test hole data.

When the user selects a drainage item, the information for that item will be displayed in the fields to
the right. The user can then key-in or select the sheet number. The selection option is only available
after the user has created the sheet by either keying in the sheet number, or using the new sheet dialog
(see below). The user can also adjust the description by editing or typing a new description in the
Description field. Once the sheet and/or description changes have been made, the Modify Drainage
Item button must be pressed to save the changes. Once the changes are made, the drainage item will
be moved into the given sheet in the tree view.

Drainage items can also be arranged into sheets using the tree view. Once the sheet has been created,
drag the drainage items into the desired sheet. The order of the sheets or drainage items can also be
changed by dragging the item to the desired location. The item being moved will be placed after the
selected item.

In addition to keying-in or selecting a sheet number by editing the drainage items, new sheets can also

be created by using the Add New Sheet button al. The Add New Sheet button opens a dialog for the
user to enter a new sheet number. This creates a new sheet in the tree, and allows drainage items to be
placed in the sheet.
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VDOT Drainage Descriptions

8-34

Add New Sheet Number (o S

Enter New Sheet Number: |

oK ‘ Cancel ‘

The Delete button X/ will delete the selected item. If the item is a sheet, the user is prompted to
confirm the deletion of all elements in the sheet. The Delete All %! button will delete all entries.

Once the drainage items and sheets are set, the descriptions can be plotted into the active .dgn file by
pressing the Plot Drainage Descriptions button. This will delete any existing sheets in the .dgn file,
and plot the new description sheets into the .dgn file.

Fe

|

|

|

| Dml [y
| - [
' s
| = St
| @ P
| o 2
| T =
| D @
| Dg =
' )
| [

(- =
| @ o
|u:: el e
|ﬁii = =
|EEEEE Pt wto) L]
| [t =
| o =
| o)

| )
| = =
| = o
|

|

| T = T
- N

The user has the opportunity to save the dialog settings into a settings file. When the Drainage
Descriptions application is opened, it will search the current directory for the settings file. If a settings
file is found, the dialog will be populated with the information from the latest settings file it finds. If
the user desires another settings file to be used, they can use the Open Settings File on the dialog to
search for another settings file. Also available on the dialog are a Save Settings and Save Settings to
Another File option. The user will also be prompted when closing the dialog to save the settings file.
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Lab Exercise: Drainage Descriptions

LAB EXERCISE: DRAINAGE DESCRIPTIONS
Importing the Drainage Data

1. Open the MicroStation file, c:\data\geo\VDOT\drain1\h17682DrainageDescriptions.dgn.

2. Open the Drainage Descriptions application by selecting the DD icon located on the VDOT
Macro’s Task tool frame. (3 icon from the Right)

g 2] 5 e o ] oo s o] |

3. Set the drainage project in the Drainage Descriptions dialog.

Drainage Descriptions

@l El Drainage Project File: IC:\Dab‘geo\vdot\drainl%1?682.ng
Test Hole Prefi:: |'|'H

Import Drainage Data
Al
X
| —I Link/Mode MName
| r r

4. Click on the Import Drainage Data button to populate the drainage item list.

Iir'"l El Drainage Project File: [C:\Datalgeo\vdot\drain1\h17682.gdf q
Test Hole Prefi:: ITH

Import Drainage Data I‘i
Al

il Link/Mode

i r r

MName

Arranging the Elementsinto Sheets by Selecting Sheet Number
1. Inthe element list, select the node 3-10.
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Lab Exercise: Drainage Descriptions

Drainage Descriptions

ﬁl El %l Drainage Project File: IC:\Daiﬁ\geo\vdot\drainl\h1?682.ng
Test Hole Prefic: ITH

< pipe-2
" pipe-3
" pipe4
< pipe-5
/" pipe6
< pipe-7
o 31
Jaf 32
& 33
it 34
A 35
o 36
it 37
| ouT

Flot Drainage Descriptions

2. Inthe Sheet N

o. field, enter 1.

Drainage Descriptions

@l El %l Drainage Project File: IC:\Daiﬁ\geo\vdot\drainlﬁ1?682.gdf
Test Hole Prefic: ITH

Impart Drainage Data |

Link/Mode

I Node I 3-10

To Node

From Node

I NJA

I N/A
Sheet Mo,

I jv

Description

15TD. DI-38 REQ'D.
L=10', H=2013.34 Inv. 0
St'd, IS-1Reqg'd.

Modify Drainage Item

/ pipe-2
/ pipe-3
/ pipe-4
/" pipe-5

JA Cutlet

Plot Drainage Descriptions

=
|

%

3. Click the Modify Drainage Item button.

8-36
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Import Drainage Data

Link/Mode Mame

I Node I 310

From Mode To Nede

I M/A I N/A

Sheet No.

[T——

Description

15TD. DI-3B REQD.
L=10', H=2019.34 Inv. 0
St'd, IS-1Reqg'd.

Modify Drainage Item
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Lab Exercise: Drainage Descriptions

VDOT GEOPAK Drainage

| 311
| 312
& 313
| 314
i 3-15
| 3-15
JH Cutlet

Plot Drainage Descriptions

Drainage Descripticns

Description
15TD. DI-3B REQ'D.
L=10', H=2019.34 Inv. 0
St'd. IS-1Reqg'd.

Modify Drainage Ttem |‘_

4. Notice the sheet that was added to the list, and node 3-10 was placed under the sheet.

#l El %l Drainage Project File: IC:‘DaE\geo‘l.vdot\drainl\.l‘l1?682.gdf
Test Hole Prefoc ITH

O Sheet 1 f———

& 3-10

Plot Drainage Descriptions

5. Select node 3-11 from the element list.
6. Use the pull down in the Sheet No. field to select sheet 1.

© 2011 Bentley Systems, Incorporated

Import Drainage Data |

LinkMode Mame
I Node I 3-10

To Mode
I /A

From MNode

I N/A

Sheet Nao.
I 1 vl

Description
15TD, DI-38 REQD.
L=10", H=2019.34 Inv. O
St'd, IS-1Req'd.

Modify Drainage Item




Lab Exercise: Drainage Descriptions

8-38

10.

Drainage Descripticns

ﬁ;l El %l Drainage Project File: IC:Wam\geo\vdot\drain1‘!)11?682.ng
Test Hole Prefic ITH

< pipe-3

A Cutlet
01 Sheet1
E & 3-10

Flot Drainage Descriptions

Click the Modify Drainage Item button.
Select link P100 from the element list.
Set the Sheet No. to sheet 1.

Import Drainage Data |

Link/Mode Mame

I Node I 311

From Mode To Mode

I NJA I NfA

Sheet No.

Description

15TD. DI-3C REQD.
L=6', H=2019.78' Inv. 0
St'd. IS-1Req'd.

Modify Drainage Item

In the first line of the Description field, change the ** to 3.

© 2011 Bentley Systems, Incorporated
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Lab Exercise: Drainage Descriptions

VDOT GEOPAK Drainage

Drainage Descriptions

@l El %l Drainage Project File: IC:\Daiﬁ\geo\vdct\drainlW1?682.ng
Test Hole Prefic: ITH

/ P100
S Pl01
S P02
S P03
/P04
# P105
/ P106
# pipe-1
# pipe-2

Plot Drainage Descriptions

11. Click the Modify Drainage Item button.

12. Select node 3-10.
13. Drag node 3-10 and drop it on Sheet 1.

Plot Drainage Descriptions

14. Notice the order of the elements is rearranged.

© 2011 Bentley Systems, Incorporated

al
|
%

Import Drainage Data |

Link/Mode
I Link

Mame
I P100

To Node
I 3-11

Fram Node
I 3-10

Sheet Mo.
I 1 vI

Descriptiol

52- (3 Cover)
Inv.(In) 2016.81 Inv.(Out) 2016.56

Modify Drainage Item |

SIS N,
I 1 vl

Description
15TD. DI-3B REQD.
L=10", H=2019.34 Inv. 0
St'd. IS-1Req'd.

Modify Drainage Item




Lab Exercise: Drainage Descriptions

Plot Drainage Descriptions

15. Repeat for node 3-11, but drop it on node 3-10. The element order should be as shown in the
picture below.
& 3-16

0 Sheet 1
@ 310
il

-/ P100

Plot Drainage Descriptions

Arranging the Elementsinto Sheets by Drag and Drop
1. Click on the Add New Sheet icon.

Drainage Descriptis
@l El %l Drainage Project File: [c:\Data\geo\vdot\drain1\h17682.odf &l
Test Hole Prefa |'|'H
/ pipe-4 - _
/ pipe-5 Import Drainage Data
/ pipes a2
7 pipe-7 x|
 3-1 Link/Mode Name
ﬁij % I Node I 311
34
jg 3-5 H From Mode To Node
i | nia | nia

2. Enter 2in the Add New Sheet Number dialog.

Enter Mew Sheet Mumber: I 2

oK Cancel |

3. Click the OK button.
4. Dragnode 3-1 and drop it on Shest 2.
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Lab Exercise: Drainage Descriptions

VDOT GEOPAK Drainage

& 316
JH Outlet
1 Sheet1
b @ 3410
A 311
. A pann

m

Plot Drainage Descriptions

5. Drag node 3-2 and drop it on node 3-1.

@ Sheet1
! @ 310
A 311
— / P100

1|

Plot Drainage Descriptions

Creating the Drainage Description Sheets

1. Using one of the methods outlined above, arrange the nodes and links into the sheets in the
following order.

Sheet 1

3-10
3-11
P100
3-12
P101
3-13
3-14
P102
P105
3-16
3-15
P103
P104
ouT
P106

© 2011 Bentley Systems, Incorporated
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Lab Exercise: Drainage Descriptions

Sheet 2
3-1
3-2
pipe-1
3-3
pipe-2
3-4
3-5
pipe-3
pipe-6
3-7
3-6
pipe-4
pipe-5
Outlet
pipe-7

2. Save the data by clicking on the Save Data icon. Use a file name of
17682Dr ainageDescriptions.ddd.

3. Click on the Plot Drainage Descriptions button.

Drainage Descriptions - C:\Data\geo'\vdot\drain1\176820rainageDescriptions.ddd

@l El %l Drainage Project File: IC:Wam\geo\vdot\drainlw1?'682.gdf
Test Hole Prefic ITH

[ Sheet 1 -
Import Drainage Data

Link/MNode Mame

From Node To Node

Sheet No.
I 1 vl

Description

Plat Drainage Descriptions I*_ Modify Drainage Item

4. Review the Drainage Description sheet that was plotted.
5. Close the Drainage Descriptions dialog.
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9 Culvert Design

OBJECTIVES

The objective of this chapter is to review culvert placement and design.

INTRODUCTION

GEOPAK Culvert is a powerful tool for the design and analysis of culvert structures. Located within
GEOPAK Drainage, the Culvert tool can leverage data from a coordinate geometry database (GPK), a
site database file (GSF), the drainage database file (GDF) or a binary TIN file. This enables the user to
utilize roadway and / or storm sewer data, both existing and proposed.

INVOKING THE CULVERT TOOL

The Culvert tool can be accessed by selecting Component > Culvert from the main Drainage menu.

Previously stored culverts are displayed in the list box for easy selection and modification. Six tools
are supported (from left to right):

TooL DESCRIPTION
Add Culvert invokes the add culvert dialog.
Name: [ Cubvert]]
Deseriptions |
[ ok | Cancel |
Modify Culvert invokes the culvert dialog populated with data for the specified culvert in the list box.
Identify Culvert when click and a previously stored culvert is selected on the screen, the culvert is displayed in
the list box.

Delete Culvert deletes the culvert in the list box.

Note Note. A prerequisite to storing culverts is a headwall must be stored within the Node options

in the specified Drainage Library.

The Culvert dialog is used for adding, editing, or deleting Culverts.
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Invoking the Culvert Tool

9-2

E[Zulvert M= 3
Culvert 1D: 4 [Culvert] -] » —
: LA a4 =] Aprly|
Description;: |
~ Detailz
[EolvertBratie I Overtopping I Computations
Parameters ] Caonfiguration I Headwall Location
 Discharge r— Tailwater
User Supplied vI Uszer Supplied vI
Design  Discharge | T ailwater Elewvation
| |
X X
|D.DDD |D.DDD

The dialog consists of three fields at the top, and six tabs. The fields at the top remain regardless of
which tab is selected. As each tab is selected, the dialog changes dynamically to reflect the selected
tab. Only the culvert ID and description are constant while manipulating tabs.

TAB

DESCRIPTION

Parameters

Defines the design Dischargeand Tailwater as well as the
Discharges and Tailwater to be used for analysis.

Configuration

Defines the properties of the culvert including the culvert shape,
material, size, number of barrels, roughness coefficients, and
entrance type.

Headwall Location

Defines the location and reference information for the culvert

Overtopping

Defines parameters used in the calculation of overtopping flow.

Computations

Provides for any combination of culvert, tailwater, and/or
overtopping calculations and allows for output to an ASCII file.

Culvert Profile

Not available in the current version.

The minimum requirements for storing a culvert are completion of the front three tabs: Parameters,
Headwall Locations, and Configurations.

© 2011 Bentley Systems, Incorporated
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Lab Exercise: Culvert Design

LAB EXERCISE: CULVERT DESIGN
> Add a Culvert in Plan View and Set Parameters

1. Open the MicroStation file c:\data\geo\vdot\drain1\h17682.dgn and drainage project
c:\data\geo\wdot\drain1\h17682.gdf.

2. Select the Culvert tool (Drainage: Component > Culvert>Add).

3. Enter the Name as Culvert 1.
4. Click OK.

Culvert ID: 4 4

Description:
Details
| Culvert Profile Qvertopping Computations
| Parameters Configuration Headwall Location

Discharge Tailwater

User Supplied + Compute - Bwtract Crozs Section

Design  Discharge Slope %: | 4.000 N Value: | 0.040

X 75.000 Adjust Tailwater Depth: | 0.000
120.000

Distance Blewvation -

0.000 2009.255 El]
2671 2008.966

3538 2008.891 7

0.000 0.000

6. Enter the culvert discharges.

Set to User Supplied.
Discharge: Enter 75 and click Add List Item.
Keyin 120 and click Add List Item.

Design Discharge: Double click in the design column next to the 75 .

7. Define the Tailwater:
Slope: 4.0%
N Value: 0.040

8. Click Extract Cross Section.
9. Setto DrapeElement on Mode/TIN and set to TIN File.
10. Click Filesand select survey.tin.
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Lab Exercise: Culvert Design

|OK

Section | Symbaology

[ Drape Blement on Model / TIN =] [TIN File = | | surveytin
| Select Element | | Flace Element |

Extracted Profile
Profile 1D:  Culvert 1 Description:

Horiz. Scale: | 10.000
Vert. Scale: | 1.000
Max. Blevation: | 2013.174
Min. Elevation: | 2006.952
Maxx. Station: 24252
Min. Station: 0.000

Flace Profile

11. Click Place Element to locate the postion of the tailwater profile to extract.

12. Place aline in a location similar to that shown below:

The Define Culvert Tailwater Cross Section dialog now contains the profile along the element

placed representing the channel cross section at this location.
13. Click OK

14. The main Culvert dialog opens again and the coordinates of the profile are populated.

Note The Distance and Elevation table will vary depending on where the cross section was

extracted.
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Lab Exercise: Culvert Design

» Define Culvert Type

1. Click Configuration tab.

Culvert ID: 4 4

Description:
Details

E =

| Culvert Profile

Qvertopping Computations

| Parameters

Entrance Type

Configuration

Shape:

Headwall Location

Material:

Culvert Size

[Library kem ]

[18 Inch Dia. Concrete Pipe

=

Roughness:
Entrance Ke: 0.500

- Gl T |

Number of Bamrels:
0.013

2. Enter the parameters which define the culvert type.
Shape: Circular
Material: Concrete
Library Item: 18 inch Dia. Circular
Roughness 0.013
Entrance Type: Headwall Square Edge

» Define Headwall Locations

We need to define the location of the upstream and downstream headwalls (nodes).

1.

Culvert ID: 4 4

Description:
Detailz

Click Headwall L ocation tab.

v ¢+ % B0

| Culvert Profile

Crwvertopping Computations |

| Parameters

[TIN File

)

MAINLINE
Node ID:  Culvert 1-UP
Library ltem:
[Tangent to Ref. Chain #
Chain Sta.: | 206+72.00 [ Mirror Cel
Offset: | 55.000 + Angle: | 50.000
Invert Elev : 2017.352

Type: [Plan View -|
Upstream Headwall

Reference Chain:

)

Configuration

Headwall Location |

Create Profile

-

proposed tin Q
Downstream Headwall
Reference Chain: |MAINLINE

Mode ID:  Culvert 1-DN
Librany tem:
[ Tangent to Ref. Chain #
Chain Sta.: | 206=72.00 [ Mimor Cell
Offset: | -60.000 + Angle: | 270.000
Invert Elev : 2016.977

)

[ Cynamic: Place ] Fevi

[ Dynamic Place ] [ Keyin Place

2.

VDOT GEOPAK Drainage

© 2011 Bentley Systems, Incorporated

Enter the headwall information.

9-5



Lab Exercise: Culvert Design

Type: Plan View
Reference Chain: Mainline
TIN File: Survey.tin

Next we need to locate the Upstream Node.

3. Click Dynamic Place in the Upstream Headwell section and set the upstream node at a
location near the station /offset location.

Next we need to locate the Downstream Node.

4. Click Dynamic Place under the Downstream Node group and set the downstream node at a
location near the station /offset location.

5. Set both Upstream and Downstream Invert Elev to TIN/Model.
This extracts the elevations at the headwall locations with information from the TIN file.
» Draw Culvert and Check Computations
Once the Nodes have been located and the elevations set, the Culvert can be added to the project.

1. Click Apply.

The culvert is drawn and labeled according to the symbology in the Preferences and labeled.
—— @;J N,

Culvert ID: 4 4

Description:

Detailz
| Parameters Corfiguration Headwall Location
| Culvert Profile Crwvertopping Computations

Circular

Concrete

18 Inch Dia. Concrete Pipe
Rize = 1.500

Humber Of Berrels = 1
Length = 115.000

Slope = 0.004

S
Compute Culvert Output to ASCII: Create - Wiew...
Citheet | Tailwater
|| Owvertopping Culvert 1.out

3. Inthe Output section, toggle on Culvert and Tailwater to view the Culvert calculations.
4. Click Compute Culvert to perform the calculations.
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Lab Exercise: Culvert Design

> Cul

vert Adjustment in Profile View

1. Click Headwall L ocation tab.
2. Click Filesand select Proposed.tin.

This is a proposed DTM file created by the Roadway Designers, which incorporates the
existing ground data plus the designed cross sections of the project.

Culvert ID: 4 > v + % FE

Description:

Detailz
| Culvert Profile Crwvertopping Computations |

| Parameters " Configuration Headwall Location |

VDOT GEOPAK Drainage

Type: [Plan View  ~] [TINFle =] | proposedtin Q, Create Profile

Upstream Headwall Downstream Headwall
Reference Chain: |MAINLINE A Reference Chain: |MAINLINE A

Node ID:  Culvert 1-UP Mode ID:  Culvert 1-DN
Lbray hem: = R ——- =]
(Tangentto Ref. Chain__v] # [Tangentto Ref. Chain__v] #F
Chain Sta.: | 206+72.00 Mirror Cell Chain Sta.: | 206+72.00 Mirror Cell
| Offget: | 55.000 + Angle: | 50.000 | Offget: | -60.000 + Angle: | 270.000
Invert Blev.: (TIN/Model ] 2017.392 Invert Elev.: (TIN/Model »] 2016977
| Dynamic Place | | Keyin Place | | Dynamic Place | | Keyin Place

3. Click Create Profile.

| oK | |Cance| |

Section | Symbaology

[ Drape Blement on Model / TIN =] [TIN File = | | proposed tin Q

Select Blement Flace Element
Extracted Profile

Profile 1D:  Culvert 1 Description:
Heriz. Scale: | 10.000

Vert. Scale: | 1.000
Mzx¢. Blevation: | 2025.000
Min. Elevation: | 2010.000

Maxx. Station:  135.000

Min. Station: 0.000

Flace Profile

Adjust the profile station, elevation and symbology.
5. Click PlaceProfile and data point to place the profile in the design file.
6. Click OK.

7. Change the Typeto Profile View and click OK at the prompt.
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Lab Exercise: Culvert Design

Culvert ID: 4 4

Description:
Detailz

v ¢+ % @O

| Culvert Profile " Crwvertopping Computations

Configuration
[TINFile =]

| Parameters "

Type: (Profile View +|
Upstream Headwall
Reference Chain: |MAINLINE A

Node ID:  Culvert 1-UP m

Library tem: |ES18-1 -
180.000

Drape Angle: 388181 =+ Angle:

RS

Headwall Location
proposed tin Q

Create Profile
Downstream Headwall

Reference Chain: |MAINLINE A

Mode 1D:  Culvert 1-DN m

Library tem: |[ES518-1 -
360.000

Drape Angle: 38.83181  + Angle:

125.000 é

2016.977

206+72.00
-60.000

[ Invert Sta.:
[ Invert Blev.:

Chain Sta.:
Chain Offset:

10.000
2017392

206+72.00
55.000

[ Invert Sta.:
[ Invert Blev.:

Chain Sta.:
Chain Cffzet:

8. Click Station DP (to the right of Invert Sta and Elev) to adjust the location of the upstream

and downstream headwall. The location of the headwall could be done dynamically by
moving your cursor close to the circle marking the inverts of the culvert in profile view.

9. Click Updateto reset the location of the culvert in profile and plan view.

2823

zozz

2021 7

2az0 =

LY
2019

2015

n x
e
207

LY
2006

s owtvent-tyF i
Nade VD douf

It] 28 38 48 58 &2 7a Er] £ 120 s

2015

2014

2013

120 128

-ON

10. Click Computations tab and update the calculations.
11. Exit MicroStation.
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10 VDOT Bentley Community Group

OBJECTIVES
To become a member of the Virginia DOT and Consultants BE Community. This will be where you
can post support questions and issues regarding GEOPAK Drainage.

INTRODUCTION

We created Be Communities to be the premiere destination for the world’s infrastructure communities
to come together to connect, communicate, and learn from each other. Be Communities provides you
with a wide range of tools for sharing information through forums, blogs, wikis, and files areas within
each community.

Solutions — Share best practices, ideas, and content with other infrastructure professionals.

Products — For Bentley product-related questions, TechNotes, FAQs, Technical Bulletins, and more.
You can jump straight to a specific product area from the Product Community Mappings.

Be Programs - Find news, technical information, training, and other resources related to Bentley-
empowered programs for infrastructure professionals, educators, and students.

Check out forum topics, blog and wiki articles, as well as various user communities, and much more.
For information on getting started with Be Communities, take a look in the Help community.

If you are not a Be Communities member, joining is easy and takes very little time. Join now,
then Sign In and take advantage of all that Be Communities has to offer!

Be Communities

F'-’j Virginia DOT and Consultants
5”‘.. :'. a |||.! hi H 1

LAB EXERCISE: JOIN THE BE COMMUNITY
1. Open the following web site: http://communities.bentley.com/
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http://communities.bentley.com/solutions/default.aspx�
http://communities.bentley.com/products/default.aspx�
http://communities.bentley.com/help/w/Be_Communities_Help/bentley-product-to-be-communities-product-group-mappings.aspx�
http://communities.bentley.com/programs/default.aspx�
http://communities.bentley.com/f�
http://communities.bentley.com/b�
http://communities.bentley.com/w�
http://communities.bentley.com/communities/default.aspx�
http://communities.bentley.com/help/default.aspx�
http://communities.bentley.com/user/CreateUser.aspx?ReturnUrl=�
http://communities.bentley.com/login.aspx�
http://communities.bentley.com/�

Lab Exercise: Join the BE Community

Be Communities

New Io Be Communities?
JOIN NOW

The Global Network for

Already o Member? SIGN IN

‘What is Be Communities?

HexUnits
Haaet™

®in Road and Ses Design Fonum

N replind b Strangs et mming n McoSzation Visualzalon Community Fomem

mage in Geospatial Deskop Forum

valbd ArQUAERT paSS0a b dmaag Rancsian in Prajectiviss Pragramming - Fanim

2. Click on JOIN NOW
3. Fill'in the information as required.

Be Communities

Sign 1 =ame and wmal {iequred

R only takes 2 Tew minales 1o [, PLeass B in e infarmaBien Beisw 1o creats your sccount

Sign in pame:
Your Hame

Email Address:
Your Emad Address

Re-enter Emad Address:
Your Emad Address

Timi Tona:

(UTC-05 00) Eastem Time (US[=]

She Terms:
| accept he services agreement
o 4
epistemic.
Retress

Entar M8 words above

4, Click Join Now.

> Join the Virginia DOT and Consultants Group

1. Once you Sign In you can go to the Communities Tab under the web site:
http://comnunities.bentley.conv and select Virginia DOT and Consultants.
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http://communities.bentley.com/�

Lab Exercise: Join the BE Community

Be Communities

3 3 gek in Road and Ste Design Forum

out forun

2. Inthe Upper right of the web page select Join Community.

gk Join Community
ig¢ Add Community to Favorites

oy Getthis RSS feed

3. You are now a member of the Virginia DOT and Consultants Group.
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Lab Exercise: Join the BE Community
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1 1 Class Project

OBJECTIVES
Using the Data Provided:
o Create and design a storm sewer system with GEOPAK Drainage.

o Create a Profile of the storm sewer system.
o Create Storm Tabulation and Spread Analysis for the storm sewer system.

INTRODUCTION

You are starting a project and need to do the first pass design with GEOPAK Drainage. You have
been provided a basic set of files from the location and design group to get started.

You are required at this stage to provide a profile of the system for review. You are also required to
submit a Storm Tabulation sheet and a Spread Analysis sheet.

PROJECT FILES

There are several files that have been provided. They are located on the computer hard drive. The
files provided include the proposed design of the roadway, the proposed design terrain model, the
existing survey and utility design files, the coordinate geometry database with alignments and profiles
of the design, and the GEOP AK project manager file.

You have also been provided a blank GEOPAK Drainage file with all the necessary project
preferences set up.

The files are all located in the following folder:

C:\data\geo\vdot\drainl - end of class project\

The files included in the folder are:
1. d93144des.dgn — roadway design file
2. d93144work.dgn — superelevation shapes and pattern lines
3. d93144xspacific.dgn — proposed cross section file
4. d93144prop.tin —- GEOPAK surface file
5. job101.gpk — GEOPAK coordinate geometry database
a. Alignment - Pacific
6. $93144.dgn — existing survey file
7. su93144 — existing utility file
8. h93144.dgn - blank file for hydraulic design
a. Rainfall Preferences — Loudon County
9. h93144.gdf — blank GEOPAK Drainage file for hydraulic design
10. h93144da.gdf — defined drainage areas for use on this project
11. 93144.prj — GEOPAK Project Manager file

VDOT GEOPAK Drainage © 2011 Bentley Systems, Incorporated 111



Project Completion

There are a few other files as well that may assist you in the layout and design of your project. All
standard files specific to VDOT design and needed by the software should be automatically accessed
through your VDOT workspace.

PROJECT COMPLETION

Your project is considered complete when you show the instructor a profile of your system along with
a storm tabulation and spread analysis.
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12 Technical Reference

OBJECTIVES

o The objective of this chapter is to review the computation methods utilized by GEOPAK
Drainage.

THE RATIONAL METHOD

The Rational method is the most widely used formula to calculate storm water runoff. VDOT
recommends the use of that for pipe sizing, inlet capacity and spread computations.

This method uses certain assumptions that make their use only suitable for areas of less than 200 acres.
These assumptions are:
e The entire drainage area contributes to the discharge

e Rainfall intensity, measured in inches per hour, is distributed evenly in the whole drainage
area.

¢ Rainfall intensity is at a constant rate along the entire duration of the storm. The storm
duration is at least equal to the time of concentration.

e  Frequency of the computed flow is of the same frequency as that of the rainfall intensity. A 5
year rainfall intensity is set to produce a 5 year peak flow or discharge.

o Coefficient of runoff is the same for all storms and probabilities of recurrence.
The rational formula is given as:
Q=CIA
Q
C
I

computed peak discharge in cubic feet per second (cfs)

runoff coefficient (non dimensional value)

intensity of storm in inches/hr.
A =drainage area in acres

The formula is not dimensionally correct as it is a result of empirical studies.
Let’s analyze in detail each component of the formula.

RUNOFF COEFFICIENT (C)

The runoff coefficient is a function of the ground cover and other hydrological abstractions.

This is a dimensionless number that represents the fraction of rainfall that remains on the surface of the
ground.

The runoff coefficient relates the estimated peak discharge to a theoretical maximum of 100 percent of
runoff.

VDOT provides a table of runoff coefficients that depends on the slope of the terrain being analyzed
and the use of it.
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THE RATI ONAL METHOD

INTENSITY (1)

12-2

In more practical terms we can summarize that for storm drain projects, we can divide our drainage
area into pervious and impervious areas.

We can conclude that a pervious area is the one with a ¢ value equal or less than 0.5. A typical
pervious area could be woodlands, grassy terrain or residential areas. Then we can also say that an
impervious area is the one with a ¢ value greater than 0.5. Pavement areas or heavy commercial and
industrial lots are a good representation of this type of drainage area.

Therefore, we can say that for storm drain projects the following assumption is valid:
C =0.95 for pavement areas
C = 0.50 for grassy areas

In a drainage area, multiple types of surfaces could be present with different runoff coefficients. Then,
a weighted runoff coefficient should be determined. The weighting is based on the area of each land
and is found by the following formula:

D>CA

-5,

C

Intensity is usually represented at the rate of rainfall in inches over an hour period. Intensity
computations in GEOPAK Drainage are based on one of several options for defining the Intensity-
Duration-Frequency (IDF) relationship.

The selection of the intensity over a drainage area depends of the frequency of the storm to be analyzed
and their duration, than in general we equal to the time of concentration of the area.

The intensity over a drainage area is calculated or extracted from widely develop I-D-F (intensity-
duration-frequency) curves. VDOT also provides mathematical functions for each of the curves so they
can be implemented in computer programs. GEOPAK Drainage uses a four parameter intensity curve
with the time of concentration in logarithmic format to represent the intensity rainfall in Virginia.

| =a+bln(tc) +cIn(tc) +d In(tc)®
I = rainfall intensity for frequency (inch/hr)

n = time of concentration (min)

a,b,c,d = empirical factors which are input for each frequency.

;| Description: | Rational Data Type: [Eguation
Equation Selection iza/b+Tc)c
Uzer Defined:

Frequency a b C
2.0000 58.3000 122500 0.8600

@ i=flabec.Tc)
1 i =flab.c Frequency.Tc)

) i=flab.edin(Tc) 5.0000 56.4600 11.5000 0.8000
100000 452500 52500 0.7200
250000 420300 82500 06700
50.0000 343300 6.0000 0.5500

0.00 0.0000 || 0.0000 | 0.0000

VDOT has also published I-D-F curves covering the State of Virginia for different frequencies under
different rainfall zones.

In order to find the intensity for drainage area, we have to do the following.
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THE RATI ONAL METHOD

1.- Localize our project inside one of the zones VDOT has divided the State.
2.- Select the proper 1-D-F curve according to the selected zone.

3.- Enter the chart using the time of concentration as the storm duration and intersect the proper
frequency curve.

4.- At the point of intersection, read the rainfall intensity in inches per hour.

TIME OF CONCENTRATION (TC)

Time of concentration is defined as the time required for a drop of rainfall to travel from the most
remote point of a watershed to the point of analysis. GEOPAK Drainage time of concentration
calculations are derived from FHWA HEC-22.

VDOT recommends a minimum time of concentration equal to 5 minutes despite a lower calculated
time.

To calculate time of concentration, we have to recognize the different types of flow that occur inside
the drainage basin and along the flow path. These are sheet flow, shallow concentrated flow and open
channel or pipe flow. For each type of flow a myriad of formulas could be used; each one of them
using their own assumptions. FHWA in their “Urban Drainage Design Manual” cites the following
formulae for each types of flow.

Sheet Flow Travel Time: it is the starting type of flow in a drainage basin in which runoff has a
uniform depth along a sloping surface. We can say that the limit is the first 400 ft. The formula is a
version of the kinematic wave equation.

K, (nL)"™
Toheat = e\ 7

T = sheet flow travel time (minutes)
n = Manning’s roughness coefficient of the watershed.
L = flow length (ft)

I = rainfall intensity (inches/hr)
S = surface slope (ft/ft)

Ky, = empirical coefficient equal to 0.933

M anning's Roughness Coefficient (n) for Overland Sheet Flow

Surface Description n
Smooth Asphalt 0.011
Smooth Concrete 0.012
Ordinary concrete lining 0.013
Good wood 0.014
Brick with cement mortar 0.014
Vitrified clay 0.015
Cast iron 0.015
Corrugated metal pipe 0.024
Cement rubble surface 0.024
Fallow (no residue) 0.05
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THE RATI ONAL METHOD

12-4

Cultivated soils:
Residue cover < 20%
Residue cover > 20%

Range (natural)
Short grass prairie

Dense grasses

Bermuda grass

Woods (when selecting n, consider cover to a
height of about 30 mm. This is the only part of the
plant cover that will obstruct sheet flow.

Light underbrush

Dense underbrush

0.06

0.17

0.13
0.15

0.24

0.41

0.40

0.80

This is an iterative process since the intensity depends on the time of concentration. Therefore, the
assumed time of concentration must be the same as the calculated one in order to stop the iterative

process.

Shallow Concentrated Flow Travel Time: Up to a distance of 400 ft, sheet flow tends to
concentrated in rills and then gullies of increasing proportions. First, we need to calculate the velocity

in order to estimate the travel time.
V =K, kS

V = velocity (ft/s)
K, = coefficient of 3.28
= intercept coefficient.

S = slopein percentage
I nter cept Coefficients for Velocity vs. Slope Relationship

Land cover / Flow regime
Forest with heavy ground litter; hay meadow (overland
flow)
Trash fallow or minimum tillage cultivation; contour or strip
cropped; woodland (overland flow).
Short grass pasture (overland flow)
Cultivated straight row (overland flow).
Nearly bare and untilled (overland flow) alluvial fans in

© 2011 Bentley Systems, Incorporated
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0.152
0.213

0.274
0.305
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THE RATI ONAL METHOD

western mountain regions

Grassed waterway (shallow concentrated flow). 0.457
Unpaved (shallow concentrated flow.) 0.491
Paved area (shallow concentrated flow); small upland 0.619
gullies

Open Channe and PipeFlow Travel Time: It is the flow collected in channel and pipes. The
Manning’s equation can be used to estimate the average flow velocities in pipes and open channels.

149
n

V R2/380.5

V = velocity (ft/s)

n = Manning’s runoff coefficient

R = hydraulic radius (flow area divided by the wetted perimeter)
S = slope (ft/ft)

Then the travel time could be calculated as:

Tchannel = 60_V

Values of M anning Coefficient (n) for Channels and Pipes:

Conduit Material Manning n
Closed Conduits:
Asbestos — cement pipe 0.011-0.015
Brick 0.013-0.017
Cast Iron pipe
Cement-lined & seal coat 0.011-0.015
Concrete (monolithic) 0.012-0.014
Corrugated-metal pipe (1/2 in x 2 % in corrugations)
Plain 0.022-0.026
Paved Invert 0.018-0.022
Spun Asphalt Lined 0.011-0.015
Plastic pipe (smooth) 0.011-0.015
Vitrified Clay:
Pipes 0.011-0.015
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THE RATI ONAL METHOD

Liner Plates
Open Channels
Lined Channels:

A. Asphalt

B. Brick

C. Concrete

D. Rubble or riprap

E. Vegetal
Excavated or dredged

Earth, straight, and uniform

Earth, winding, fairly uniform

Rock

Not maintained

Natural channels (minor streams, top width at flood
stage < 100 ft.

Fairly regular section

Irregular section with pools

Then, the total time of concentration for a watershed will be:

T

concentration

= Tsheet + Tshallow

STORM FREQUENCY

Frequency can be defined as the return period of a specific storm or their exceedance probability.

12-6

Exceedance probability is the probability that an event having

0.013-

0.013-0.017
0.012-0.018
0.011-0.020
0.020-0.035

0.030-0.40

0.02-0.030
0.025-0.040
0.030-0.045

0.050-0.14

0.03-0.07

0.04-0.10

+T,

channel

a specific volume and duration will be

exceeded in a specified time period. Return period is the average length of time between events having

the same volume and duration.

Be careful, saying that a storm has a 50 year frequency does not mean that it happens every 50 years.

The probability of a storm happening is inversely proportional
50 year storm has a 2% probability of recurrence.

VDOT recommends the following design frequencies dependi

of the return period. This means that a

ng of the type of project:

Typeof Project Design Frequency

© 2011 Bentley Systems, Incorporated

VDOT GEOPAK Drainage



THE RATI ONAL METHOD

General Design 3 year

General design with ditch replacement 10 year
and adding of side pipes.

General design work on interstates 10 year

Interstate facilities which only outlet is 50 year
a stormdrain system and for the outlet
of systems requiring pumping stations.
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INLET SPREAD COVPUTATI ONS

INLET SPREAD COMPUTATIONS

The spread or ponded width of runoff at an inlet location is a geometric function of the cross sectional

geometry, longitudinal pavement/gutter slope and discharge. A direct solution is not possible for
complex cross sections with multiple breaks in the transverse slope so an iterative procedure derived
from HEC-22 is employed.

CURB INLETS ON-GRADE

12-8

The computation of on-grade curb opening inlets involves a determination spread or ponded width
characteristics, computation of length required for total interception, and consideration of inlet
efficiency.

g T -
LW,
o
a ?
Curb
Pavement Opening
Inlet

The hydraulics of Curb Inlets On Grade is derived from HEC-22. The applicable equations are as
follows:

The length of curb inlet required for total interception using Equation:

0.
L, =060 QIH-! 503 [L]
na,

where:
L, = length of curb inlet required (ft)
Q = flowrate in gutter(cfs)

S = longitudinal slope (ft/ft)
n = Manning's roughness coefficient
Se = equivalent cross slope (ft/ft) for non depressed inlets

The equivalent cross slope (S.) for a depressed curb-opening inlet using Equation:

5 =5 +—F,
W
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CURB | NLETS I N SAG CALCULATI ONS

where:

Se = equivalent cross slope (ft/ft)

Sx = cross slope of the road (ft/ft)

a = gutter depression depth (ft)

W = gutter depression width (ft)

Eo = ratio of depression flow to total flow

The Ratio of depression flow to total flow is determined using the following equation:
E,=1 - [1 - E]m

T

where:
Eo = ratio of depression flow to total flow

Inlet interception capacity is then defined by:

Cit ervges = Cana ¥ Eiffcieny
where:
Qi = intercepted discharge (cfs)
Qt = total inlet discharge (cfs)
Efficiency = inlet efficiency defined below

L
Efficiency = 1-(1- L—}”

r

where:
L, = length of curb inlet required for 100% interception (ft)
L = length of curb inlet provided (ft)

CURB INLETS IN SAG CALCULATIONS

The capacity of a curb inlet in a sag depends on the water depth at the curb opening, and the height of
the curb opening.

The inlet operates as a weir to depths equal to the curb opening height and transition to orifice flow on
higher depths. In the transition the capacity is based on the lesser of the computed weir and orifice
capacity.

The head on the inlet is computed by adding the ponded depth (y) and the inlet depression (a) using the
following Equation:

h=y+a
where:
h = head at inlet opening (ft)
y = ponded depth in gutter (ft)
a = inlet depression depth (ft)

The capacity of the inlet when operating under weir conditions is calculated with the equation:
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GRATE | NLETS ON- GRADE CALCULATI ONS

Q=C_ @L+13*Whl

where:

Q = total flow reaching inlet (cfs)

Cw = weir coefficient = 2.3

h = head at inlet opening (ft)

L = length of curb inlet opening (ft)

W = lateral width of inlet depression (ft)

The equation for interception capacity of a curb opening operating as an orifice follows:

Q=C,hL./2gd,

where:

Q = total flow reaching inlet (ft*/s)

C, = orifice coefficient = 0.67

h = depth of opening (ft)

L = length of curb opening inlet (ft)

g = acceleration due to gravity = 32.2 ft/s?

d, = effective head at the centroid of the orifice (ft)

GRATE INLETS ON-GRADE CALCULATIONS

12-10

The capacity of a grate inlet on-grade depends on its geometry and the cross slope, longitudinal slope,
total gutter flow, depth of flow, and pavement roughness. The design of a grate inlet on-grade involves
an analysis of given grate dimensions to estimate the interception rate. The difference between the
estimated interception rate and the total approach discharge equals the bypass rate. The following
procedure is applicable to grate inlets on-grade:

The Ratio of discharge over the grate (Frontal Flow) to flow to total flow is determined using the
following equation:

where:
Eo = ratio of flow over the grate to total flow

The ratio of frontal flow intercepted to total frontal flow:
Re=1-03(V-V,), fV=1,
F,=10ifV <V,

where:

R¢ = ratio of frontal flow intercepted to total frontal flow

V = approach velocity of flow in gutter (ft/s)

V, = minimum velocity that will cause splash over grate (ft/s)

The splash over velocity is of the form of

© 2011 Bentley Systems, Incorporated VDOT GEOPAK Drainage



GRATE | NLETS ON- GRADE CALCULATI ONS

WV, = ALY factort™

where:

Vo = is splash over velocity

A = constant for different grate type

N = a power coefficient for different grate type
L = grate length

factor = 1 for English and .3048 for metric

Grate Type Coefficient A Coefficient N
P-1-7/8 5.74872 0.5038679
P-1-1/8 4.54822 0.5058875
Curved Vane 3.92812 0.5954068
45 Tilt Bar 3.35159 0.5926234
30 Tilt Bar 2.67291 0.7567052
P-1-7/8-4 3.01181 0.6454720
Reticuline 2.48235 0.7659749

The ratio of side flow intercepted to total side flow:

o —[1+ [0.083 leB]T
R P kb

L_Q K]

where:

Rs = ratio of side flow intercepted to total flow
z = inverse of transverse slope

V = approach velocity of flow in gutter (ft/s)

L = length of grate (ft)

The efficiency of grate, Ey, using equation:

E;=[RE, +R,(I-E,]]
The interception capacity of the grate, Q;, using equation:

Q:=EQ=Q[R:E, +R,{1-E,]]
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GRATE | NLETS | N SAG CALCULATI ONS

The bypass flow rate:
Co=0-0,

GRATE INLETS IN SAG CALCULATIONS

A grate inlet in sag configuration operates in weir flow at low ponding depths. The transition to orifice
flow begins as the ponded depth increases. The procedure for calculating the inlet capacity is as
follows:

The capacity of a grate inlet operating as a weir is determined with the following equation:
g, = (1~ B)C,PH"

where:

Q. = weir capacity of grate (cfs)

C. = weir coefficient = 3.087

P = perimeter of the grate (ft)

h = allowable head on grate (ft)

Pr = perimeter reduction factor to account for clogging

Under orifice conditions, the grate area controls the capacity. The capacity of a grate inlet operating
under orifice flow is computed equation:

0, = A*(1- 4,)C, . Jogh
where:
Q, = orifice capacity of grate (cfs)
C, = orifice flow coefficient = 0.67
A = clear opening area (ft?) of the grate (the total area available for flow)
g = acceleration due to gravity (32.2 ft/s?)
h = allowable head on grate (ft)
Ag = area reduction factor to account for clogging

The capacity of a grated inlet in a sag is based on the minimum flow calculated from weir and orifice
conditions. The figure below demonstrates the relationship between weir and orifice flow. If Q, is
greater than Q,, (to the left of the intersection in the figure), then the capacity would be that calculated
with the weir equation. If, however, Q, is less than Q,, (to the right of the intersection), then the
capacity as determined with the orifice equation would be used.
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Weir (Queh™)

£
£

S
Orifice (Q=h'")

Inlet C apacity ()

"

# gt Orifice
/ ' ontr ol #—— Control

Effective Head ()
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LINK HYDRAULI C COVPUTATI ONS

LINK HYDRAULIC COMPUTATIONS

Numerous algorithms are employed to perform the pipe and ditch hydraulic computations. The
fundamental equations and terminology are presented here for reference purposes.

The most widely used formula for determining the hydraulic characteristics of storm drain networks is
the Manning Formula, expressed by the following equation:

v =Llp2sgw
I

where:

V = mean rate of flow (ft/s)

R = the hydraulic radius (ft)

S = the slope of hydraulic gradeline (ft/ft)
n = Manning's roughness coefficient

The hydraulic radius (R) is defined as follows:

E= i
W
where:
Wp = wetted perimeter (ft)
A = cross sectional area of flow (A?)
To satisfy continuity,
Q=AV

where:

Q = discharge (m*/s)

Combining these equations gives the following equation:
Q= % 4 Al

Conveyance describes the geometric carrying capacity of a hydraulic conduit and is described by the
following equation:

L B

K=—T=—A4AR

|
& |-

Friction Slope is the slope (S) in Manning's formula required to convey a specified discharge under
uniform flow conditions given a depth, roughness, and shape. Under uniform flow, depth and flow area
are constant and the friction slope, the actual slope, and the energy slope are all equal.

Sy = (%)2
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LINK DeSl aN CONSTRAI NTS

LINK DESIGN CONSTRAINTS

The Constraints establish further design criteria for Links. GEOPAK Drainage utilizes the physical
constraints of minimum and maximum size and slope to determine a suitable pipe size.

Lik ID: 4 ey s

[ Highlight

Details
Options

Design Constraints

Definiti Minimum Maxdmum
inition -

Conditions Rize: | 1.000 4000

Consraints Slope: | 0.500 10,000

Computation Velocity: | 2.000 10,000
Type

@ Pipe
~) Ditch

GEOPAK Drainage will perform the following steps to determine the “allotted pipe envelope”

VDOT GEOPAK Drainage

Starting upstream, GEOPAK computes each link slope by connecting the nodes at the
elevation set by the node elevation minus the minimum depth.

If this slope is less than the minimum slope, GEOP AK Drainage sets the slope equal to the
minimum slope. This will provide the upper limit of the envelope. Then, it continues
downstream.

To setup the bottom part of the “envelope” , it starts from the outlet elevation, move upstream
and setup the minimum invert of the pipes by using node elevation minus the maximum depth
values on each node.

If the invert falls within the minimum and maximum slopes the link is placed at the calculated
elevation. If not, the link is once again placed at the minimum specified slope from that node
to the upstream end of the system.

If during the construction of the envelope, any elevations that the user has held will be
accommodated if physically possible and the envelope constrained to that elevation.
However, if a held elevation of a pipe violates the minimum or maximum depth line, the
elevation will not be held. With the minimum and maximum depth profiles computed,
GEOPAK Drainage can then design a suitable pipe within this envelope that satisfies all the
constraints possible.
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The other constraints, minimum and maximum velocity are for querying purposes and evaluating the

adequacy of the design.

Minimum Rise

Constraint - Minimum rise (diameter, height) for pipe or ditch in master
units (i.e. feet or meters). The Department’s minimum round pipe size is
1.5'(18").

Maximum Rise

Constraint - Maximum rise (diameter, height) for pipe or ditch in master
units (i.e. feet or meters). Unless the designer knows a constraint, it is
recommended that this be set for a large pipe such as a 6' (72”).

Minimum Slope

Constraint - Minimum physical slope for pipe or ditch expressed in
percentage. The minimum pipe slope varies with the pipe size (0.15% for
18", 0.102% for 24" etc.) See the discussion in the Storm Drain Handbook.
During the initial design, the pipe sizes are not known, so this constraint
may need to be changed as the design progresses. In moderately sloped
terrain, using 0.15% may be acceptable for all pipes, because the terrain
will force the pipes to be steeper than that. In flat terrain, using 0.15% for
all pipes may cause the downstream pipes to be too deep.

Maximum Slope

Constraint - Maximum physical slope for pipe or ditch expressed in
percentage. The Department does not have a maximum slope constraint, so
it is recommended that this be set high for all pipes.

Minimum Veocity

Query - Minimum velocity for pipe or ditch expressed in feet per second or
meters per second. This value must be something greater than zero for the
program to do the hydraulic calculations.

Maximum Ve ocity

Query - Maximum velocity for pipe or ditch expressed in feet per second or
meters per second.
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HYDRAULIC GRADE LI NE COVPUTATI ONS

HYDRAULIC GRADE LINE COMPUTATIONS

The methodology employed by GEOPAK Drainage to compute the water surface profiles through a
storm drain network is typical of any open channel water surface procedure. A backwater analysis is
performed through the system beginning at the most downstream point (outlet) and progressing
upstream to the most remote nodes. GEOPAK Drainage will compute the hydraulic grade line using
gradually varied flow analysis in free surface flow conditions and pressure flow computations under
full flow conditions.

The resulting hydraulic gradeline represents the set of elevations to which the water would rise if open
to atmospheric pressure (e.g., piezometer tubes) along a pipe run and can be used to evaluate the
adequacy of the design and identify areas where flooding occurs.

HYDRAULIC GRADELINE

The hydraulic gradeline (HGL) procedure begins at the most downstream node (outlet) and proceeds
upstream through each link in the same fashion. A starting HGL at this downstream point elevation
must be defined. The procedure for developing the HGL through a link of the network from
downstream node to upstream node is as follows:
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1. Beginning with the HGL at the downstream node (HGL,;), the Energy Gradeline (EGL,) is computed
from:

1

EGL= HGL+ —
ig

where:

v = velocity at flow depth HGL (ft/s)

g = gravity (32.2)

HGL = elevation of hydraulic gradeline

Assuming a very small change in the energy and depth (y) compute the HGL, from HGL, = HGL;+ y

2. Determine the distance along the pipe (x) to create the y loss due to friction = x = Sgy where S¢=
0.5(S:+S,)

3. This procedure of computing HGL, and the distance along the pipe proceeds until the end of the
pipe has been reached yielding the HGL at the upstream end of the pipe.

4. The resulting upstream HGL is subsequently used on the next upstream pipe as its starting
downstream HGL. GEOPAK Drainage can alternatively use the computed energy gradeline upstream
as the starting downstream EGL on the next pipe upstream. This alternative method differs in that the
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SPECIAL CONSI DERATI ONS

EGL's upstream and downstream at a node are equal rather than the conventional assumption that the
HGL's are equal.

5. If junction losses are desired they computed prior to progressing upstream and added to the
hydraulic gradeline.

SPECIAL CONSIDERATIONS
e Ifthe starting HGL is less than critical depth then critical depth will be assumed.

e If the HGL converges to equal the uniform depth the computations proceed to the upstream
end at uniform depth

e  Once the HGL reaches the soffit of the pipe full flow conditions begin.

o Hydraulically steep pipes where uniform depth is less than the critical depth are checked with
a backwater profile to verify if the resulting upstream HGL drowns out critical depth at the
upstream end. If it does than the backwater profile is accepted. If the backwater curve does
not exceed the critical depth, then a forewater profile is generated for this supercritical
condition. A forewater profile uses the same procedure as above but progresses from the
upstream end towards the downstream end. It begins at critical depth at the upstream end and
converges towards uniform depth as the calculations proceed downstream.

e Hydraulic jumps may occur when mixing supercritical and subcritical water surface profiles.
GEOPAK Drainage does not compute the exact location of a jump but will check if
downstream subcritical depths have sufficient energy to force a supercritical profile to its
conjugate depth thereby satisfying the conditions required for a jump to occur. Message will
be appear indicating the existence of a jump.
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JUNCTION LOSS METHODOLOGE ES

JUNCTION LOSS METHODOLOGIES

Five junction loss methodologies are discussed:
e  Free surface transition losses
e  Pressure flow transition losses
e Bend losses
e Terminal inlet / junction losses

e  Complex junction losses

FREE SURFACE TRANSITION LOSSES

The energy losses may be expressed in terms of the Kinetic energy at the between the incoming and
outgoing pipes:

Vﬂ
H, = K:,xﬂ(z—)
g

where K; is the transition Loss Coefficient.

2 2
H:r = K:r (VL _ij
g g
f0|’V2>V1
2 2
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2z 2g
f0|’V1>V2
where:

V, = upstream velocity
V, = downstream velocity

K; = Loss Coefficient for expansion of contraction

PRESSURE FLOW TRANSITION LOSSES

The energy losses may be expressed in terms of the kinetic energy at the between the incoming and
outgoing pipes:

(AP
H, =K ]
2g
where K; is the transition Loss Coefficient.
2
(3 — ¥

H, =K )
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BEND LOsSES

for V,>V;
2
(M V)
H, =K, (—L—2
2
for Vi>V,
where:
V, = upstream velocity
V, = downstream velocity
K = Loss Coefficient for expansion of contraction
BEND LOSSES
Method 1 (From Modern Sewer Design)
Bend losses may be estimated from the equation:
172
H,=E,—
b b =
Where the K, can be estimated from the following table.
K - Bend Loss Coefficient Degree of Turn at Bend
0.10 20
0.32 40
0.64 60
1.06 80
1.32 90
Method 2 (From AASHTO)
Bend losses may be estimated from the equation:
'livil'g
H, =K, —
b b zg
Where the K, can be estimated from the following table.
K - Bend Loss Coefficient Degree of Turn at Bend
0.19 15
0.35 30
0.47 45
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CURVE LOsSES

0.56 60
0.64 75
0.70 90

CURVE LOSSES
Losses for curved pipe segments may be estimated from the equation:

@

K, =25]—

" 00

where:
= central angle of bend in degrees
TERMINAL INLET /JUNCTION LOSS

Vﬂ
H, =K (—)

2g

where:
V = Velocity at terminal end of junction

K = Loss Coefficient for terminal junction

COMPLEX JUNCTIONS

Manhole losses in many cases comprise a significant percentage of the overall losses within a sewer
system. Losses at junctions are dependent upon flow characteristics, junction geometry and relative

sewer diameters.
Method 1

Losses at junctions where one or more incoming laterals occur may be estimated by combining the

laws of pressure plus momentum where H; is equal to the junction losses.
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COMPLEX JUNCTI ONS

1 —> 2 >

Using the laws of pressure plus momentum, the loss H; can be estimated as follows:

(4+4)_@° o o
2 -’q'zg 4‘113 *"133

cos o

':HJ' +‘Dl _D:;:'

Method 2

Losses at junctions where one or more incoming laterals occur utilize the principle of conservation of
energy, involving position energy and momentum energy. The energy content of the inflows is equal to
the energy content of the outflow plus any losses due to the collision and turbulence.

The loss H; can be estimated as follows:
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COMPLEX JUNCTI ONS

2 2 2 2
H. = Ly O — ey T EO
! 2(he

where:
Q = discharges
V = horizontal velocities

K = bend loss factor
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GEOPAK DrAl NAGE WARNI NG MESSAGES

GEOPAK DRAINAGE WARNING MESSAGES

PREFERENCES

AREAS

NODE:

12-24

Error Opening GPK file: The directory path for the location of the project’s geometric database (gpk file) is
not properly defined in the Drainage project preferences.

Error Opening Drainage Library: The directory path for the location of the project’s drainage library (dlb
file) is not properly defined in the Drainage project preferences.

Close All Open Library Item Dialogs Before Exiting Librarian: All edit dialogs must be saved or cancelled
before exiting the drainage library dialog.

Unabletoload path data: The directory paths for any of the project components are invalid or do not exist as
defined in the Project preferences dialog.

Unableto find shapefilein preferences. The roadway superelevation shapes dgn file is not at the location
specified in the Project preferences dialog.

No element meetsthe boundary level/symbology criteria: The dgn element symbology specified as a search
criteria for the area definition does not match any of the elements in the dgn file.

Area Creation Failed or Aborted - Area Must be Enclosed: A drainage area must be closed shape element in
Microstation.

No Boundary Elements Selected: A boundary or borderline Microstation elements to define a drainage area
were not selected.

Sum of Subareas = ## Exceeds Total Drainage Area = ## Do Y ou wish to Reset Total ?: The sum of the
subareas entered in the Area>Subareas option exceeds the total area defined in the Area>Definition dialog box.
GEOPAK will adjust the total area as the total sum of the subareas.

Error Retrieving Cell: The Microstation cell library containing the drainage node cells is not attached to the
dgn file, it is not found or it is not specified in MS_Celllist variable.

NO eement identified: User has not selected/identified the Microstation element where the drainage node is
going to take as a reference for placement while using the Tangent to Element or Tangent on Element option in
the Node>location dialog.

Unableto deter mine PGL Elevation: The station where the node is placed does not exist along the profile
specified as a reference.

Unableto compute TIN Elevation: The node is placed outside the boundary of the TIN file specified or the
TIN file does not exist.

Error Finding D& C Manager: The D&C Manager ddb file is not found at the location specified in the Project
Preferences.

Error Computing Inlets Calculations for Networ k: GEOPAK Drainage was not able to compute any
hydraulics for the specified inlet. No flow is getting to the inlet. This could be caused by a wrong spread criteria
definition in which the first slope of the spread criteria cross section is diverting the flow out of the inlet
(negative slope) or the user has not defined a drainage area or discharge into the node.

Error Opening ACBOOK : The D&C Manager ddb file is not found at the location specified in the Project
Preferences.
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LINK:

LINK:

Error Accessing TIN or Model: The TIN file or Site Model gsf file do not exist at the directory path specified
in the Project Preferences.

Error in Inlet By Pass Designations - Loop Detected: User is bypassing flow into the same node.

Error using shapes: GEOPAK was unable to extract information from the roadway superelevation shapes
defined in the Project preferences. This could be caused by wrong definitions inside the shapes (chain and
profile), the shape dgn file does not exist in the path specified in the Project preferences or there are not shapes
defined at the node location.

Link placement ERROR: Link was not placed and stored in the drainage database (gdf file). This could be
caused by a wrong definition (from and to node are the same) or a Microstation element to define the link is not
selected.

Cannot Hold the Slope and From and To Node Elevations: User can not specify hold values for the inverts
and slope of the link/pipes at the same time. User should specify the inverts and let the slope to be calculated by
the software.

Cannot Hold From Node Soffit and Invert Elevations. User can not specify values for the soffit and invert
elevations in the same FROM node. User should specify either one of them and let the software calculate the
remaining elevation with the link rise or pipe diameter.

Cannot Hold To Node Soffit and Invert Elevations: User can not specify values for the soffit and invert
elevations in the same TO node. User should specify either one of them and let the software calculate the
remaining elevation with the link rise or pipe diameter.

Cannot Hold Morethan Two Conditions: User can not specify hold values for the inverts and slope of the
link/pipes at the same time.

Rise Exceeds Maximum allowed by Profile Envelope: The selected or designed link for the segment is
encroaching in the profile envelope defined by the elevations and minimum depths of the connected nodes.

Downstream HGL sufficient for Hydraulic Jump: GEOPAK Drainage does not calculate the exact location
of a hydraulic jump but it can warn the user of its possible occurrence.

Minimum Slope used for Podtive Drainage: Link slopes were adjusted to the minimum specified slope in
order to assure gravity/positive flow. Adverse slope pipes are not allowed.

Min Depth Exceeded at Upstream or Downstream of Link: Link rise is encroaching the limits defined by
the node elevation minus the minimum depth.

NETWORK:

Error Building Network : An invalid network has been defined. Multiple outlet nodes or “loop” connections
are not allowed.

Network Calculations Containing Profile are not up to date, Please Perform Network Calculations:
Shown results may not be up to date since possible edit operations have occurred in the network.

An Active Network must be selected: The Drainage>Network>Active Network has not been selected in the
project. Some reporting options required this definition at the user request.

Network Computations are not up to date show results anyway ?: Shown results may not be up to date since
possible edit operations have occurred in the network.

Network Calculationsinvolving link are not up to date, Please perform Networ k Computations. Shown
results may not be up to date since possible edit operations have occurred in the network.

Errors Preclude Computations: GEOPAK Drainage was unable to calculate the network system. This could
be caused by some zero values in the node or link definitions (no flow into the nodes, minimum
velocities equal to zero) or no drainage areas defined for inlets.
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PROFILES

e HGL Blowout at upstream end: The hydraulic grade line is encroaching the limits defined by the node
elevation minus the minimum freeboard value (defined in the Project Preferences).

e Commingling Runoff Methods not supported: GEOPAK Drainage can compute a network either using the
Rational or SCS method for the drainage areas definitions.

e Error Building Networ k - More than One Outlet found: An invalid network has been defined. Multiple
outlet nodes are not supported.

e Error Building Network - L oop or Multiple Downstream Links: An invalid network has been defined. Loop
or closed circuits connections are not supported.

e Error Building Network - More than five Incoming Links for Node: GEOPAK Drainage does not allow
more that five link/pipes connections in a node.
PROFILES

e Unsuccessfully projectingto chain __ from link __: The chain extends/limits does not include the
link location.

e Error Accessing TIN or Model: The TIN does not exist at the directory path specified in the Project
Preferences.

e DrainageProfile__ containsNode__: The Drainage Profile dialog must be closed to edit this node:
The Drainage Profile dialog must be closed before editing a node that is part of the active profile.

e DrainageProfile__ containsLink _ :The Drainage Profile dialog must be closed to edit this link:
The Drainage Profile dialog must be closed before editing a link that is part of the active profile.

NAVIGATOR

o No QueriesAvailablefor Sdected Type: There are no query options for the drainage element type
selected.

¢ No Elements Meeting Query werefound: An specific query has returned no results.

ROUTING

e Unabletoload computation file: The ASCII file specified to store the computations was not
previously created while in Append mode.
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GEOPAK REPORT Bul LDER VARI ABLES

AREA

NODE

GEOPAK REPORT BUILDER VARIABLES

Area-1D: Drainage area name/identification stored in the drainage database (gdf file)

Area — Description: Drainage area user provided description.

Area - Time of Concentration: User provided or calculated time of concentration.

Area - Tc Used: Time of concentration used in the calculation for the drainage area discharge.
Area — Discharge: Computed discharge for the drainage area.

Area — Intensity: Intensity rainfall used as computed from the time of concentration and rainfall
library.

Area - Composite C Value: Calculated composite C coefficient for the Rational method.

Area - Composite Area: Calculated composite area value for the Rational method.

Area - Total Subarea C Value: Calculated composite C value for only the delineated subareas.
Area - Total Subarea: Sum of the delineated subareas only.

Area - Remainder C Value: C coefficient of the area not included into the delineated subareas.
Area - Remainder Area: Calculated value equal to Total Drainage Area minus the Total Subareas.
Area - Subarea 1...20 Area: Area value of the 1..20 delineated subarea.

Area - Subarea 1...20 C Value: C coefficient of the 1..20 delineated subarea.

Area - Subarea 1...20 Description: Description of the 1..20 delineated subarea.

Node-1D: Drainage node name/identification stored in the drainage database (gdf file)
Node — Description: Drainage node user provided description.

Node — Type: Node type as defined in the drainage library. E.g. curb, grate, junction, other, curb-grate,
headwall.

Node - Library Item Name: Node name as it is stored in the drainage library.
Node - Library Item Description: Node description as it is stored in the drainage library.
Node - Reference Chain: GEOPAK chain used to locate the node by station.

Node - Reference PGL: GEOPAK profile used to compute the elevation and longitudinal slope for the
node.

Node - Reference TIN: GEOPAK DTM file used to compute the elevation of the node.
Node - Station : Station value computed at the node location using the Node - Reference Chain.

Node - Offset : Offset or distance value computed from the Node - Reference Chain to the node
location. A negative value will indicate the left side of the chain.

Node - Location X Node/ Node - Location Y Node : Coordinate location of the drainage node.
Node — Rotation Node: Angle value in which the node is rotated.
Node - Cumulative Tc : Accumulated time of concentration at the node location.

Node - Supplied Discharge: Applied flow into the node. A discharge is entered directly without a
drainage area definition.

Node - Cumulative Supplied Q : Accumulated directly-entered discharge in the node.
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INLET

Node — Freeboard : Distance computed as node elevation minus hydraulic grade line elevation.
Node - Cumulative Discharge : Accumulated discharge/flow in the node.

Node - Cumulative Area : Accumulated drainage area in the node.

Node - Cumulative C Value : Accumulated C coefficient in the node.

Node - Cumulative Intensity: Accumulated intensity in the node.

Node - Hyd Center X / Node - Hyd Center Y : Coordinate location of the node hydraulic center.
Node - Elev Point X / Node - Elev Point Y : Coordinate location of the node elevation point .
Node - Origin X / Node - Origin Y : Coordinate location of the node cell origin.

Node - Minimum Depth / Node - Maximum Depth: Distance measured from the node elevation point.
These distances paired with the next connected node creates en envelope in which the links can be
placed.

Node — Depth : Distance computed from the node elevation point minus the node bottom elevation.

Node - Minimum Invert Elevation : Minimum invert elevation computed from the links arriving or
leaving the node.

Node - Maximum Rise In : Maximum link size arriving into the node.
Node - Maximum Rise Out: Maximum link size leaving the node.

Node - Minimum Invert In / Node - Minimum Invert Out : Minimum invert elevation of the links
arriving or leaving the node.

Node - Bottom Name : Name as stored in the drainage library of the bottom structure attached to the
node.

Node - Bottom Description : Description as stored in the drainage library of the bottom structure
attached to the node.

Node - Pay Item : D&C Manager item ID attached to the node.
Node - Bottom X / Node - Bottom Y : Coordinate location of the bottom structure attached to the node.

Node - Bottom Station: Station value computed at the bottom of the structure attached to the node
using the Node - Reference Chain.

Node - Bottom Offset: Offset or distance value computed from the Node - Reference Chain to the
bottom of the structure attached to the node . A negative value will indicate the left side of the chain.

Node - Bottom Elevation: Elevation of the bottom of the structure attached to the node.

Node - Sump Depth: Extra depth specified by the user added after computing the node bottom
elevation.

Node - Is Link Base Flow: Returns a value of -1 if a Baseflow (offsite drainage discharge) option is
added to the node.

Node - Link Base Flow Type: Returns a value of 1 if the Baseflow (offsite drainage discharge) is
entered as a numeric value. Returns 0 if the baseflow discharge is entered as a predefined drainage
area.

Node - Link Base Flow Area: Returns the name or ID of the drainage area entered as baseflow.
Returns N/A if not.

Node - Link Base Flow Discharge: Returns the numeric value entered as baseflow discharge. Returns
N/A if not.

INLET

Inlet - ID: Drainage inlet name/identification stored in the drainage database (gdf file).
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INLET

Inlet — Description: Drainage inlet user provided description.

Inlet - By Pass Node ID : Node name in which by pass flow is directed from the present inlet.

Inlet — Type: Inlet type as defined in the drainage library. E.g. curb, grate, curb-grate.

Inlet - Profile Type : Inlet placement profile condition. Either On Grade or Sag.

Inlet — Discharge : Inlet computed discharge from the drainage area or supplied discharge.

Inlet — Capacity : Capacity of the inlet based on their physical properties and placement conditions.

Inlet - Max By Pass: Maximum by pass flow/discharge assigned to the inlet as a query value. It is not
used for design purposes.

Inlet - By Pass Flow: Computed flow that the present inlet will bypass due to lack of capacity.
Inlet - By Pass Flow Into: Inlet name in which by pass flow is directed from the present inlet.
Inlet - Curb Length: Curb length as defined in the drainage library.

Inlet - Curb Depression: Curb Depression as defined in the drainage library.

Inlet - Curb Height: Curb Height as defined in the drainage library.

Inlet - Curb Depression Width: Curb Depression Width as defined in the drainage library.
Inlet - Slot Length: Slot Length as defined in the drainage library.

Inlet - Slot Width: Slot Width as defined in the drainage library.

Inlet - Grate Type: Grate Type as defined in the drainage library.

Inlet - Grate Length: Grate Length as defined in the drainage library.

Inlet - Grate Width : Grate Width as defined in the drainage library.

Inlet - Grate Area: Grate Area as defined in the drainage library.

Inlet Grate Perimeter: Grate Perimeter as defined in the drainage library.

Inlet - Grate Clog Area: Grate Clog Area as defined in the drainage library.

Inlet - Grate Clog Per Inlet: Grate Clog Per Inlet as defined in the drainage library.

Inlet - Max Ponded Depth: Maximum allowed spread depth. This is used a query value and not for
design purposes.

Inlet - Max Ponded Width: Maximum allowed spread width. This is used a query value and not for
design purposes.

Inlet - Longitudinal Slope: Slope along the direction of stationing defined by the user or a GEOPAK
profile.

Inlet - Computed Ponded Width: Computed spread width.

Inlet - Computed Ponded Depth: Computed spread depth.

Inlet - Right Spread Intercept: : Computed spread width at the right side of the inlet.
Inlet - Left Spread Intercept: Computed spread width at the left side of the inlet.
Inlet - Length Required: Computed inlet required in order to handle all the discharge.
Inlet - Spread N: Manning’s coefficient for the spread section.

Inlet - Composite Spread Slope: Composite slope across the inlet.

Inlet - Inlet to Gutter Offset: Distance applied when the inlet is set at a certain offset of the section
considered for computing spread width and depth.
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LINKS

LINKS

12-30

Inlet - Spread Slope 1...5: Slope of the different segments of the Spread Criteria cross section. Section
1 is the closest to the inlet.

Inlet - Spread Width 1...5: Width of the different segments of the Spread Criteria cross section.
Section 1 is the closest to the inlet.

Link — ID: Drainage link name/identification stored in the drainage database (gdf file).
Link — Description: Drainage link user provided description.

Link — Type: Link type. Either pipe or ditch.

Link - Upstream Node: Upstream node ID of the connecting link.

Link - Downstream Node: Downstream node ID of the connecting link.

Link — Shape: Link shape as defined in the drainage library. E.g. Arch, box, circular, ellipse or pipe
arch.

Link — Material: Link material as defined in the drainage library. E.g. aluminum, concrete, plastic, or
steel.

Link - Corr — Type: Link corrugation or type as defined in the drainage library. E.g. Standards, low
profile, high profile, horizontal, or vertical.

Link - Library Item: Link name as it is stored in the drainage library.

Link - Number of Barrels: Number of parallel pipes going from one node to another.

Link - Actual Length: Link length measured from the graphical ends of the element.

Link - Hydraulic Length: Link length measured from hydraulic center to hydraulic center of each node.
Link - Manning's N Value: Manning’s coefficient of the link.

Link — Slope: Link slope in percentage.

Link — Rise: Link rise in feet or meters.

Link — Span: Link span in feet or meters.

Link — Discharge: Link discharge/flow.

Link - Uniform Depth: Flow uniform depth at the link.

Link - Uniform Velocity: Uniform velocity computed at the link.

Link - Critical Depth: Critical depth computed at the link.

Link - Critical Velocity: Critical Velocity computed at the link.

Link - Friction Slope: Friction slope computed at the link.

Link - Critical Slope: Computed slope caused by critical flow at the link.

Link - Actual Depth Downstream: Downstream runoff depth at the link.

Link - Actual Depth Upstream: Upstream runoff depth at the link.

Link — Capacity: Link capacity under the present physical conditions.

Link - HGL Downstream/ Link - HGL Upstream: Hydraulic grade elevation at the link ends.
Link - EGL Downstream/ Link - EGL Upstream: Energy grade line elevation at the link ends.
Link - Upstream Junction Loss: Junction loss value at the upper portion of the link.

Link - Soffit Upstream /Link - Soffit Downstream: Soffit or crown elevation at the link ends.
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LINKS

Link - Invert Upstream/Link - Invert Downstream: Invert elevation at the link ends.
Link - Minimum Rise: Minimum link rise used for design purposes.
Link - Maximum Rise: Maximum link rise used for design purposes.

Link - Minimum Slope/ Link - Maximum Slope: Minimum/maximum slope at which links would be
placed.

Link - Minimum Velocity/Link - Maximum Velocity: Minimum/maximum velocity at which links
would be placed.

Link - Design Size: Return a Yes/No value if GEOPAK Drainage will design the size of the links.

Link - Design Barrels: Return a Yes/No value if GEOPAK Drainage will consider parallel links from
node to node.

Link - Actual Velocity Downstream/Link - Actual Velocity Upstream : Velocities computed at the link
ends.

Link - Pay Item: ID of the Design and Computation Manager item associated with the link as defined
in the drainage library.

Link - Library Description: Link description as it is stored in the drainage library.
Link - Iterative Velocity: Computed velocity at the link after 10 iterations.
Link - Full Velocity: Computed velocity assuming that the links are flowing full.

Link - Upstream Freeboard: Computed elevation from the upstream node minus the assigned freeboard
to the node.
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